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Tools you will learn:
•	 DMAIC project roadmap
•	 Identifying and prioritizing 

improvement projects
•	 Improvement project reporting
•	 Chartering improvement projects
•	 Process mapping

LSS-101: Introduction to Lean Six Sigma (16 hours)

Combining Lean and Six Sigma into a single improvement initiative eliminates 
redundant infrastructure and provides the ultimate in world-class performance:  
Six Sigma quality combined with Lean speed!  This module will get you up to 
speed on Lean Six Sigma principles and methods. 

You will learn:
•	 How integrating Lean and Six Sigma can dramatically improve your business 

results 
•	 How the DMAIC (Define-Measure-Analyze-Improve-Control) project roadmap 

can improve LSS project results, including greater reductions in lead time and 
cost of waste

•	 How to identify and prioritize LSS projects for maximum impact 
•	 How to deploy Lean Six Sigma projects 
•	 How to charter LSS projects
•	 Create accurate current state process maps 
•	 How to select and launch teams for effectiveness
•	 Understand leadership responsibilities

Tools you will learn:
•	 Observing the current state
•	 Value stream mapping
•	 Sample size calculation
•	 Basic statistics and normal 

distribution

LSS-102: Measuring Process Performance-I (16 Hours)

Reliable data is required for Lean Six Sigma Improvement projects. This module 
explains how to collect data to quantify the current state and establish desired 
improvement goals. 

You will learn how to:
•	 Conduct process walks, apply good interviewing and listening techniques, and 

identify “low hanging fruit” opportunities for improvement 
•	 Create accurate value stream maps 
•	 Recognize basic data types: quantitative and categorical
•	 Identify X and Y variables for your LSS project 
•	 Perform sample size calculations for data collection
•	 Collect data that is representative of the current state
•	 Calculate project benefit metrics based on quantitative and categorical data

Prerequisite: LSS-101: Introduction to Lean Six Sigma

Tools you will learn:
•	 Measurement system analysis
•	 Statistical graphics
•	 Pareto analysis
•	 Process capability indices

LSS-103: Measuring Process Performance-II (2 days)

Reliable data is required for Lean Six Sigma Improvement projects. This module 
explains how to collect data to quantify the current state and establish desired 
improvement goals. 

You will learn how to:
•	 Conduct measurement system analyses
•	 Apply Pareto analysis to categories of defects, errors, failures, cost, non-value 

adding time, or other types of waste
•	 Calculate and interpret process capability indices

Prerequisite: LSS-102: Measuring Process Performance-I



Tools you will learn:
•	 Significance testing
•	 Interpreting P values
•	 Five whys
•	 Affinity analysis
•	 Fishbone diagram

LSS-104: Root Cause Analysis and Improving the Process (16 Hours)

One of the most important and challenging steps in a Lean Six Sigma 
improvement project is to determine the root cause(s) of problems within the 
project scope. Possible causes must be confirmed or debunked by data analysis. If 
there are multiple root causes, these should be prioritized. 

You will learn how to:
•	 Describe the population associated with a process
•	 Classify significance testing into two basic types:  comparing populations, 

correlating variables
•	 Explain P values and how they relate to standards of evidence
•	 Test for differences between or among population
•	 Test for correlations between variables and interpret the results
•	 Perform root cause analysis

Root Cause Analysis

Tools you will learn:
•	 Developing solutions
•	 Lean solutions 
•	 Theory of Constraints
•	 Failure Modes & Effects Analysis 

(FMEA)

Once root causes have been identified, the next step is to develop and prioritize 
solutions. The best solution(s) are identified, tested, and then assessed to make 
sure that the intended outcome is achieved. 

You will learn how to:
•	 Use common solution categories to assist in developing solutions for your 

project
•	 Use the results of root cause analysis to develop solutions for your project
•	 Apply Lean solutions
•	 Use benefit/feasibility analysis to evaluate proposed solutions
•	 Apply FMEA to your proposed future state
•	 Plan and conduct a pilot study of your future state process
•	 Establish statistical baselines for your future state process
•	 Test for significant improvements of the future state over the current state

Prerequisite: LSS-103: Measuring Process Performance-II

Improving the Process

Tools you will learn:
•	 Control Plan
•	 Statistical Process Control (SPC)
•	 Response Plan 

LSS-105: Sustaining Improvement Efforts (16 Hours)

Developing and implementing a control plan is necessary to sustain the gains 
achieved by the project.

You will learn how to:
•	 Develop a control plan for the future state
•	 Explain the difference between common causes and assignable causes
•	 Calculate control limits for some commonly used control charts
•	 Explain the purpose and nature of a response plan
•	 Describe a scenario where a process outcome fails to meet a customer 

expectation, but it is not appropriate to initiate a response plan
•	 Understand the principle of a visual factory

LSS GB Test for Successful Completion of Course

Prerequisite: LSS-104: Root Cause Analysis and Improving the Process



 Selecting Your Lean Six Sigma Improvement Project(s)

Your organization should assign a high-priority improvement project to work on during the training program. Selecting the right 
project can have a tremendous effect on your organization’s business results. If project selection is done well, processes will function 
more efficiently in 3 to 6 months, employees will feel satisfied and appreciated for making business improvements and ultimately all 
stakeholders will see the benefit. If project selection is done poorly, it may not have the support of senior management and roadblocks 
may not be removed due to other business priorities. 

Here are some guidelines to help you and your organization identify and prioritize potential improvement projects: 
•	 Every business is different. You should make every effort to ensure your company’s specific priorities are taken into account when 

evaluating potential improvement projects. 
•	 Ask your business leader for the three greatest issues facing the business. Make sure the project is one of the issues or is directly 

related. This will ensure that your management team is giving the project the proper attention and support and is willing to quickly 
remove roadblocks. 

•	 What are the greatest issues as seen from the eyes of your customers? Look through customer complaint logs, listen to call center 
telephone conversations and call customers that have stopped your company service. Create a Pareto Chart to prioritize issues. This 
will help with project prioritization and project selection. 

•	 Is the project manageable? Can the project be completed within six months? If longer, you may lose members as they move to other 
jobs or the team may feel frustrated that they’re not making a difference. 

•	 Will the completed project have a measurable impact on the business processes or financial bottom line? Don’t embark on a project 
without knowing what the benefits are to the business. This will keep your team motivated along the way. 

•	 What is your process capability? If you haven’t been measuring your process, how do you know it needs improvement? Make sure 
you know what amount of defects the process is currently producing and define your project desired outcome.

General Guidelines for Project Selection 
•	 Any project should have identifiable process inputs and outputs. 
•	 A good Lean Six Sigma project should never have a pre-determined solution. 
•	 If you already know the answer, then just go fix it! (For example, Lean projects)
•	 For projects that have operator or operator training as an input, focus on ways to reduce operator variation, making your process 

more robust to different or untrained operators. 
•	 All projects need to be approached from the perspective of understanding the variation in process inputs, controlling them, and 

eliminating the defects. 

Lean Six Sigma is project-intensive. Organizations such as General Electric complete as many as 7,000 Lean Six Sigma projects in a single 
year. Smaller companies can complete several hundred projects per year. Typically, Lean Six Sigma projects address three different areas 
of potential improvement: quality, cost and schedule. Critical-to-quality characteristics are designated CTQ; critical-to-cost, CTC; and 
critical-to-schedule, CTS. This classification can help focus Lean Six Sigma projects by defining project deliverables in terms of their impact 
on one or more characteristics. 

Spreadsheets can provide an objective means of prioritizing potential improvement projects. First, your “Council of Champions” decides 
on a “Balanced Scorecard” of project benefit metrics, for example: Customer Satisfaction (Quality, Delivery, Service…), Sales, Profit, Cash 
Flow, New Business Generation, Safety, Employee Satisfaction, etc. Projects under consideration are rated with respect to each benefit 
metric, and then overall ratings are computed and used to rank the projects by overall benefit. A hypothetical example of this process is 
shown in Figure 1.   

 

Benefit metrics →
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Relative weight → 2 1 1 1       

Reduce defects per unit for process A 3 3 9        18.0

Improve call-center performance 9 3 1        22.0

Reduce days in Accounts Receivable    9       9.0

Reduce lead time for product family B 9 3         21.0

Reduce WIP on production line C    9       9.0

Find and qualify cheaper raw material   9        9.0

Increase reliability of product D 9 3         21.0

           0.0

           0.0

           0.0

           0.0

           0.0

Total metric impact → 30 12 19 18 0 0 0 0 0 0

Pr
oj

ec
ts

Total project benefit

 Rate each project for impact on each metric:     0 = none   1 = weak   3 = moderate   9 = strong

Figure 1. Example of project benefits prioritization 



Potential projects should also be rated with respect to project feasibility metrics like Ease of Implementation, Likelihood of Success, 
Rapidity of ROI, Availability of Data, etc. The overall ratings are then computed and used to rank the projects by overall benefit. A 
hypothetical example of this process is shown in Figure 2.   

Figure 2. Example of project feasibility prioritization  

The final step in project selection should involve joint consideration of overall benefit and feasibility ratings. Projects ranking high for 
both benefit and feasibility are good candidates for immediate action. An example in Figures 1 and 2 is the project “Reduce lead time for 
product family B.”  

Last but not least, considerable time during the first two-day session of the training program will be spent on the subject of project 
selection. If you have two or three potential improvement projects in mind before the first training session begins then information 
gained can be used to make a final decision regarding selection of the optimal improvement project. Your instructor will also be available 
to assist you in project selection if required. The project you select will form the basis for the application of the remainder of the training 
and will be the first outcome of your newly acquired knowledge and skills.
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Relative weight → 1 2         

Reduce defects per unit for process A 9 3         15.0

Improve call-center performance 1 3         7.0

Reduce days in Accounts Receivable 3 9         21.0

Reduce lead time for product family B 9 9         27.0

Reduce WIP on production line C 9 9         27.0

Find and qualify cheaper raw material 9 1         11.0

Increase reliability of product D 9 3         15.0

           0.0

           0.0

           0.0

           0.0

           0.0
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Total project feasibility

 Rate each project with respect to each metric:     1 = low   3 = medium   9 = high

Excel Prerequisites

Computer Platform 
The Lean Six Sigma Green Belt (LSS GB) program is designed around the use of Microsoft Office Excel for PC’s (2010 preferred but 2007 
will also work). If a Mac is used, it must be loaded with the 2016 version of Excel for Macs to be compatible with the course materials 
(Mac Excel version 2011 will not be compatible for some of the statistical analyses). 

Recommended Excel Setup 
Excel set-up needs to include the add-on “Analysis ToolPak” which will enable the “Data Analysis” function in the “Data” tab. See the 
“Excel Analysis Toolpak Setup” for additional instructions. 

Excel Proficiency 
The Lean Six Sigma program was developed on the assumption that participants already know how to perform the Excel operations 
listed in the following table. Practice and proficiency with these Excel operations will allow participants to concentrate on learning the 
concepts and tools of LSS, without having to learn Excel at the same time.  The items in bold are more advanced operations, and you’ll be 
instructed in these during class; learning them ahead of time is optional. 

Excel Tab Operation
File Open, Close, Save As
Home Cut, Copy, Paste, Paste Options (values, formulas etc.), Insert Row/Column, Delete Row/Column, Clear Contents, 

Format Cells (general, text, #, $, %, etc.), Select Cell Ranges, Select Row(s), Select Column(s), Select Row Height, Set 
Column Width

Insert Create, Format and Modify Column Charts; Create, Format and Modify Line Charts; Create and Modify Pivot 
Tables; Create, Format and Modify Scatter Plots

Formulas Insert Function; AutoSum; Edit Cell Formulas; Copy Cell Formulas; Use basic math, stats and logic functions in 
formulas (SUM, SQRT, AVERAGE, STDEV, IF); Use relative and absolute cell references; use quotation marks to 
signify a text result in a logic formula (e.g., =IF(C2<1500, “Fail”, “Pass”)



Excel setup needs to include the Add-On “Analysis ToolPak” which will enable the “Data Analysis” function in the “Data” tab. 

What you should see (from Excel 2010):

If “Data Analysis” does not appear, 
select in the following order:
•	 File tab (in left hand corner)
•	 Options
•	 Add-Ins
•	 Select (highlight) “Analysis ToolPak”
•	 Click Go
•	 Check “Analysis ToolPak”
•	 Click OK

Data Sort (including Add/Delete levels); Filter; Text to Columns; “Data Analysis” needs to be enabled (see notes in Excel 
Set-up section)

View Options to show Gridlines, Formula Bar and Headings should be checked; New Window; Arrange All; Hide/Unhide 
Columns; Freeze/Unfreeze Panes

Other Excel 
Functions

Use of right-click mouse commands; Drag and drop; Select Worksheet; Rename Worksheet; Move Worksheet; 
Copy Worksheet

Go back to the Data tab and see if the “Data Analysis” function shows up (you can try closing and re-opening Excel).  If it does not show 
up, try the command above again, making sure to follow each step. 

If the “Analysis ToolPak” option was not included in the original installation, then the commands above will not be successful. Excel must 
be re-installed making sure it’s included.  

The “Analysis ToolPak” can also be downloaded from the Microsoft Office web site. 

At times, Excel sometimes loses the “Data Analysis” function and the “Analysis ToolPak” must be reloaded (try closing and re-opening 
Excel first).

Excel Analysis Toolpak Setup
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11  Lean Overview

The goal
• Provide the greatest value for customers using the 

fewest resources

The methods
• Principles and practices based on the Toyota 

Production System (TPS)

The barrier • Culture  always defeats methodology

The path forward*

• Create a culture of continuous improvement    

(kaizen)

• Integrate improvement cycles into the daily work     

of all employees

• Improve all processes, every day

*See Toyota Kata (2010) by Mike Rother. 

2Basic principles of Lean

• Value is defined from the customer’s point of view

→ Reduce or eliminate activities that do not add 
customer value 

• Value stream ⎯ all activities required to provide a 

specified family of products or services to the customer

→ Organize workflows by value stream, not by 
department

1

2
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3Customer defines value

Customer value adding (CVA)

• Activities that are required, from the customer’s point of 
view, to provide the desired products and services

• What the customer is willing to pay for

• Changes the form or function of the product

• Goal: Optimize and standardize these activities

Non-value adding (NVA)

• There exists a feasible future state in which the desired 
products and services can be provided without these activities

• Goal: Eliminate or reduce

 Non-value adding but necessary 

• Activities that are not CVA, but cannot feasibly be eliminated 
under current constraints

• Examples include audits, reporting, regulatory compliance, etc.

• Goal: Question and reduce

4

Typical current state value stream

Common example of CVA and NVA

Lead time  =  2,216 mins

Process time  =     116 mins (5.3%)

Queue (material or transactions waiting to be worked on) → 100% NVA 

Operation 1

10m

Operation 3

12m

Operation 2

13m

350m150m100m

Operation 4

23m

200m

Operation 7

16m

Operation 6

35m

Operation 5

7m

450m 450m400m

Wait time  =  2,100 mins (94.7%)

3

4
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5What is the priority:  reducing CVA or reducing NVA?

Current 

state

50% reduction 

in process time

50% reduction 

in wait time

Process time 116 m 58 m 116 m

Wait time 2,100 m 2,100 m 1,050 m

Lead time 2,216 m 2,158 m 1,166 m

Reduction in lead time → 2.6% 47.4%

Operation 1

10m

Operation 3

12m

Operation 2

13m

350m150m100m

Operation 4

23m

200m

Operation 7

16m

Operation 6

35m

Operation 5

7m

450m 450m400m

6Reduce NVA, not CVA!

0
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Current state 50% reduction in touch time 50% reduction in wait time
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Wait time Touch time

5
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7

D Defects: Failure to meet expected standards of quality or delivery

O Over production: Making or doing more than is needed at the time

W Waiting: People waiting to work, or things waiting to be worked on

N
Not utilizing creativity: Failure to integrate improvement cycles into the 

daily work of all employees

T Transportation: People or things being moved from one place to another

I
Inventory: Storing supplies, WIP, or finished goods beyond what is 

needed

M Motion: Excessive motion in the completion of work activities

E
Extra processing: Producing or delivering to a higher standard than is 

required

Categories of NVA

8Exercise 1.1

Think of processes in your organization and list examples of non-value adding 

(NVA) activities. 

Try to identify more than one for each ‘DOWNTIME’ category.

D Defects:

O Over production:

W Waiting:

N Not utilizing creativity:

T Transportation:

I Inventory:

M Motion:

E Extra processing:

7

8
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9Example of organizing work by department

• Each department handles all products → inefficient

• Departments over produce → high levels of WIP

• WIP is valued as an asset ⎯ in reality it’s a cash sink

• WIP moves between departments in large batches → long 

lead times, long lags before defects are discovered

• Poor layout → excessive transport

Press
Lathe

Heat

treat

Saw Deburr

Finishing

10Example of organizing work by value stream

Exit Finish

Enter

Press

Heat

treat

DeburrLatheSaw

One of several

cells

Lathe

• Each cell handles particular, similar products → efficient

• Cells produce only to current customer demand → low levels of 

WIP, less cash tied up

• WIP moves through each cell in small batches → short lead times

• Proximity  of operations → minimal transport, defects identified 

immediately

9

10
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11The kaizen culture

• Kaizen ⎯ Japanese word for “continuous improvement”

• Ongoing, daily process yielding many small improvements

• Employees are expected to expose and solve problems instead 

of ignoring and working around them

• Supervisors and managers must banish kaizen killing language

“That’s a dumb idea”

“That won’t work”

“We can’t do that”

“We tried that before”

“Stop complaining ― just do your job”

12The spirit of kaizen

• Open to change

• Positive attitude

• No blaming

• The only bad questions are the ones not asked

• First find the cause of the problem, then seek 

solutions

• One person, one vote ⎯ position doesn’t matter

11

12
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13Kaizen events

• Kaikaku ⎯  “radical, transformational improvement”

• More commonly known as kaizen event

• A “concentrated dose of kaizen”

• Core team:  pre-event preparation

• Extended team:  3-5 days of 100% dedicated involvement

14Characteristics of a typical kaizen event

• Emphasis on “tribal knowledge” (a.k.a. “wisdom of the 

organization”)

• Causes of the problem are not difficult to identify

• Solutions are not difficult to develop

• Bias for action

✓ Develop solutions during the event

✓ Reconsider previous solution ideas that were discarded

✓ Implement solutions during the event if possible

13
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15Preparation for a typical kaizen event

✓ Project charter completed

✓ Current state process maps completed
• Value stream

• Flowchart

• Spaghetti

✓ Data collected, metrics calculated, goals set

✓ Event training material prepared (if needed)

✓ Event logistics arranged
• War room

• Materials

• Food

✓ Team members, process owners, and resources notified

✓ Impacted workers met with and challenges identified

16Essential component:  the “command center”

15
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17Walking the gemba (“the actual place”)

18Possible pitfalls of kaizen events

• Time constraint drives selection and scoping of projects

“We tend to choose easy projects that can be completed in 3-5 
days.”

✓  Mitigating strategy – Choose larger projects and develop a 
solution during kaizen event.  Use 30-day homework plan for 
implementation.

“We tend to choose projects with very narrow scope ― it is not 
uncommon for us to make improvements in one area only to cause 
problems in another.”

✓ Mitigating strategy – Include team members from other 
potentially impacted areas.  Discuss negative side-effects and 
develop solution that will prevent unintended consequences.

• Gains not sustained after the event

“The results disappear as soon as the team does. We have a lot of 
do-overs.”

✓ Mitigating strategy – Update all necessary documentation, 
develop a training plan, and create supporting management 
materials for the new standards.

17
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19Possible pitfalls (cont’d)

• Failure to foster kaizen culture in the organization 

“We only do kaizen events ⎯ there is very little culture building.”

✓ Mitigating strategy – Culture change takes time.  Be patient.  
Develop problem identification and solving into daily work cycles for 
all people.

“We have done many kaizen events, but the fundamental behaviors and 
processes of top management haven’t changed.”

✓ Mitigating strategy - Include top management in LSS training and 
improvement events.  Change in managerial expectation should come 
from upper management.

“Decisions and changes are driven by ‘outside experts’ rather than the 
people doing the work.”

✓ Mitigating strategy – The role of outside lean experts is to provide 
knowledge on the lean process and tools, and to guide the process.  
Solutions should come from process experts.

20Notes

19
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212  Six Sigma Overview

• Process spread

• Pursuit of perfect quality

• Pragmatic business initiative

22Process spread



 of the population



Greek letter mu

Population mean

+



Greek letter sigma  

Population standard 

deviation  

− +− +−

Normal distribution (bell curve)

21
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23Process capability

LSL USL

0.27% defective (first pass)

 

24Process capability (cont’d)

USL stands for Upper Specification Limit, LSL stands for Lower Specification Limit. 

Specification limits represent the Voice of the Customer with regard to measureable 

characteristics of products or services. 

For the Normal distribution shown above, the mean () is equal to the midpoint of the 

specification range, and the process spread (6) is exactly equal to the width of the 

specification range (USL minus LSL). This means that 99.73% of product or service 

outcomes produced by this process satisfy the spec limits. Equivalently, 0.27% of 

outcomes lead to scrap, rework, do-overs, or other costly measures to prevent or 

respond to customer dissatisfaction.

23
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25

2,700 defective parts per million 

2,000 pieces of mail lost each hour

20,000 wrong prescriptions per year 

15,000 newborn babies dropped per year

No electricity or water 8.6 hours per month 

500 incorrect surgical procedures each week

Pursuit of perfect quality

In the 1980s, Motorola questioned

the adequacy of 0.27% defective as

an improvement objective

LSL USL

 

26Pursuit of perfect quality (cont’d)

LSL USL

Motorola proposed a more aggressive objective



2 defective parts per billion

25
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27Allowing the mean to wander

LSL USL



At most 3.4 defective parts per million (DPPM)

28Wandering mean (cont’d)

• Motorola backed away from 2 defective parts per billion as the 

stretch goal

• They allowed that the process mean might wander as much as  

away from the spec midpoint

• At these extremes, the process would produce 3.4 defective parts 

per million (DPPM) 

• The   offset was somewhat arbitrary, but 3.4 DPPM became 

the definition of “Six Sigma quality” 

27
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29Doesn’t have to be a Normal distribution . . .

0 USL

Before improvement project

30. . . in fact, often it isn’t

0 USL

After improvement project
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31

Suppose we have 10,000 DPPM (99% yield) for each operation

Why set the quality bar so high?

99%

Op 1

99%

Op 3

99%

Op 2

99%

Op 4

99%

Op 5

99%

Op 6

99%

Op 7

Area manager:  “Our overall yield is 99%”

Is this true?

99%

Op 8

99%

Op 10

99%

Op 9

99%

Op 11

99%

Op 12

99%

Op 13

99%

Op 14

32We can’t repeal the laws of probability!

Overall yield*  =  Probability of no defect in 14 operations

 =     …   (14 times)

  =  (0.99)14

  =  0.868746  →  86.9%

131,254 DPPM

*Also known as cumulative yield, end-to-end yield, and rolled throughput yield 
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33

100 DPPM (99.99% yield) in each operation

Setting the quality bar (cont’d)

Overall yield  = (0.9999)14  =  0.998601  →  99.86% 

1399 DPPM

99.99%

Op 1

99.99%

Op 3

99.99%

Op 2

99.99%

Op 4

99.99%

Op 5

99.99%

Op 6

99.99%

Op 7

99.99%

Op 8

99.99%

Op 10

99.99%

Op 9

99.99%

Op 11

99.99%

Op 12

99.99%

Op 13

99.99%

Op 14

34

10 DPPM (99.999% yield) in each operation

Setting the quality bar (cont’d)

Overall yield  = (0.99999)14  =  0.999860  →  99.986%

140 DPPM

99.999%

Op 1

99.999%

Op 3

99.999%

Op 2

99.999%

Op 4

99.999%

Op 5

99.999%

Op 6

99.999%

Op 7

99.999%

Op 8

99.999%

Op 10

99.999%

Op 9

99.999%

Op 11

99.999%

Op 12

99.999%

Op 13

99.999%

Op 14
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35Exercise 2.1

The average yield for 35 operations in an assembly process is 98.4%. Calculate the 

overall yield under the simplifying assumption that the yield for each operation is 

exactly equal to 98.4%. (The real answer would be the product of the actual operation 

yields.)

0

100

Sequence of operations

?

36Exercise 2.1 (cont’d)

The area manager reported 98.4% as the overall yield of the operation. His reaction to 

the correct analysis followed the classic grief cycle:

Denial “This can’t be right. There must be a mistake in your calculation.”

Anger “This is ridiculous. You’re wasting my time.”

Bargaining “Isn’t my method just as valid as your method?”

Depression ‘This is really bad. What am I going to tell everyone?”

Acceptance “I guess you can’t solve a problem if you don’t know you have it.”

35
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37We can count defects instead of defective parts

• Each potential defect on a part, or potential error in a transaction, is 

called an opportunity

• We can use DPMO (defects per million opportunities) instead of 

DPPM (defective parts per million) 

• DPPM is more customer focused 

• DPMO is more process focused 

• Requirements for using DPMO

✓A finite number of identifiable opportunities per part or transaction

✓Statistical independence of defect occurrence at different opportunities

DPMO is a finer measure than
DPPM ― it responds more rapidly to 

process changes

38

Definition of

“opportunity”
Fraction defective

Expressed as a 

percentage
Focus

Each part
Defective parts

% Defective Customer
All parts

Each possible 

defect on a 

part

Defects
Defects per 100 

opportunities 

(DPHO)

Process(All parts)  

(possible defects per 

part)

Each 

transaction

Defective 

transactions % Defective Customer
All transactions

Each possible 

error in a 

transaction 

Errors
Defects per 100 

opportunities 

(DPHO)

Process(All transactions)  

(possible errors per 

transaction)

In many cases, failure rates are quantified as percentages  
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39Pragmatic business initiative

• In the 1990s, GE shifted the emphasis from the Six Sigma quality 

goal to Six Sigma projects ⎯ the way to pursue the goal

• Leaders and Champions define key performance indicators (KPIs) 

⎯ a “balanced scorecard” including but not limited to $$ measures

• KPIs drive a prioritization process

• Prioritization tells us which project(s) should be first in line

• “Black Belts” or “Green Belts” lead the project teams 

• “Champions” provide resources and remove barriers for the teams

40Champions

✓ Management team members

✓ Identify and prioritize projects

✓ Assign project teams

✓ Provide teams with resources as needed

✓ Remove organizational barriers to project completion

✓ Provide project management support

✓ Communicate project results to the organization

39
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41Comparison of Green and Black Belts 

Prerequisites and roles Green Black

• Experience in process improvement ✓ ✓ 

• Strong teamwork, leadership, and people skills ✓ ✓ 

• Basic Excel skills

• Ability to acquire intermediate Excel skills
✓ ✓ 

• Receive training in basic statistical concepts and methods ✓ ✓ 

• Lead project teams ✓ ✓ 

• Provide technical support to project teams ✓ ✓ 

• Prior experience with statistical methods ✓ 

• Able to learn and use statistical software ✓ 

• Receive training in advanced statistical concepts and methods ✓ 

• Assist Champions in project identification and prioritization ✓ 

42Examples of projects

Project Annual $$ benefit

Reduce alpha case on large titanium castings 20,800,000

Reduce cost and lead time to develop extrusion tooling 2,000,000

Reduce wasted medication in hospital central pharmacy 1,100,000

Reduce roll stock inventory in box plant 768,000

Reduce cost of belt grinding in casting finishing 500,000

Improve the court collections process in city government 400,000

Reduce DOA replacement parts in field service 216,000

Reduce DPMO and amount of testing of circuit boards 192,000

Reduce electricity consumption in manufacture of airline storage bins 65,000

Reduce quoting turnaround time (not counting increased Purchase 

Order award rate)
34,000

41

42



Copyright © 2025  ETI Group

433  Why Combine Lean and Six Sigma?

• They require the same kaizen culture

• They employ common strategies

• They focus on complementary problem areas

• They employ complementary methods

• They emphasize fact over opinion and use data to 

inform decisions

• One improvement infrastructure is better than two

44The need for kaizen

• Without kaizen, both Lean and Six Sigma fall into “top down, command 

& control, outside experts” mode 

• Culture always beats methodology ― benefits will be limited

• Improvement cycles must be integral to the daily work of all employees

• Teamwork across departments must be “business as usual”

• Open discussion of problems must be safe ⎯  emotionally and 

professionally

• “It’s not a witch hunt ⎯ it’s a treasure hunt”

43
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45Common strategies

• Driven by Voice of the Customer 

• Focus on eliminating waste

• Focus on processes and process improvement

• Improve processes via team projects

• Keep the improvement cycles going

46Complementary problem focus and methods

Lean Six Sigma

Lead and Cycle time

WIP

Other visible waste

Defects

“Invisible” waste 

Defects caused by chaos and confusion
Defects caused by materials and 

equipment

Root causes easier to determine. 

(Processes directly observable.)

Root causes harder to determine. 

(Processes often not observable.)

Value stream mapping

Geographic mapping

Basic process mapping

Cross functional process mapping

Defines and standardizes the

“Wisdom of the organization”

Data collection and analysis to 

discover a new solution

Common TPS solutions can be adapted 

to many circumstances

Project roadmap provides a 

method for finding solutions

45

46



Copyright © 2025  ETI Group

47A single improvement infrastructure

• Eliminates redundancy

• Eliminates wasteful 

competition for resources

• Provides a universal roadmap 

for improvement projects

Lean
Six 

Sigma
LeanLean Six SigmaLean

Six 

Sigma

48Lean Six Sigma

Originally, TPS included virtually all the tools of what we now call Lean Six Sigma 

(LSS). When TPS came to the USA, the Lean tools were adopted right away, but the 

Six Sigma tools were not. This made sense because there was plenty of “low hanging 

fruit” that could be harvested by Lean without undertaking the difficult task of 

teaching people statistical concepts and methods.

For many organizations, it still makes sense to embrace Lean concepts and methods 

first. The LSS project roadmap is an excellent vehicle for this. Eventually, 

organizations will need to tackle more difficult problems that cannot be solved with 

Lean concepts and methods. When this time comes, the LSS project roadmap provides 

the Six Sigma concepts and methods needed to solve the more difficult problems. 

Thus, in the USA at least, we might think of Lean and Six Sigma as fraternal siblings 

separated at birth, reunited at last by LSS.
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494  Relation of LSS to Other Initiatives

• Strategic planning

• ISO 9001

• Voice of the customer

• Supply chain management

• Balanced scorecard

50Strategic planning

Mission statement

Vision statement

Objectives, measures

Strategies, projects, initiatives

Tactics, action plans

Key success factors,
core competencies

• Strengths

• Weaknesses

• Opportunities

• Threats

• Assumptions

• Benchmarking

Identifying
candidate
projects

Prioritizing
candidate
projects 
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51ISO 9001

Management

review

Internal audits

Corrective & preventive

action system

Data collection & analysis

Identifying
candidate
projects

Prioritizing
candidate
projects

Lean Six Sigma

Projects

52Voice of the customer

• Resolving complaints does not increase customer satisfaction

• Suppliers must proactively discover what customers really want

✓ Collect and analyze data on customer feedback, complaints, 
returns, . . .

✓ Visit customers in person ⎯ observe, listen, learn

Identifying
candidate
projects
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53Supply chain management

• Finding the right suppliers

• Building partnerships, not just writing contracts

• Knowing and communicating your needs and expectations

• Listening to the “Voice of the Supplier”

• Monitoring your supplier’s performance

• Giving clear and useful feedback

Joint projects

54Balanced scorecard

Financial
Revenue

Profit

Costs
...

Customer
Customer satisfaction

Quality

Delivery

Employee satisfaction

Safety
...

Internal process
Defects

Lead time 

Supply chain performance
...

Learning & growth
New business

Effectiveness of training

Cumulative benefit of projects
...

KPIs
Project prioritization
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555  Deploying LSS Projects 

• Roles and responsibilities

• Limiting projects in process

• The continuous improvement cycle  

• LSS and the Fire model

56

Define

KPIs

Identify 

candidate

projects

Prioritize

candidate

projects

Champion

projects

Lead 

projects

Top Mgmt ✓

Corporate level 
✓ ✓ 

Champions ✓ ✓ ✓ ✓ 

Black Belts ✓ ✓ ✓ 

Green Belts
✓ 

LSS Project ✓ ✓ ✓ 

Roles and responsibilities
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57Must limit projects in process

• Suppose we have two “belts”, each leading four projects 

• They are spread too thin

• It takes a long time to get the projects done

• It takes a long time to accrue the benefits
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58Limit projects in process (cont’d)

• Much better to give each of them one project at a time

• Now they have a manageable workload

• Project lead time is dramatically reduced

• Accrual of benefits is accelerated
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59Continuous improvement cycles

Ongoing identification

of candidate projects Project

buffer

Resource

buffer

Active

projects

Complete

a project

No

YesPrioritize

projects

Resources

available?

Start a

project

 

 

60LSS and the Fire model

Culture
(oxygen)

Projects
(fuel)

Training
(spark)

Teamwork
(chemical reaction)

LSS

• Many organizations are stuck in fire-

fighting mode ― reacting to crises 

• These are the organizations most in 

need of LSS

• The goal of LSS is to light fires ― to 

pursue high priority improvement 

opportunities with urgency in order to 

prevent crises
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616  LSS Project Roadmap

PDCA

Shewhart/Deming

1930s

Act Do

Check

Plan

The scientific method applied to business problems

62PDCA (cont’d)

• PDCA is the oldest improvement cycle for manufacturing, business, 
and service processes

• It has been around for more than 80 years, it has served us well, and 
it is still in use

Plan
Define the problem to be solved, collect and analyze data on the current 

state, identify possible causes of the problem.

Do
Identify possible solutions, select the most likely solution, pilot the 

solution. 

Check Analyze the results to see if the problem is solved.

Act
If the solution is successful, implement it. If the solution is not 

successful, repeat the cycle.
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63DMAIC

Motorola/GE 

1990s

Control Measure

AnalyzeImprove

Define

A high level description of today’s most widely

used improvement project roadmap

64

• Define the problem to be solved

• Make sure it has high business priority

• Define the project scope

• Publish a project charter

• Observe the current state

• Collect data on the current state

• Calculate baselines for project metrics

• Set quantitative project goals

• Analyze current state data

• Use observations and analysis results to 
identify possible causes of the problem

• Identify and prioritize possible solutions
• Review with stakeholders
• Pilot the selected solution(s)
• Analyze the results

• Implement successful solutions

• Implement statistical monitoring to sustain the 
gains

DMAIC has more “teeth” than PDCA

Measure

Analyze

Improve

Control

Define

Plan

Do

Check

Act
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65Common DMAIC complications

Measure

Analyze

Improve

Control

Define

Stakeholders happy?

Root causes determined?

Revise project baselines?

Yes

No

No

Yes

No

Yes

66

Select
project

SIPOC

Observe
current
state

Map
current
state

Address
measurement

systems

Collect
data

Quantify
current
state

Y = f (X)
analysis

Determine
root

causes

Develop
future
state

Review
with

stakeholders

Pilot
future
state

Quantify
future
state

Develop
control

plan

Implement
future
state

Monitor
future
state

Close
out

project

Charter
project

Plan data
collection

The LSS project roadmap (detailed version of DMAIC)

• Arrows indicate precursor/successor relationships

• Dashed lines indicate project reviews with champion

Define Measure Analyze Improve Control
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67Strengths of LSS projects

• Aligned with business priorities

• Clearly defined scope and boundaries

• Combination of process observation and data analysis

• Solve problems by understanding them  

• Conclusions supported by statistical standards of evidence 

• Improvements verified quantitatively

• Statistical monitoring used to sustain gains

68Characteristics of LSS projects

• We want to improve a process (the way we do something) or product 

(a way for customers to do something)

• The current process or product falls measurably short of what is 

needed or desired

• The cause of the problem is not known, or there is lack of consensus 

as to what it is

• Process observation and data collection/analysis are required 

• Root cause analysis is required

• Lean solutions may or may not be applicable
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69Examples of LSS projects

Probability that Lean 

solutions will apply

• Reduce injection molding defects 

• Reduce injection molding setup time 

• Reduce oxidation layer on titanium castings 

• Reduce unplanned downtime 

• Reduce Request For Quote (RFQ) turnaround time

• Reduce repair shop turnaround time 

• Reduce the cost of belt grinding

Low

High

Low   

Medium

High

High

Low

70Other types of projects (non-LSS) 

• We know what needs to be done, and we want to do it

• It may be simple, quick, and cheap (a “just do it” project)

• It may be complex, time consuming, and/or expensive (a 

“project management” project)

• All of the above involve implementing known solutions

• These projects could be action items resulting from a LSS 

project, but they are not in themselves LSS projects
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71Examples of non-LSS projects

Automate a task that is currently done manually 

Upgrade software to the latest revision 

Revise outdated work instructions

Install a new piece of equipment

Obtain environmental permits

Replace outdated computers

Install a bar coding system

Build a plant in China

72Exercise 6.1

Classify these projects LSS Other

Implement the new ERP system we have decided to use

Reduce errors in processing purchase requisitions

Reduce wave solder defects

Open a new branch office in the next town

Reduce billing lead time

Install a web-based ordering system 

Reduce non-manufacturing time from order to sell

Reduce scrap in the coiling department

Eliminate cracking of molded housings

Reduce installation & warranty costs

Increase the percentage of quotes that produce a PO
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73

Select
project

SIPOC

Observe
current
state

Map
current
state

Address
measurement

systems

Collect
data

Quantify
current
state

Y = f (X)
analysis

Determine
root

causes

Develop
future
state

Review
with

stakeholders

Pilot
future
state

Quantify
future
state

Develop
control

plan

Implement
future
state

Monitor
future
state

Close
out

project

Charter
project

Plan data
collection

7  Identifying Candidate Projects

74Where do candidate projects come from?

• Benchmarking

✓ If they can do it, why can’t we?

• Vision of the future

• Demand expected to exceed current capacity

✓ Seems to require capital expenditure

✓ Better to reduce defects and lead times

• Voice of the customer (VOC)

✓ Quality

✓ Delivery

✓ Cost

✓ Service

• Cost of waste analysis

✓ Follow the money

We will focus 
on these two
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75Capturing VOC data

• Direct observation of the customer’s process
✓ Engage customers in conversation around their work

✓Not specific to product features

✓ Capture their words — clues to unspoken needs

• Interviews
✓One on one, team on team, focus groups . . .

• Surveys
✓ Telephone, mail, email, website . . .I
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76

H. What is your level of satisfaction with our delivery 

performance relative to your requested delivery date? 

_____ 5. Completely satisfied

_____ 4. Very satisfied

_____ 3. Moderately satisfied

_____ 2. Slightly satisfied

_____ 1. Not satisfied at all

H. How important is it to you that we deliver our products 

within one day of your requested delivery date? 

_____  5. Most important

_____  4. Very important

_____  3. Moderately important

_____  2. Slightly important

_____  1. Not important at all

VOC survey method 

Ask two questions for each customer requirement

What is the
importance of

this requirement
to you?

What is your level
of satisfaction with

our performance
relative to this 
requirement? 

X

X
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77“Perceptual map” based on VOC data

• Average importance vs. average 

satisfaction for requirements A 

thru I

• Need improvement projects 

directed at requirements H and D

• The averages could represent 

multiple customers (smaller 

companies)

• They could also represent multiple 

individuals with different roles 

within a single customer (larger 

company)
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78Exercise 7.1

Discuss the following questions:

(a) What types of Voice of the Customer (VOC) information does your organization 

monitor and analyze? 

(b) How is this VOC information obtained? That is, who gathers it and what 

methods are used to do so? These methods may be both formal and informal.

(c) How might you use VOC information to identify potential LSS projects for 

your area of the organization? Consider both internal and external customers.

(d) What are some past examples of decisions, actions, or improvement projects 

based on VOC information?
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79Often your customers are happy . . .

. . . but you’re killing yourself to make it so 

DeliveryExpediting

Quality

Overtime

Premium freight

Inspect/sort

Rework

Scrap

Your customersYou

ServiceInstallation & warranty costs

LSS

projects

80Cost-of-waste analysis

• Includes, but not limited to, cost of poor quality 

• Assists in project selection and scoping

• Needed to establish project baselines 

• Assists in defining project goals

• Needed to determine project benefits

• Money speaks loudest in many organizations
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81Apparent cost of poor quality

Manufacturing

process
Defective?

Y

N

$

Customer

Scrap

82What is the real cost of poor quality?

$$

$$
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83The “hidden factory”

Defective?

Rework

Y

N

Manufacturing

process

Defective?

Y

N

Scrap

$

$

$

$

Customer

Defective?Returns Y

$

N

Can it be
fixed?

Y

N

$

84Hidden factory (cont’d)

• Inspections to sort good parts from 

bad 

• Efforts to determine causes of defects

• Inflating material orders and 

time/cost standards

• Returned goods

• Service activity under warranty

• Trips to placate unhappy customers

• Loss of business due to unhappy 

customers

• Reworking or scrapping defective 

parts

• Complicated inventory management 

• Specialized training for rework 

processes

• Specialized rework equipment

• Capacity allocated to rework

• Special rework qualification 

processes
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85Example:  cost-of-waste analysis

$$

• This was the first detailed cost-of-waste analysis 
conducted by this manufacturer

• They were surprised to find that the cost of 
carrying WIP and finished goods was the big hitter

86Costs of poor transactional quality

• Waste is harder to see in transactional processes 

• The only quantifiable cost factor is the time people spend on 

NVA activities

• Even if this time is reduced, there will be no actual cost 

reduction (unless people are laid off)

• The real benefits are 

✓Reducing lead time,

✓Increasing customer satisfaction, and 

✓Increasing capacity without additional resources
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87The “hidden office” 

Errors?

Do over

Y

N

Transactional

process

Errors?

Y

N

$

Customer

$

Errors?

$

Do-overs

$
Y N

88Hidden office (cont’d)

• Doing things over again due to errors or omissions

• Inspections to find errors and omissions

• Workarounds necessitated by root causes not being 

addressed

• Efforts to determine causes of errors and omissions

• Loss of business due to unhappy customers
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89

D Failure to meet expected standards of quality or delivery

O Making or doing more than is needed at the time

W People waiting to work, or things waiting to be worked on

N
Failure to integrate improvement cycles into the daily work of all 

employees

T People or things being moved from one place to another

I Supplies, WIP, or finished goods beyond what it is needed

M Excessive motion in the completion of work activities

E Producing or delivering to a higher standard than is required

Other costs of waste (from the Lean playbook) 

90Exercise 7.2

a) The current practice of a central pharmacy in a hospital is to prepare all IV 

piggybacks and syringes for each day at 7:00 am. Every day, some of this 

medication is wasted because patients are discharged, transferred, or have their 

medication orders changed. The anecdotal estimate of the annual cost of this waste 

is $100,000. Open Data Sets → hospital central pharmacy to use the “hidden 

factory” data given below and in the spread-sheet to get a better estimate of the 

annual cost of waste. (Assume 52 working weeks per year.)

b) Suggest a way to reduce the cost of waste in this example.

Number of doses wasted 657

Staff hours spent retrieving wasted doses 21

Staff hours spent disposing of wasted doses 10

Weekly averages

Product cost per dose $14

Disposal fee per dose $42

Labor cost per hour $23

Average rates

c)  What other costs or impacts can you think of that might be occurring due to this    

practice?
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8  Prioritizing Candidate Projects

92Qualitative description of a good improvement project

Clearly defined problem, scope, and boundaries 

Clearly defined project metrics with baselines and goals

Resources available, good chance of success, rapid benefits  

Aligned with business priorities

Can complete in a reasonable amount of time

Specific

Measurable

Achievable

Relevant

Time-bounded

How do we quantify these attributes?
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93Examples of project feasibility metrics

✓ High likelihood of solving the problem

✓ Rapid completion of project

✓ Rapid realization of benefits

✓ Availability of required resources

✓ Availability of data

✓ Process is easy to change

✓ . . .

94Feasibility metrics (cont’d)

Sometimes people want to use cost of implementation or ease of implementation as 

feasibility metrics. The cost metric doesn’t make sense for LSS projects, because we 

don’t know what the solution is going to be. The same can be said for the ease metric, 

if it refers to a solution. 

If, on the other hand, the ease metric refers to the changeability of the in−scope work 

flow, then it is valid. 
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95Measures of project impact:  KPIs 

✓ Customer satisfaction ⎯ quality, delivery, service . . . 

✓ Revenue, cash flow, cost of waste . . .

✓ Growth in existing markets

✓ New market penetration

✓ Lack of adverse safety impact

✓ Lack of adverse environmental impact

✓ . . . 

96KPIs (cont’d)

An organization should use its key performance indicators (KPIs) to measure the 

probable impact of proposed improvement projects. KPIs are often established during 

a strategic planning process. 

If your organization has a balanced scorecard, it has already taken a step towards 

understanding what its KPIs are. If a KPI in a balanced scorecard is defined too 

broadly, it will need to be broken down further to be useful in project prioritization. 

An example would be breaking “customer satisfaction” into separate KPIs for quality, 

delivery, and service.

KPIs should be defined before they are used to prioritize projects. This helps people 

distinguish between the KPIs and the projects themselves, which in turn helps in 

scoping projects appropriately. For example, “reduce scrap and rework” is too broad 

for a project scope. A better project scope would be something like “reduce scrap and 

rework for product XYZ.”

KPIs are supposed to reflect the priorities of the organization. As such, they should 

change when these priorities change, and only then. 
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97Instructions for prioritizing projects

1. Open Student Files → blank C&E matrix − impact & feasibility.

2. In the Metrics sheet, change Impact metrics to KPIs. (Already done)

3. List your KPIs and relative weights.

4. List your feasibility metrics and relative weights.

5. Go to the Impact ratings sheet, change Items to be ranked to Projects.

6. List the candidate projects you wish to rank.

7. Rate each project for degree of positive impact on each KPI 

(by H, M, L).

98Prioritizing projects (cont’d)

8. Go to the Feasibility ratings sheet, rate each project for each feasibility 

metric (by H, M, L).

9. Go to the sheet Impact−feasibility plot to evaluate the results.
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99Student Files \ prioritizing projects − example 1

Metrics tab

100Metrics (cont’d)

• Enter your KPIs in the Metrics sheet 

• State KPIs in “higher is better” form ― for example, use “reduce cost of 

waste” instead of “cost of waste”

• Enter relative weights (importance) for the KPIs. Here is a process for doing 

this:

1. If the KPIs are equally important, weight them all as 1.

2. If some KPIs are more important than others, split them into a more 
important group and a less important group.  

3. If some KPIs in a group are more important than others, split them into a 
more important subgroup and a less important subgroup.  

4. If necessary, split subgroups into sub-subgroups.

5. If you end up with two homogeneous groups, use weights 1 and 2. If you end 
up with three homogeneous groups, use weights 1, 2, and 3. And so on.

• Everything said here applies as well to your feasibility metrics.
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101Impact ratings

102Comments on impact and feasibility ratings

The slide above shows the Impact ratings sheet with some project titles entered. Our 

job is to rate each project as having high (H), medium (M), low (L), or no impact 

(blank) on each KPI. The numerical codings for H, M, and L are specified in the sheet 

Impact calculations.

Ideally, the team should assign the ratings one KPI at a time, because our goal is to 

prioritize the projects, not the KPIs. If you would rather assign the ratings one project 

at a time, just make sure to check that the resulting project rankings for each KPI 

make sense.

The next slide shows the Feasibility ratings sheet. Here we rate each project as high 

(H), medium (M), or low (L) for each feasibility metric. The numerical codings are 

specified in the Feasibility calculations sheet.

As for the impact ratings, it is best if the team assigns feasibility ratings one metric at 

a time. If you would rather assign the ratings one project at a time, just make sure to 

check that the resulting project rankings for each feasibility metric make sense.
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103Feasibility ratings

104Impact-feasibility plot

• Project names and impact ratings are carried forward from the Impact ratings sheet

• Feasibility ratings are carried forward from the Feasibility ratings sheet 
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105Impact-feasibility plot (cont’d)

106Impact-feasibility plot (cont’d)

This is a scatterplot of the overall impact and feasibility scores for the projects. The 

upper right hand corner is the “sweet spot.” Projects that score highly for both impact 

and feasibility should be your first priority.

Based on the plot, projects A and F both have high priority based on the plot. 

Assuming you have resources for only one project, how should you choose between 

them?

The answer to this question can be found by considering the maturity of your 

organization with respect to continuous improvement. If your organization is solidly 

committed to continuous improvement, and has been at it long enough to dispel any 

skepticism in the workforce, you should go with A (greater impact). On the other 

hand, if your organization has just started its continuous improvement journey, and 

you want a high probability success to win over the skeptics, you should go with F 

(greater feasibility).

105

106



Copyright © 2025  ETI Group

107Student Files \ prioritizing projects - example 2

KPIs Relative weights Project feasibility metrics Relative weights

Improve cust. satis. w/delivery 2 Process is easy to change 3

Improve cust. satis. w/quality 2 Rapid completion of project 2

Improve cash flow 1 Needed resources available 2

Improve P, Y, E 1 Highly likely to solve the problem 1

Lack of compliance/safety impact 1

Lack of environmental impact 1

Reduce other cost 1

Reduce scrap or rework 1

Worksheet:  “Metrics”

108Impact and feasibility scores
Projects Tag Benefit Feasibility

Improve first pass yield of sonic welding A 34 18

Reduce injection molding start-up scrap B 15 24

Reduce final assembly cycle time for exterior SAE compliant lamps C 18 40

Improve first pass yield of manual solder D 20 28

Improve first pass yield of wave soldered parts E 20 24

Reduce internal scrap due to material handling F 12 24

Reduce scrap in painting G 37 18

Reduce scrap in metallization H 36 28

Reduce scrap in doming I 45 14

Reduce scrap in epoxy mixing J 13 56

Reduce internal fog lamp process K 41 22

Improved first pass yield of name plates thru painting and doming L 49 10

Reduced plant power consumption M 22 18

Reduce product development testing cost N 15 50

Reduce product development time O 26 14

Improve % of products that meet requirements 6mos after PPAP P 24 18

Reduce number of design changes post design freeze prior to SOP Q 26 20

Reduce payables processing time R 13 48

Improve reporting accuracy of end of life service only product cost S 15 48

Reduce period end closing time T 7 48

Reduce working capital as a % of sales U 23 18

Reduce warranty returns of lamps with water ingress V 14 24

22 projects!

Impact
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109Impact-feasibility plot
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110Impact-feasibility plot (cont’d)

• Nothing in the “sweet spot” 

• Instead, an “efficient frontier” running from project J 

down to project L 

• This company had been at it for a while, so they 

chose project L 
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111

Open Student Files → prioritizing projects − exercise. Use your knowledge and 

experience to do the following tasks.

a) Choose three (3) of the given KPIs to use in the exercise. Feel free to modify the 

weights for the impact and feasibility metrics as desired.

b) Rate the projects with respect to impact for the 3 KPIs you chose.

c) Rate the projects with respect to feasibility, using the given metrics.

d) Use the impact−feasibility plot to determine which of these projects your team 

would give top priority. 

Exercise 8.1

112Exercise 8.2

This is “homework” to be done as a group activity involving Black Belt candidates 

and individuals likely to serve as Champions. It could also include other stakeholders. 

Do (a) and (b) first. Do (c) and (d) later in a separate session.

(a) Identify KPIs likely to be used by your organization to prioritize 

improvement projects.

(b) Identify feasibility metrics likely to be used by your organization to prioritize 

improvement projects. 

(c) Compile a list of candidate improvement projects. 

(d) Use the project prioritizer to rank these projects.
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9  Chartering LSS Projects

114Elements of a project charter

• Project title

• Problem and goal statements

• Value stream scope

• Workflow scope

• Constraints, concerns, assumptions

• Primary project metrics, baseline values & goals, KPIs affected  

• Secondary (“do no harm”) metrics, baseline values

• Team members and roles

• Resources and roles

• Stakeholders and their connection to the project

• Start and project review dates

113
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115Purpose of the charter

•  Make the business case for the project

•  Define the project scope and process boundaries

•  Define the project metrics, give baselines and goals

•  Identify the project team

•  Identify resources for the team

•  Identify stakeholders affected by the project outcome

•  Provide a starting point for managing the project 

•  Create buy-in and excitement 

116The charter must evolve with the project

• Baselines for benefit metrics may not be known initially ⎯  

update the charter when these are determined 

• Project scope may be modified as new information comes to 

light

• Stakeholders may change if the project scope is modified

• Additional resources may be needed to overcome 

unanticipated barriers

• Anticipated completion dates for project reviews may have to 

be pushed out
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117Problem statement

• Describes the current situation in objective terms

 

• Does not suggest or imply solutions 

• Locates the problem in time

• Can include baseline values of project metrics

• Gives enough information that people outside the team can 

understand what the project is about

What
is

118Problem statement guidelines

State the effect 

Say who and what are affected, and how they are affected. Say what is wrong, not 

why it is wrong. Avoid “due to” or “because of” statements ⎯ they imply solutions. 

 

Be specific 

Avoid general terms like “morale,” “productivity,” “communication” and 

“training” — they tend to have a different meaning in each person’s mind. Use 

specific, operationally defined terms to narrow the focus to the problem at hand.

Use positive statements 

Avoid “lack of” statements (e.g., not enough, we need, we should). Negative 

statements imply solutions. Do not state a problem as a question ⎯ this implies that 

the answer to the question is the solution.

Quantify the problem 

Say how much, how often, when, where. Use project metrics.

Focus on the “gaps”

Compare the current levels of the project metrics to previous levels, expected levels, 

or desired levels. These will also be presented in the Project metrics section.

117

118



Copyright © 2025  ETI Group

119

In 2024 there were 15 industrial accidents 

site wide. Previously, the annual average was 2.5 with

at most 7 in a given year. This new level represents 

a significant decline in employee safety. If it 

continues, we will see a $200,000 increase in annual 

costs, and substantially decreased productivity.

Example: Critiquing a problem statement

120

❑ What is happening? 

❑ Who is affected by the problem?

❑What are the “gaps”?

❑ What are the consequences of not solving the problem?

❑ Where does the problem occur?

❑ When does the problem occur?

❑ When did the problem start?

Example: Checklist for critiquing a problem statement
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121Exercise 9.1

Customers are dissatisfied with telephone support 

wait times for calls handled through our call

center in Uzbekistan. Our records show an average

wait time of 8 minutes. 10% of wait times exceed

20 minutes.

Critique this problem statement using the checklist below. Check the boxes for 

questions that are answered. The purpose of this process is to note which questions 

are not answered.

122Checklist for critiquing a problem statement

❑ What is happening?

❑ Who is affected by the problem?

❑ What are the “gaps”?

❑ What are the consequences of not solving the problem?

❑ Where does the problem occur?

❑ When does the problem occur?

❑ When did the problem start?
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123Evolution of problem statements 

  ☺

We are unhappy with our 

customers because they 

don’t pay our invoices on 

time. 

15% invoices submitted to 

customers are paid more 

than 60 days late.

20% of invoices submitted 

to Customer X last year 

were paid more than 60 

days late. This compares to 

5% for our other customers.

Due to lack of training in 

the ED (Emergency Dept.), 

patients are waiting too 

long.

The average wait time for 

ED patients has increased 

from 1 hour to 2 hours. 

In the last 6 months, the 

average wait time for ED 

patients during peak hours 

has increased from 2 hours 

to 4 hours.

124

  ☺

Regional account managers 

submit RFQs (Requests for 

Quotes) to business 

units on behalf of customers.

The account managers say 

our customers are voicing 

dissatisfaction with our 

long quotation turnaround 

times (TATs). The business 

units don’t really think 

there is a problem. If there 

is a problem, it is most 

likely caused by the account 

managers.

Regional account managers 

submit RFQs to business 

units on behalf of customers. 

The expectation is to turn 

quotes within 3 days. 

According to the account 

managers, this expectation 

is not being met in many 

cases. This is causing 

customer dissatisfaction and 

lost orders.

Regional account managers 

submit RFQs to business 

units on behalf of customers. 

The expectation is to turn 

quotes in 3 days. Over the 

past 17 months, 27% have

exceeded 3 days. The TATs 

have ranged from 1 to 29 

days, with an average of 2.8 

days. We suspect that long 

TATs are at least partially 

responsible for lost orders.

(Student Files \ Case Studies 

\ quotation process 

\ quotation process charter) 

Evolution of problem statements (cont’d) 
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125

As our business has grown over the years, our tool development 

process has become a major problem. The primary customer 

complaint is that our order-to-sell time is too long. This is caused 

primarily by large numbers of tool rework cycles. Over the past year, 

the number of reworks per tool ranged from 0 to 18. The order-to-

sell time ranged from 3 to 57 days. The rework cost per tool ranged 

from 0 to $32,400. We cannot compete on price with our Chinese 

competitors, so our only hope is to compete on quality and lead time. 

A secondary problem is that many of the tools released to 

manufacturing from the current testing process require slow line 

speeds and high material weight. 

Example Problem statement: Student Files \ Case Studies \ 

tool development \ tool development charter

126

“Alpha case” is an oxidation layer commonly found on titanium 

castings in the as-cast condition. It must be removed by chemical 

milling. Alpha case is measured by chemical analysis of coupons taken 

from the castings. The upper specification limit for O2 is 200 PPM. 

Over the past six months, post-milling O2 levels on large titanium 

castings have gradually trended upward. It has become common 

practice to send castings back for one or more extra chemical mills 

to bring the O2 below 200. Each extra cycle reduces our profit 

margin by $TBD and adds TBD days to the lead time. 

In the past two months, repeated chemical milling has failed to solve 

the O2 problem for increasing numbers of castings. Instead, these 

castings are scrapped for dimensional nonconformance. This has 

resulted in scrap costs of about $400,000 per week, and has severely 

hindered our ability to meet delivery schedules. 

Example Problem statement: 

Student Files \ Case Studies \ Ti casting \ Ti casting charter
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127Exercise 9.2

(a) Write a problem statement for the project you and your team currently have in 

mind. Leave blanks for metrics, as needed.

(b) Share your problem statement with another team. Take appropriate precautions for 

any proprietary information.

(c) Write a critique of the problem statement you receive from another team.

(d) Share your critique with the other team and the class. (Start by saying something 

positive.)

(e) Revise your problem statement in light of the other team’s comments.

128Exercise 9.2 (cont’d) Problem Statement Outline/Critique Checklist

Problem Statement Guidelines

• State the effect  

• Be specific 

• Use positive statements 

• Quantify the problem 

• Focus on the “gaps”

❑ What is happening?

❑ Who is affected by the problem?

❑ What are the “gaps”?

❑ What are the consequences of not solving the problem?

❑ Where does the problem occur?

❑ When does the problem occur?

❑ When did the problem start?
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129Examples of goal statements

• Meet the 3-day turnaround time (TAT) expectation 95% of 

the time.

• Achieve O2 level of 200 PPM or less for all castings after first 

chemical milling.

• Complete all first project reviews within the 10-day 

expectation.

What
is

What 
should

be

• Reduce the number of reworks per tool by 50%. 

130Project scope:  the two dimensions

Value stream scope

• Which customers?

• Which products?

• Which services?

• Which locations?

• Which suppliers?

• Which materials?

Workflow scope

• Starts with an RFQ (request for quote) from the customer, ends with an 

approved quote or a request to modify the RFQ. 

• Starts with receipt of a CAD drawing from the customer, ends with an 

approved tool and run conditions released to Manufacturing. 

• Starts with ceramic slurry make up, ends with a finished casting. 

• Billing, payment, adjustment, and collection.

• Order processing, fulfillment, and costing.
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131Examples of project constraints and concerns

Constraints Concerns

• Deadlines for project completion

• Types of solution excluded 

• Limitations on availability of 

resources 

• Limitations on availability of data

•  . . .

• Several previous attempts to solve this 

problem were unsuccessful

• The low average TAT has created the 

impression there is no problem 

• None of the process participants want to 

be on the team

• Our yield is currently 0%, so we must 

move quickly to solve this problem

•  . . .

132Examples of project assumptions

• How often the team will meet

• How long the meetings will be

• Time to be spent on the project by each team member

• Roles and responsibilities of the team members

• In scope solutions will apply to out of scope areas

• We will be able to get some process participants on the team 

• We will engage stakeholders and convince them to support the 

project

• . . .
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133Project metrics

• Total number of defective parts last month, by day of week

• Can we conclude that Tuesdays are best and Wednesdays are 
worst?

0

2

4

6

8

10

12

14

16

18

Mon Tues Wed Thurs Fri

134Project metrics must be normalized!

• Part volume was 
lower on Mondays

• % Defective is 
much higher on 
Mondays

• The problem is 
worse on Mondays 
than on other days0
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Improper patient preps CT scans

52% 29% 30% 31% 30%

Defective parts Parts produced
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135Categories of Project Metrics

The three main categories of project metrics are quality, delivery and cost. 

• It is recommended that your primary metric be a Quality or Delivery 

metric, in order to keep your project focused on the process. 

• With process improvement, cost will follow.

If your primary metric is: Secondary metrics to 

consider are:

Quality (defects, scrap, rework, etc.) Delivery and Cost 

Delivery (time to complete, on-time 

delivery, etc.)

Quality and Cost

Cost Quality and Delivery

136Examples of project metrics

a) Statistics calculated from current state data (must be normalized)

Statistic Data needed to calculate statistic

Avg. number of reworks Numbers of reworks for N tools

Avg. time order to sell Order to sell times for N tools

PO hit rate PO (yes or no) for N quotes

% TAT > 3 TAT > 3 (yes or no) for N quotes 

Avg. TAT Turnaround times for N quotes 

% O2  > 200 O2 > 200 (yes or no) for N castings after first chem. mill

Avg. O2 O2 levels for N castings after first chem. mill

Do you see a pattern here? TAT = Turnaround Time

135

136



Copyright © 2025  ETI Group

137Project metrics (cont’d)

• Cost of product 
rework

• Cost of product scrap

• Cost of tool rework

• Cost of lost orders

• Cash flow

• Revenue 

• . . .

b) Validated financial calculations are needed to ensure your baseline 

costs (and benefits achieved) align with the financial methods used 

by your organization 

• Total $$ for a specified 
time period

• Annualized $$

• $$ as percent of COGS

• $$ as percent of sales

• . . . 

COGS = Cost of Goods Sold

Normalized

138Project metrics must be linked to KPIs

✓ Customer satisfaction ⎯ quality, delivery, service . . . 

✓ Revenue, cash flow, cost of waste . . .

✓ Growth in existing markets

✓ New market penetration

✓ Lack of adverse safety impact

✓ Lack of adverse environmental impact

✓ . . . 
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139Exercise 9.3

Define the primary metric for the project you currently have in mind. Describe the 

data that will be needed to calculate it and give the formula by which it will be 

calculated.

140Exercise 9.4

Define secondary metrics for the project you currently have in mind. Describe the data 

that will be needed to calculate them, and give the formula by which it will be 

calculated.

139

140



Copyright © 2025  ETI Group

141Baselines for project metrics

• Should be calculated from data representative of the current 

state

• Use a long enough timeframe to get an adequate sample size

• Don’t go back so far that you lose relevance to the current 

state

142Setting goals for project metrics

• From benchmarking

• From established business goals

• Performance prior to onset of the problem

• A percentage of the current state value (once this has been 

established)

• 50% reduction is a common goal*

*In many cases this is feasible and will have substantial business impact

141
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143LSS projects must be team projects 

• They need to solve difficult problems

• They need expertise in diverse areas

• They require resources controlled by different parts of the 

organization

• They need internal customer/supplier participation

• They have to consider unintended consequences of proposed 

solutions

• They must create stakeholder support for proposed solutions

144

Team work

✓ Developing shared purpose

✓ Sharing information

✓ Combining, enhancing, 
improving, refining ideas

Iteration between team and individual work

Individual work

✓ Following up on action 
items 

✓ Gathering information

✓ Creating new ideas
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145Team member knowledge and experience

In scope workflow – operational
In scope workflow – technical  

Lean Six Sigma

External suppliers 
Internal suppliers      

Internal customers        
External customers            

Multiple dimensions must be represented

146Knowledge and experience (cont’d)

It might seem that the ideal project team would consist entirely of people who 

possess substantial knowledge in all of the dimensions mentioned above. One problem 

is that such people may not exist. In any case, the ideal team should be well balanced 

with respect to these dimensions. Here are some reasons: 

• All relevant perspectives on the in−scope work flow must be represented within 

the team:  process participants, customers, suppliers, and other stakeholders.

• Team members with little prior knowledge of the in−scope work flow can 

provide the team with “outside eyes” and “out of the box” thinking.

• The team must include members with knowledge and experience in Lean Six 

Sigma.

• Team members with little prior knowledge of Lean Six Sigma receive valuable 

hands−on training by participating in the project.

145
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147Team member strengths and weaknesses

Code Strengths Weaknesses

CIU
Creative, imaginative, unorthodox. Can solve 

difficult problems.
Ignores details. Too preoccupied to 

communicate effectively.

EEC
Extrovert, enthusiastic, communicative. 

Explores opportunities, develops contacts.
Overly optimistic. Loses interest once initial 

enthusiasm has passed.

MCL
Mature, confident, good leader. Clarifies goals, 

promotes decision making, delegates well.
Can be seen as manipulative. Delegates 

personal work.

CDP
Challenging, dynamic, good under pressure. Has 
the drive and courage to overcome obstacles.

Can provoke others. Hurts people’s feelings.

SSD
Sober, strategic, discerning. Sees all options, 

judges accurately.
Lacks drive and ability to inspire others. 

Overly critical.

CMPD
Cooperative, mild, perceptive, diplomatic. 
Listens, builds consensus, averts conflict.

Indecisive in crunch situations, easily 
influenced.

DRCE
Disciplined, reliable, conservative, efficient. 

Turns ideas into practical action.
Can be inflexible, slow to respond to new 

possibilities.

PC
Painstaking, conscientious. Searches out errors 

and omissions, delivers on time.
Inclined to worry unduly. Reluctant to 

delegate. Can be a nit-picker.

SAD
Analytical, detail oriented, specialist. Provides 

knowledge and skills in rare supply.
Contributes only on a narrow front. Dwells on 

technicalities. Can’t see the “big picture.”

148Strengths and weaknesses (cont’d)

Optimal team composition has been researched from a personality point of view. The 

table shown is adapted from the book Team Roles at Work by Meredith Belbin and is 

just one of many examples available for understanding character traits. It can be 

helpful for team members to use an assessment tool to better understand their own and 

other members’ styles for communication, learning, confrontation, etc.

Successful teams need members with a variety of different strengths such as those 

described above. The strengths that a member brings to the team usually come with 

corresponding weaknesses. Team members make their greatest contributions when 

they are aware of their strengths and weaknesses. Team leaders are most successful 

when they are aware of the strengths and weaknesses of every team member.

The pairings of strengths and weaknesses shown above are based on statistical 

correlations. They do not apply to all individuals. However, most people can find 

themselves somewhere on each list.

Which strengths do you possess? Which weaknesses?
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149Resources

People who provide the team with things they need: 

Master Black Belt

Project champion

Process owner

Facilities

Finance

HR

IT
.
.
.

It’s recommended to designate these people during project chartering.

150Stakeholders

People with a vested interest in the project or its outcome 

who provide the team with their point of view on the project 

and its potential impacts

• May control critical resources

• May have concerns with proposed changes

• May have approval authority over proposed changes

• May own the in-scope process

• Team must engage stakeholders to get support for the 
project

149
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151Stakeholder analysis

It is in the best interest of the team to determine the current levels of stakeholder 

support or resistance, and the levels of support needed for the project to succeed. The 

more strongly a stakeholder is affected by the project and its outcome, and the greater 

the  influence he/she has on the project and its outcome, the stronger his/her support 

must be.

For each stakeholder, gather information (tactfully) and evaluate their level of support 

or resistance. Use this information to rate them with respect to the three criteria given 

in the next slide. 

A stakeholder analysis contains sensitive information and should 

remain confidential to the core team and champion.

152Example: Stakeholder analysis – criteria

Student Files → stakeholder analysis example - Criteria

1 2 3 4 5

Position with 

respect to the 

project

Strong support Support Indifference Resistance Strong resistance

Degree of 

Influence on the 

project or its 

outcome 

Very low Low Medium High Very high

Degree affected 

by the project or 

its outcome

Very low Low Medium High Very high
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153Stakeholder analysis – rating

Criteria →
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A 2 2 1 5 2 20

B 3 2 2 4 2 48

C 3 2 2 3 2 36

D 4 2 3 4 3 144

E 2 2 1 2 3 12

F 3 2 2 3 4 72

G 3 3 1 2 3 18

H 3 2 2 1 3 18

I 1 1 1 1 1 1

J 1 1 1 1 1 1
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Student Files → stakeholder analysis example – Stakeholders

154Stakeholder analysis – rating (cont’d)

A form of risk analysis is used to identify the stakeholders most in need of gentle 

persuasion. Your ratings should be entered into the white cells of the sheet shown 

above. The column gap between current needed is computed as 

(current position – needed position + 1). For example, if the current and needed scores 

are the same, the gap is 1 ⎯ the lowest (best) possible value. If the current score is 5 

and the needed score is 1, the gap is 5 ⎯ the largest (worst) possible value.

The total rating is the product of all columns, excluding the needed position column. 

The needed position is used only to compute the gap, the degree of increase in support 

required.  

 

A template for this analysis is in Student Files \ blank stakeholder analysis.

Focus your efforts to increase levels of support on the 

critical stakeholders ⎯ those with the highest total ratings.
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155
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Stakeholder analysis (cont’d)

Sort the 

stakeholders in 

decreasing order 

by total rating.

(You may have to 

unprotect the sheet to 

do so.)

Student Files → stakeholder analysis example - Pareto

156

P
Persuade them by creating a compelling case using data, 

examples, what competitors are doing, links to strategic goals…

A
Appeal to their ideals, values, virtues, visibility, personal 

ambition…

I
Involve them in the project ⎯ perhaps not on the core team, but 

get them in the loop as soon as possible, avoid surprises. 

N Negotiate with them. Is there a quid pro quo for their support?

T
Tell them to cooperate. (This only works if you have the authority. 

Even so, use as a last resort.) 

PAINT your way into stakeholder support
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158Effective Teams

For teams to be effective, the members must work collectively 

to achieve desired outcomes.

▪ This does not happen automatically

▪ Initially, the team is just people assigned to work together

▪ The ability to work together effectively develops as the team 

works together. They:

• get to know each other

• learn what they can expect from each other

• figure out how to divide labor and assign tasks

• determine how to coordinate the work of the team
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159Stages of Team Development

Team Development is the process of learning to work 

together effectively.

In 1965, Bruce Tuckman published a widely adopted model of this 

process*

He proposed a development sequence consisting of four stages:

• Forming

• Storming

• Norming

• Performing

* Tuckman, B. W. (1965). Developmental sequence in small groups. Psychological Bulletin, 63(6), 384–399. 

160Forming

The Forming Stage is a period of orientation and getting 

acquainted with each other and the project

▪ Usually, the team is meeting for the first time

▪ Team members are polite and positive, and possibly anxious or excited

▪ Uncertainty is high

▪ Members strive to get to know each other

▪ People are looking for leadership and authority

▪ Questions they may have:

• What does this team have to offer me?

• Will I fit in?

• What’s expected of me and others?

159
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161Storming

As the name indicates, the Storming Stage is marked by 

conflict, competition and polarization

▪ Energy is put into unproductive activities

▪ Members may disagree on team goals

▪ There is resistance to group influence and

  task requirements

▪ Subgroups can form around strong 

  personalities or areas of agreement

▪ Individual personalities emerge 

▪ Members may:

• question boundaries established in the Forming Stage

• think they are working harder than others on the team

• be frustrated by the different working styles of other team members

162Norming

The team becomes more cohesive and members have more 

in-group feeling as they enter the Norming Stage

▪ Members learn to cooperate and focus on team goals

▪ They appreciate each other’s strengths

▪ Consensus is reached on who the leader(s) are and the roles of 

individual members

▪ Members ask each other for help and provide constructive 

feedback

▪ The new-found harmony can be precarious, and the team can 

easily slide back into storming due to:

• changes in team membership

• disagreements re-emerging

• the uncertainty surrounding new tasks

161
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163Performing

In the Performing Stage, the team is well-functioning and 

mature

▪ Roles become flexible and functional

▪ Structural issues have been resolved

▪ Cooperation and consensus have been well established

▪ Problems and conflict are dealt with constructively

▪ Members are committed to the team’s mission

▪ Group energy is channeled into the task

164Adjourning

In 1977, Tuckman and Mary Ann Jensen updated the model, adding 

Adjourning, noting that “a perfect rhyme could not be found.”

The Adjourning Phase involves team dissolution

▪ Most of the team’s goals have been accomplished

▪ The focus is on wrapping of final tasks and documentation

▪ Some team members may move off the team, as the workload 

diminishes

▪ Working relationships that have developed come to an end

• The process can be stressful, especially when the dissolution is unplanned 

or unexpected by the team

• Some describe this stage as “mourning”

▪ Ceremonial recognition of the effort and 

  success of the team is recommended!
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165Team Development and Effectiveness

A team’s effectiveness is impacted by its level of development

As may be expected, effectiveness is lowest during the Storming Phase but in the long 

run, successful navigation of this phase is critical to the team’s success.

Leaders must help their team move out of Storming as constructively as possible.

166Moving through the Stages

Groups do not always move sequentially from 

Forming to Storming to Norming to Performing

A key role of team leaders is to help the team progress through Forming and 

Storming, and to and remain in Norming and Performing, as much as possible.

Performing

Forming

Storming

Norming
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167Stages of Team Development Activity:

Your instructor will break you into groups. You will have 15 minutes in your 

group to complete this activity, for each phase assigned.

As a group:

▪ Quickly review the guidelines for brainstorming.

▪ Brainstorm specific ideas on the question for your assigned phase(s)    

[~ 10 min.] Consider the question from the team leader perspective.

▪ List all ideas on a white board or flipchart during the brainstorming 

session.

▪ Discuss the brainstormed list and make ideas more specific so they are 

actionable, as needed. Indicate all “good” ideas. [~ 5 min.]

▪ Choose someone to report out. 

▪ Present all ideas deemed ‘good’ by your team.

168Stages of Team Development Activity (cont’d)

Assigned

Phase

As the team leader, what specific things can 

you do in team meetings, or with individual 

members between meetings, to help your team 

work together effectively in this phase and . . .

Forming . . . move from Forming to Storming?

Storming . . . move from Storming to Norming?

Norming . . . move from Norming to Performing?

Performing . . . remain in Performing?
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10  Project Scope and SIPOC

170Value stream scope

✓ Which customers?

✓ Which products?

✓ Which locations?

✓ Which materials?

✓ Which suppliers?

✓ . . .

Defines the project scope in terms of . . .

Value stream
All activities needed to provide a specified family of products or 

services to customers
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171Value stream scope (cont’d)

In scope: Customer A, product X

Out of scope:  all other products

Out of scope:  all other customers

172Example 1 — value stream scope

PVC

products

Locations

B & C

In scope

Out of scope

Composite

products

Location

A

Project to reduce cost and lead time of extrusion tool development
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173Workflow scope

✓ Which activities in the value stream are addressed by the project?

✓ Which operations?

✓ Which processes?

✓ Which areas?

✓ Which departments?

✓ . . . 

Defines the project scope in terms of . . .

174

CAD drawing from customer

Configuration

Machining

Polishing

Assembly

Tool released to ManufacturingTesting

Example 1 — workflow scope

Project to reduce cost and lead time of extrusion tool development

• Manufacturing is out of scope

• The project is not chartered to analyze and improve Manufacturing

• What is the relationship between Manufacturing and the workflow scope?
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175

The intersection of value stream and workflow scope 

Example 1 — project scope

PVC Products, Location A            

176Example 2 — value stream scope

All customers, all products

Project in Customer Service to address order changes
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177Example 2 — workflow scope

The project will address only 

the first three steps of the 

order change process

Order Changes

178Example 2 — project scope

• Order Processing of Changes is in scope

• Everything else is out of scope

• How will this affect the activities of the project team?
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All customers, all products

The intersection of value stream and workflow scope 
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179Exercise 10.1

Our company makes prototypes for various types of mounting brackets. These are 

classified as either standard or non-standard. A project has been launched to reduce 

the lead time for designing and building prototypes for non-standard brackets (see 

slide below for a typical example). 

What is the value stream scope for this project? 

What is the workflow scope for this project? 

Open Student Files → Case Studies → MBDP→ MBDP charter and update it by 

entering your description of the workflow scope; save your file for reference later in 

the course. 

180A non-standard mounting bracket

Ambihelical hexnut     Trichometric insert     

Rectabular base                      
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181Introduction to SIPOC

• The project charter frames the project in the business space 

• SIPOC is a separate document that frames the project in the process 

space:

     Suppliers → Inputs → Process → Outputs → Customers

• A SIPOC diagram is helpful at both the macro project level as 

described here, and at more detailed levels within a process.

• SIPOC also documents the data collection needed for the project

• The five elements of SIPOC are defined on the slide below. 

• The logical sequence for reading or creating a SIPOC:

                                    P → O → C → I → S 

182

5) Suppliers
Entities who provide necessary inputs to the workflow scope. 

Suppliers may be internal or external to the organization.

4) Inputs
Products, services, or information provided to the workflow 

scope by suppliers. 

1) Process

The workflow scope: the activities to be analyzed and 

improved. A high-level description including first step, main 

intermediate steps, and last step.

2) Outputs
Products, services, or information provided by the workflow 

scope to customers. 

3) Customers
Entities who receive outputs from the workflow scope. 

Customers may be internal or external to the organization. 

SIPOC definitions
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182



Copyright © 2025  ETI Group

183Graphical presentation of SIPOC

Organization

Process Internal 

Customers

External

Customers

Internal 

Suppliers

External

Suppliers

Inputs Outputs(workflow scope)

These may not be mutually exclusive

184

Project The title of your project

Suppliers

Inputs

and Xs

Process

and Xs

Outputs

and Ys

Customers

Blank SIPOC template

Internal External

Internal External

InputsInputs

OutputsOutputs

First step Main step Main step Main step Main step Last step
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185Blank SIPOC (cont’d)

The slide shows a graphical SIPOC template. All you have to do is edit the various 

boxes and text. You can also add or delete boxes or text. 

The digital version of this template, blank SIPOC, can be found in the Student Files 

folder.

The following three slides show the graphical SIPOCs for three case studies. 

Digital versions can be found in Student Files \ Case Studies within each case study’s 

folder:

• quotation process SIPOC #1             

• Ti casting SIPOC #1

• tool development SIPOC #1 

186

Project Reduce RFQ (Request for Quote) Turnaround Time

Suppliers

Inputs

and Xs

Process

and Xs

Outputs

and Ys

Customers

SIPOC example 1: Quotation Process

Receive RFQ Develop quote Review quote Send quote or request

a revised RFQ

Approved quoteRequest

to revise RFQ

External customer

Request for quote

Availability

Lead time

Pricing

External customer External suppliers
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187

Project Reduce Alpha Case on Titanium Castings

Suppliers

Inputs

and Xs

Process

and Xs

Outputs

and Ys

Customers

SIPOC example 2: Titanium Casting 

Slurry

make-up

Shell

build
Autoclave Casting

Shell

removal

Backend

processing
Heat

treat

Finished casting

Certificate of O2 compliance

External customers

Ceramic shell materials

Ti alloy

Chemical milling

Blueprints

Dim’l specs

Wax molding tools

O2 spec

Wax patterns

External customer External suppliersWax molding & assembly

188

Project Reduce Cost and Lead Time of Extrusion Tool Development

Suppliers

Inputs

and Xs

Process

and Xs

Outputs

and Ys

Customers

SIPOC example 3: Tool Development

External customers External suppliers

Raw materials for

machining and extrusion

CAD drawing

Dimensional specs

Weight spec

CAD
drawing

from
 customer

Configuration Machining Polishing Assembly

Tool and run
conditions
released
to Mfg

Testing

Sample extrusions
Approved tool

Run conditions

Manufacturing External customer
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189Exercise 10.2

Our company makes prototypes for various types of mounting brackets. The process 

of designing and building the prototypes is referred to as the Mounting Bracket 

Development Process (MBDP). A project has been launched to reduce the MBDP 

lead time for non-standard brackets (see below for an example). For background on 

the project and process, please refer to the following documents in Student Files \ 

Case Studies \ MBDP: 

MBDP charter

MBDP description for SIPOC

Use the information in these documents to create a SIPOC for this project using the 

template in Student Files \ blank SIPOC (use “Save As” to preserve the template). 

Remember that the SIPOC is used to show a high-level view of the process for 

establishing boundaries according to the project scope; avoid too much detail.

Do not fill in the X and Y variables shown on the blank SIPOC template (but do not 

delete their placeholders); we will discuss this topic later in the course.

Save your MBDP SIPOC file for reference later in the course.

190A non-standard mounting bracket

Ambihelical hexnut     Trichometric insert     

Rectabular base                      
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11  Observing the Current State

192Guidelines

• The purpose is to improve the process, not to audit work 

performance 

• Workflow observation periods should be scheduled in advance with 

appropriate supervisors and/or managers

• Workflow participants must be briefed on the project charter

• Participants must have adequate advance notice of observation 

periods

• Observations should be limited to the value stream and workflow 

scopes for the project
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193Guidelines (cont’d)

• Don’t “gang up” on a few participants or process steps⎯  

deploy team members effectively to get as many perspectives as 

possible

• Ask permission to take notes, photographs or videos ⎯ this 

helps team members get the information they need without 

having to repeat questions later

• Observations should begin with introductions and guided tours, 

in some cases  

• This should be done on all relevant shifts

• Subsequent “unguided” observations are often needed

194

• Interview workflow participants within the project scope

• Identify data variables and inspection points for inputs provided 

by internal suppliers

• Interview internal suppliers and customers of the workflow 

scope

• Identify data variables and inspection points for outputs provided 

to internal customers

• Identify NVA activities ⎯ these may be opportunities for 

improvement within the project scope

• Confirm or revise process map(s)

Typical elements of workflow observation
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195Team roles & responsibilities

Bob Carol Ted Alice Moe Larry Curly

Interview workflow participants ✓ ✓

Observe and record changes to process map ✓ ✓

Identify workflow data variables and 

inspection points
✓ ✓

Identify data variables and inspection points 

for workflow inputs
✓ ✓ 

Interview internal customers ✓  ✓

Identify data variables and inspection points 

for workflow outputs
✓ ✓ 

Focus on measurement systems ✓ ✓

196Asking questions

• The way you ask questions can affect the usefulness of the answers 

you get

• Closed questions can be answered with “yes” or “no” ⎯ if the 

person is reluctant to talk to you, closed questions will not get you 

anywhere

• Open questions start with words like what, why, when, where, who, 

which, how, etc.

• Open questions are much better for eliciting information, ideas, 

opinions, etc.
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197Asking questions (cont’d)

Open questions Closed questions

“How do you do that?”

“Why is it done this way?

“How do you think that would help?”

“When you say ___ , what do you mean?”

“What would be an example of that?”

“What are some possible causes of ___ ?”

“Why do you think that could be a cause?”

“Why do you think that happens?”

“Can you see from where you’re 
sitting?”

“Can you hear me in the back?”

“So, you agree with the schedule 
change?”

“Have we decided to meet on 
Fridays?”

“We covered that earlier, didn’t 
we?”

• Closed questions are useful for 

moving a conversation along

• Try to phrase them so that the 

answer you want is “yes”

198Correcting bad listening habits

Concentrate . . . . . . . on what is being said. 

Observe . . . . . . . . . . .facial expressions and body language. 

Respond . . . . . . . . . . with eyes, voice, gestures, and posture to 

                                     communicate  empathy and understanding.

 

Reflect . . . . . . . . . . . . information by paraphrasing. 

Elicit . . . . . . . . . . . . . . information by asking questions. 

Control . . . . . . . . . . . . the urge to interrupt, judge, or change the 

                                      subject.

Take . . . . . . . . . . . . . . advantage of lags between question and answer 

                                      to record observations or further questions.
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199Lean (and quality) checklist

❑ Are there opportunities for reducing batch size?

❑ Where is the greatest amount of work-in-process (WIP)?

❑ What are the most common do-overs, defects, errors?

❑ Is the physical layout causing excessive movement of people or 

material? 

❑ Is there unnecessary complexity?

❑ Where are the most time-consuming changeovers?

❑ Are there opportunities for mistake proofing?

❑ Are there places where inspections/tests can be performed 

sooner?

200Lean (and quality) checklist (cont’d)

❑ Are there serial activities that could be parallel?

❑ Are there redundant activities/inspections/tests that should be 

eliminated?

❑ Are there separate steps that should be combined into a single 

step?

❑ Are there single steps that should be split into separate steps?

❑ Are work instructions missing, outdated, or not visible?

❑ Are there problems with availability of equipment or material?

❑ . . .

199
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201Observation log

• Team members may see possible causes of problems and solutions as 

soon as they start observing and mapping the current state

• These observations should not be publicized until the appropriate point in 

the project roadmap

• These observations should be logged as they arise, preferably in Excel 

(facilitates categorization and prioritization)

• The possible causes will be reviewed in the Analyze phase, along with 

data analysis results, to determine root causes

• The possible solutions will be reviewed in the Improve phase to develop 

the future state

202Observation log (cont’d)

Team member Date Location Possible cause Possible solution

201
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12  Basic Process Mapping

204Basic process mapping

A basic process map shows the flow of individual tasks and decision 

points within the main steps of the process. 

Benefits of process mapping: 

• easy to learn

• produces useful documentation of the current state

• great team building activity

Keys to successful mapping: 

• focus on the appropriate level of activity 

• start with a high-level map before starting more detailed 

mapping

• leverage the SIPOC diagram: first, last, and main steps of the 

in-scope workflow will form the high-level process map
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205Basic process mapping (cont’d)

Often, we want to create detailed maps for some   

or all of the main steps given in the SIPOC

Operation 3Operation 2Operation 1 Operation 4 Operation 5 Operation 6 Operation 7

206

Step, task,

activity

Standard (basic) process mapping symbols

Queue

Start/End 

Step

Decision
Yes

No

Delay
A Connector for 

pagination 

breaks
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207Mapping as a team activity

Suspend your disbelief
Map the process the way it really is, not the way you 

think it should be.

Don’t make assumptions
If you don’t know what happens at a certain point, or 

can’t agree on what happens, put a question mark there. 

Then, go ask someone who does know.

Solicit feedback
Ask participants of the in scope workflow, and their 

internal customers, to review the map for accuracy and 

clarity. 

Document your work
Use mapping software to create an electronic version of 

the map.

208Writing good narrative

✓ Use active voice, not passive voice

 Order is entered

☺ Enter the order

✓ Use verb/object, not name of activity

 Order Entry

☺ Enter the order

✓ Use short sentences with familiar words

 Twilight’s last gleaming

☺ Dusk

✓ Use present tense

✓ Use logical, consistent layout

207
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209

Put

bread

in

toaster

Butter

toast

A high-level map for making toast

Get

butter

Get 

bread
Eat 

toast

Toast 

Bread

210Decision steps show what really happens

Put in

toaster

Butter

toast

Have

bread?

No

Plug in

toaster

Is it

moldy?

Yes

Yes

Yes

No

Plugged

in?

No

No

Working?

Get

butter

Yes

Have

butter?

Yes

Yes

No

No

Get 

bread

No toast 

for you

Eat 

toast

No toast 

for you

Eat 

dry?

Toast 
Bread
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211Best practice:  follow a qualitative timeline

Put in

toaster

Butter

toast

Have

bread?

No

Plug in toaster

Is it

moldy?
Yes

Yes

Yes

No

Working

?

No

No Plugged

in?

Get

butter

Yes

Have

butter?

Eat dry?

A

A
Yes

No

Yes

No

Get 

bread

No toast 

for you

Eat toast

No toast 

for you

Toast 

Bread

212Parallel activities

Common technique for reducing lead time:  convert serial to parallel

Current state lead time

Future state lead time

Put in

toaster

Butter

toast

Get

butter

Get

jam

Want

jam?

No

Yes Apply

jam

Get 

bread
Eat

Toast 

Bread

Get 

butter

Butter

toast

Get

jam

Want

jam?

No

Yes Apply

jam
Eat

Put in

toaster

Get 

bread

Toast 

Bread
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213Exercise 12.1

How would you modify the toast-making process to further reduce the lead time? 

Get 

butter

Butter

toast

Get

jam

Want

jam?

No

Yes Apply

jam
Eat

Put in

toaster

Get 

bread

Toast 

Bread

214Notes

213
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215Exercise 12.2

You are to create a process map based on the information given on the slide below. It 

will be beneficial to work in small groups. 

This is not your process. Someone else is describing their process to you. Do not 

make unwarranted assumptions! 

The instructor will provide guidance on options for creating the map either digitally 

or in hard copy.

Use a qualitative timeline and show each individual step, decision and path — our 

goal is a very detailed step-by-step map!

216Exercise 12.2 (cont’d)

There are two types of material, A and B. The material must be processed before it 

can be used. There are two steps in this process. For Process 1, the A and B materials 

must be processed in separate Type 1 machines. If two Type 1 machines are available, 

load the A material into one machine, the B material into the other, and run the two 

machines at the same time. If there is only one Type 1 machine available, run the two 

loads sequentially in that machine.

When Process 1 is completed, unload the material, and move on to Process 2. Process 

2 requires Type 2 machines. If two Type 2 machines are available, load the A material 

into one machine, the B material into another, and run the two machines at the same 

time. 

Unlike the Type 1 machines, the A and B material can be processed together in the 

same Type 2 machine. If there is only one Type 2 machine available, load both the A 

and B material into that machine for processing. This will take longer than processing 

the A and B materials in separate machines, but not as long as running two loads 

sequentially. 

When Process 2 is completed, unload the material, separate the A and B materials if 

necessary, then store them for subsequent use.

215
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13  Other Common Mapping Formats

218Other common process mapping formats

• Geographic (aka Spaghetti): tasks and decision points are 

overlaid on the “geographic” setting of the process.

• Cross-functional (aka Swimlane): tasks and decision points 

are placed in “lanes” of role responsibility.

• Topological: process activities are overlaid on a contextual 

map to shown connections or relationships.

• Value Stream Mapping (VSM): starts with a high-level map, 

combines visualization of the process steps with certain 

forms of data analysis (discussed in next module).
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219Spaghetti Diagram

• Most useful in the Analyze 

Phase

• Requires a floor plan or scale 

drawing

• Shows typical travel patterns

• Quantify distance travelled

• Also known as a geographic 

map

220Large scale spaghetti diagram
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221Spaghetti Diagram:  current state

Storage

Machining

Washing

Painting

Engineering

Inspection

8

7

6

5

42

1

3

• Should rearrange to minimize transport

• Good opportunity for a Kaizen event

222Spaghetti Diagram:  future state

Storage

Machining

WashingPainting

Engineering Inspection

87

6 5

42

1

3
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223Basic process map revisited

Input

Task 1

Task 2

Decision

Task 3

Task 4

Output

• Often it is important to document 
who is responsible for each activity 
and decision in a process

• How do we do this?

224Basic process map (cont’d)

Responsibility

Input

Task 1

Task 2

Decision

Task 3

Task 4

Output

We could make a table 
like the one shown 

here . . .

. . . but there is a 
better way!
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225Swimlane Diagram

Outside

sales

Inside

sales

Order

entry

Prod.

control

Also known as cross-functional map

Qualitative timeline

?

?

Start

End

Joint
activities

Do over

Handoff

226Swimlane Diagram (cont’d)

A swimlane diagram visually portrays the responsibilities for all process activities and 

decisions. In addition to showing responsibilities, swimlane diagrams are much better 

than simple maps for identifying opportunities for improvement. 

To create a swimlane diagram, first determine all the departments or functions 

involved in the activities and decisions you want to map. Enter swimlanes for 

departments or functions from top to bottom in the order they are first called for in the 

sequence of activities and decisions. Also, you should follow a qualitative timeline in 

placing activities and decisions on the map. 

With this method, the general flow of the activities and decisions will be from top left 

to bottom right on the map. This usually leads to the simplest and easiest to read 

depiction of the process.  

225
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227Emergency Department (ED) Topological map of patient flow

228ED patient flow (cont’d)

topological adj : concerned with relations between objects abstracted from exact quantitative 

measurement

A topological map is similar to a spaghetti diagram, but without the geography/scale. 

It shows connections, but not distances. It may or may not indicate a time or process 

sequence. The routing diagrams in the London Underground are famous examples of 

topological maps. 

The ED patient flow map shows the flow of patients, staff, and information or patient 

specimens in a hospital Emergency department.

Like geographic maps, topological maps are extremely effective for conveying the 

complexity of a process. Also, the free form nature of topological mapping lends 

itself to team brainstorming. 

On the other hand, we often need information on the sequence and location of 

process steps to move beyond the first impression of complexity. Topological 

mapping is typically not a very good format for displaying this kind of information.
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229ED patient flow in swimlane format
ED swimlane patient flow.igx
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230ED patient flow swimlane format (cont’d)

• Swimlane diagram of the same patient/information flow

• Shows the back and forth among different areas

• Gives a visual representation of the time sequence

• Clearly defines the possible patient pathways

• Solid arrows represent movement of the patient

• Dotted arrows represent movement of patient information, test 

results, X rays, blood samples, etc.

• Easier to follow

229
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231Exercise 13.1

Each team (same teams as for the SIPOC) will create a cross functional process map 

for the current state mounting bracket development process (MBDP). Review your 

MBDP SIPOC for overall boundaries and use the information in the following file:

Student Files \ Case Studies \ MBDP \ MBDP description for process map 

The instructor will provide guidance on options for creating the map either digitally or 

in hard copy.

Enter swimlanes (departments) as they occur in the narrative; it’s recommended to 

combine QE and ME in one lane. If using “sticky notes,” make the swimlanes at least 

two sticky notes wide.) 

Add a sticky note for each step or decision in the process, although Include all internal 

and external entities who play a role in the process.

You’ll need to add flow lines as you go; draw them lightly and wait until your map is 

finished to make them permanent. 

232A non-standard mounting bracket

Ambihelical hexnut     Trichometric insert     

Rectabular base                      

231

232



Copyright © 2025  ETI Group

233

Select
project

SIPOC

Observe
current
state

Map
current
state

Address
measurement

systems

Collect
data

Quantify
current
state

Y = f (X)
analysis

Determine
root

causes

Develop
future
state

Review
with

stakeholders

Pilot
future
state

Quantify
future
state

Develop
control

plan

Implement
future
state

Monitor
future
state

Close
out

project

Charter
project

Plan data
collection

14  Value Stream Mapping

234The nature of Value Stream Mapping

• Value stream mapping (VSM) combines several things:

✓Visualization of the current state 

✓Documentation of the current state 

✓Certain types of data collection and analysis

• VSM is an effective way to identify improvement 

opportunities

✓Especially in projects involving WIP, capacity, and lead time 
reduction

✓Also used to document the future state

233
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235From SIPOC to VSM

High-level map from SIPOC

Operation 3Operation 2Operation 1 Operation 4 Operation 5 Operation 6 Operation 7

Parts or
transactions

waiting

Operation 3Operation 2Operation 1 Operation 4

Operation 5 Operation 6 Operation 7

Q Q Q Q

Q QQ

236VSM, no data yet

What is the average lead time?

How much time is spent in each box or triangle?

How do we get this information?

Parts or
transactions

waiting

Operation 3Operation 2Operation 1 Operation 4

Operation 5 Operation 6 Operation 7

? ? ? ?

? ? ?

? ? ? ?

? ? ?
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237

Available Working 

Time (AWT)

• The time a process is available to conduct work

• AWT excludes time when work isn’t occurring such as time 

for breaks, meetings, lunch, preventative maintenance, 

estimates of unplanned downtime, change overs, etc.

Throughput (Tput)

• The average number of good parts or transactions completed 

over a period of time

• Typically measured as average over at least several days

• Throughput, lead time, and WIP are related through Little’s 

Law

Definitions

238

Lead time (LT)

• The total elapsed time to produce one defect free product or 

transaction

• The time difference between when a part or transaction 

enters and leaves a process

Customer 

Demand Rate 

(CDR)

• The number of parts or transactions that the customer 

desires over a period of time (usually a day, week, or month)

Definitions (cont’d)
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239

Takt time (TT)

• The pace at which an operation should complete products or 

transactions in order to meet customer demand during the 

Available Working Time.

• Available working time during a period divided by the 

number of products or transactions required during that same 

period

Cycle time (CT)

• The fastest repeatable time between part or transaction 

completions using the current processes and resources

• Shows how a process is capable of performing

• Combines with AWT to determine capacity

Definitions (cont’d)

240

Process Cycle 

Efficiency (PCE)

• The percentage of time that WIP is being transformed by VA 

activities.  In other words, the percentage of lead time that is 

value added.

Work In Progress 

(WIP)

• Includes items waiting to be worked on and items actively 

being worked on. WIP includes all of the inventory in the 

production system.

Definitions (cont’d)
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241Example 1

Available Working Time per day  =  480 min – 90 min breaks, lunch, meetings

                                                    = 390 min

       Avg. daily Customer Demand Rate  =  32 units

  

390 minutes
  32 units

Takt time  = =  12.2 mins

During a study of this process, parts were completed at the following 

times:

9:00, 9:09, 9:17, 9:28, 9:37, 9:46, 9:58, 10:07, 10:16, 10:24, 10:33, 10:42

Based on this, the elapsed time in minutes between completed units was:

9, 8, 11, 9, 9, 12, 9, 9, 8, 9, 9

Cycle Time = 9 minutes (the fastest repeatable value)

  

242Example 1 (cont’d)

Manufacturing

CustomersSuppliers

>32 units
daily is possible

Material
and/or

components
for 32 units

daily

Takt time = 12.2
Cycle time = 9.0 

241

242



Copyright © 2025  ETI Group

243Getting used to takt time and cycle time

• Units of takt and cycle time:  time divided by quantity

➢ Shorter cycle time → more output

➢ Longer cycle time → less output

• Cycle time longer than takt time

➢ Cannot meet customer demand with current 
processes and resources

• Cycle time shorter than takt time

➢ Can meet customer demand with current 
processes and resources, but may need to 
eliminate process variation

244

• Takt time longer than cycle time

• Downstream operations constrained to cycle time of 

upstream bottleneck

• Upstream operations pace themselves to cycle time of 

downstream bottleneck (pull system)

We may not want to operate as fast as possible

243
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245Exercise 14.1

Using the information provided in Example 1, consider the scenario where the 

customer wants to increase their purchases from 32 to 42 units per day.

a) What is the new takt time?

b) What is the cycle time and is the new takt time faster or slower than the cycle 

time?

c) Can you accommodate this demand increase?

d) What problems might need to be solved? 

e) Why should cycle time measurements not typically be taken from process 

output data in an ERP system?

246How do we get lead time data?

Method Drawbacks

Download accurate, time stamped 

records from database

• The best scenario, if such data exists

• Make sure WIP time is accounted for properly

Shadow parts or transactions

• Tedious

• Logistically difficult

• Time consuming for team members

Tag documentation

• Anything identified as “special” is likely to be 

expedited

• Data will not represent reality

Enter “file cabinet data” into Excel

• Tedious and time consuming 

• Likelihood of data entry errors

• May not exist

Little’s Law • Allows calculation of LT from WIP and T’put

245
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247Little’s law

Lead Time =   WIP  / Throughput

• WIP is easy to count during process observation

• If WIP varies, count multiple times and use average or min/max to 

show range in lead time

• Throughput is the quantity completed during an observation 

period.  Period should be at least several days. 

• Lead time  = amount of time that passes between when a piece 

enters and leaves a process or processes

• These values can be calculated for individual processes or for an 

entire production process chain

248

• Suppose in the system shown above, each operation has a throughput of 6 pieces per 

hour, so the entire production process is also making 6 pieces per hour

• We can use Little’s Law to calculate the overall lead time for the process, for 

individual processes, or for subsets of processes

VSM with WIP data

Average WIP for each box and triangle during an observation period

Parts or
transactions

waiting

Operation 3Operation 2Operation 1 Operation 4

Operation 5 Operation 6 Operation 7

5.0 7.5 15.0 10.0

22.5 22.5 5.0

1.0 1.5 3.0 2.0

4.5 4.5 1.0
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249Applying Little’s Law

Avg. WIP

Queue 1 5.0

Operation 1 1.0

Queue 2 7.5

Operation 2 1.5

Queue 3 15.0

Operation 3 3.0

Queue 4 10.0

Operation 4 2.0

Queue 5 22.5

Operation 5 4.5

Queue 6 22.5

Operation 6 4.5

Queue 7 5.0

Operation 7 1.0

Total 105.0

The previously described process was studied and the 

average WIP counts are shown here.  They are 

measured as follows:

• Queue WIP is the average pieces waiting to be 

processed.  For example, Queue 1 WIP is the typical 

amount of work waiting to be processed by 

Operation 1.

• Operation WIP is the average pieces actively being 

processed.  For example, Operation 1 is typically 

processing one piece.

• The Total WIP in the process is the sum of all of the 

Queue and Operation WIPs

250Applying Little’s Law

Avg. WIP

Queue 1 5.0

Operation 1 1.0

Queue 2 7.5

Operation 2 1.5

Queue 3 15.0

Operation 3 3.0

Queue 4 10.0

Operation 4 2.0

Queue 5 22.5

Operation 5 4.5

Queue 6 22.5

Operation 6 4.5

Queue 7 5.0

Operation 7 1.0

Total 105.0

We can apply Little’s Law to the entire process, an 

individual process, or a subset of processes. 

Remember:

Since each operation, and therefore the entire process 

sequence, averages 6 pieces per hour, Little’s Law lets 

us calculate lead times as follows:

• For the entire process:

Lead Time = 105 pieces / 6 pieces per hour

      = 17.5 hours or 1050 minutes

• For Queue 1 and Operation 1:

Lead Time = 6 pieces / 6 pieces per hour

      = 1 hour or 60 minutes

Lead Time =  WIP  / Throughput
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251VSM with waiting and process times

30m15m50m 10m 75m 150m 100m 20m

45m225m 45m
225m

10m50m

Operation 3Operation 2Operation 1 Operation 4

Operation 5 Operation 6 Operation 7

Lead time = 1050 minutes or 17.5 hours

Waiting time = Sum of time in queue

                      = 50 + 75 + 150 + 100 + 225 + 225 + 50 + 10 = 875 minutes

Process time = Sum of time the pieces are being worked on

                     = 10 + 15 + 30 + 20 + 45 + 45 + 10 = 175 minutes 

Process Cycle Efficiency = The percent of lead time that a part is being worked on

      = (175 / 1050)*100 = 16.7%

252Exercise 14.2

a) A manufacturing process completes an average of 45 defect-free parts each day.  

The average WIP is 15 parts. Calculate the average lead time in hours (use a 24-

hour day).

c) Should externally supplied inputs used at the first step of a process (aka “raw” 

materials) be counted as WIP?

b) A manufacturing operation runs 365 days a year. They produce about 416 defect-

free units of a particular product per year. The average WIP for this product is 40. 

Calculate the average lead time in days.
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253Exercise 14.3

Open Student Files → Case Studies → MBDP → MBDP VSM. Average WIP and 

estimates of process times (in hours and days) are given for the six main steps in this 

process. The quantity completed in 260 work days is also given. Use Excel formulas 

to calculate the following:

a) Throughput, total process time in days, total WIP. 

b) PO-PD (lead time) for the six main steps individually and the overall process. 

c) Where are the bottlenecks? Do these steps have anything in common? 

d) What would the overall lead time be if all transactions were handled immediately 

upon receipt at each step (i.e., if there were no wait time)?

e) Save your work.

254Exercise 14.4

Sort &
 collate
 record 

0.9h

Review &
code

record 

2.5h

Inspect

 coding 

1h

Identify

 billables 

0.6h

Inspect

 billables 

0.8h

Assign 
charges

0.7h

Create

invoice

0.9h

Inspect 
charges

0.3h

Print draft 
bill

1.2h

Inspect

invoice

0.2h

VA

process

time

Billing process VSM with process times and WIP

$2.8M $1.1M $3.3M

Print 
billables

1.1h

$0.7M $0.9M WIP

Q Q Q Q

Q Q

Legend

• From this data we can calculate lead time, VA process time, 
NVA process time, and total NVA time.

• To get the total wait time, we need the following calculation:

Wait time = Total NVA time – NVA process time

NVA

process

time

Wait

time
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255Exercise 14.4 (cont’d)

The average annual revenue of the company whose billing process is shown in the 

previous slide is $300M. Its average dollars in accounts receivable (AR) is $60M. 

Consider the following translations:

• AR is a process

• Dollars in AR is the WIP quantity

• Annual revenue is the quantity completed in 365 days 

• Average days in AR is the average lead time of this process

Use Little’s law to calculate the average days in AR.

The result will explain why the Accounts Receivable (billing) process was targeted 

for improvement.

256Exercise 14.4 (cont’d)

Open Data Sets → billing process VSM. Use Excel formulas to calculate the following 

in units of $M (dollars in millions) and days (use a 24-hour day):

a) Throughput, total VA process time, and total WIP.

b) Lead time for the five main process steps, and overall. 

c) Total NVA Lead Time, NVA Process Time and Process Cycle Efficiency. 

d) Wait time and Wait time as a percentage of total NVA time.

e) Where does WIP indicate a capacity constraint?  If each process had the same 

resources and AWT, where would the constraint be? Why might there be little 

WIP in front of a constraint?
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15  X and Y Variables

258Topics

• X variables

• Cause & Effect (aka Fishbone) Diagram

• Prioritizing X variables

• Y variables

• Operational definitions for data variables

• “Big Y” and “little y”
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259X variables

Suppliers Inputs

Workflow scope

Outputs Customers

X variables

Characteristics of inputs 

to the in−scope workflow

Conditions within the 

in−scope workflow

• Part/transaction level data

• Who, what, where, when, how 

(WWWWH)

• Possible causes of variation in 

the Y variables

X variables

260Cause & Effect (aka Fishbone) Diagram

The Fishbone Diagram is: 

• used to identify all potential causes (X’s or inputs) of the effect (output or 

problem of interest), usually the primary metric.

• part of identifying process inputs during the Measure Phase

• most often associated with root cause analysis

• also known as Cause-and-Effect Diagram and Ishikawa Diagram

• The greater the number of X variables identified, the greater the chance of 

solving the problem. (Why?)
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261Fishbone Diagram (cont.)

The Fishbone Diagram is created with the project team.

• It focuses the team on the particular effect, shown in the “head of the fish”

• All ideas for potential causes (critical x’s) are collected using brainstorming

• Categories on the main “bones” help trigger ideas

• Standard categories are Man, Machine, Materials, Methods, Measurement and 

Environment (“5 M’s and an E” or the “6 M’s” if  “Mother Nature” is subbed for “E”)

• The team can choose to use different categories

• Standard categories (with minor modifications) are recommended for your first uses

problem with 
Primary 

metric (Y)

ManMachineMaterials

MethodsMeasurementEnvironment

x

x
x

x

x

x

x

x

x
x

x

x

x

x

x
x

x

x

x

x

x

x

x

x

262Steps for Creating a Fishbone Diagram

The Fishbone Diagram must be visible to the entire team during the 

brainstorming (creation) session.

1. Put output of interest (usually primary metric) in the “head of the fish.”

2. Choose categories for “bones”

▪ Standard Categories: Man, Machine, Materials, Methods, Measurement, Environment

▪ The team can choose to use other categories

3. Brainstorm all possible inputs (x’s) that could cause the problem seen in the 

output (primary metric—Y)

▪ Rules for Brainstorming: Accept all stated ideas and add to diagram; No ideas are 

evaluated or rejected during the brainstorming session

4. Break broad categorical x’s into more useful, more measurable features

▪ Measurable features can be verified as causes of performance issues in the primary 

metric during the Analyze Phase

▪ We can act upon them to improve the process

▪ They need to be identified early in the project

▪ Example: Work instructions not followed—out of date; lack of training

5. Highlight those x’s deemed most important by the team
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263Fishbone Diagram Example (non-standard categories)
fishbone example.igx

Mistakes

and delays

Equipment

Material

Not available when needed

Can't hold tolerances

Not available  when needed

Equipment not reliable

Equipment outdated

OrderingDelivery

Late

Wrong material

Wrong quantity

Late

Wrong material

Wrong quantity

Out of spec

Work instructions

Not followed

Out of

 date

Outdated

Too much 

unplanned 

downtime

Hard to use

OutdatedLack of training

Lack of

 training

Work area

Too much travel

back and forth

Poor layout

264Exercise 15.1

A project has been launched to improve the mounting bracket development process 

(MBDP) in a company that makes mounting brackets. Background on the project and 

process may be found in the following files in Student Files \ Case Studies \ MBDP:

MBDP charter

MBDP description for process map

Based on the information in these documents and the process map you created earlier, 

create a Fishbone Diagram for this project. 

Save your work and keep your Fishbone diagram and the other two MBDP files open 

for reference in upcoming exercises.
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265

• X’s are identifiable characteristics of process inputs 

• Who/what/where/when/how within the workflow scope

• They are shown on your Fishbone diagram

• It may not be feasible to collect data on all X variables of 

interest

• You may need to prioritize them

Prioritizing X variables for data collection

266Instructions for prioritizing X variables

1. Open Student Files → blank C&E matrix - Pareto method 

2. In the Metrics sheet, change Metrics to Y variables 

3. List your Y variables and relative weights

4. In the Items to be ranked sheet, change Items to be ranked to X variables

5. List the X variables you wish to rank

6. Rate each X variable for degree of correlation with each Y variable:  none (blank), 

low (L), medium (M), high (H). The numerical codings for H, M, and L are 

specified in the sheet Calculations.

7. Copy your X variable list, paste it into the Pareto sheet under Paste items to be 

ranked

8. Copy your overall rankings, Paste Special → Values into the Pareto sheet under 

Paste overall rankings 

9. Select the range B3:C27, select Data → Sort, uncheck My data has headers, sort 

by column C, largest to smallest 
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267Student Files → prioritizing X variables - example

Metrics

sheet

• You can also include one or more feasibility metrics on this list

• Or use blank C&E matrix - impact & feasibility

268Example (cont’d)

Items

to be

ranked 

sheet
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269Example (cont’d)

Pareto sheet

270Example (cont’d)

Pareto sheet
Sort descending — 

high to low
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271Exercise 15.2

Open Student Files → Case Studies → MBDP → MBDP X variable prioritizer. 

Y variables and X variables are given. Use your knowledge and experience to rate the 

X variables for correlation with the Y variables and produce the Pareto Chart. 

272Prioritizing X’s using Multi-voting

Another method for prioritizing X’s for data collection is to use multi-voting:

1. Count the number of X’s

2. Divide the total number of X’s by 3. Each team member gets that many 

“votes”

3. Each team member decides how they will apply their votes, giving one 

vote to each X they think is a most likely main contributor to the problem

▪ Give a marker to each team member and have them write their votes on 

the fishbone diagram or list

▪ Use a secret ballot if there are concerns of undo influence among team 

members

4. Focus data collection on those X’s that rise to the top
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273Y variables

Suppliers Inputs

Workflow scope

Outputs CustomersY variables

• Part/transaction level data

• Characteristics of process 

outputs

• Project metrics are calculated 

from these

• Examples:  time, quality, cost

• Also: DNH* variables

*Do No Harm ― not trying to improve them, just don’t want to make them worse.
These may be secondary project metrics.

274Y variables

• A data variable is a measurable characteristic defined for individual 

parts or transactions (What does “variable” mean?)

• Y variables are measurable characteristics of outputs from the 

workflow scope

• They are the data variables from which the statistical project metrics, 

such as average or percent defective, are calculated

• Examples:  lead time, pass or fail, quantitative measures of poor 

quality (including cost)

• The Y variables are the reason we are doing the project (Why?)
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275Operational definition for a Y variable

▪ How, and from what basic quantities, will Y be calculated? 

• If Y is a Lead Time, what are the exact start and stop points?

o If using start/stop dates to calculate Lead Time, consider how to account 

for same-day times, e.g., (stop date – start date) + 1.

• If Y is unplanned downtime, how will you record your data, e.g., 

hourly/daily/weekly summaries, event log, etc.?

▪ What measurement system will be used?

▪ If Y is pass/fail, what are the possible defects? 

▪ If you are going to count defects per opportunity (DPMO), how are the 

opportunities defined?

▪ If there is existing data, can you use it? What minor modifications to your 

operational definition(s) may be needed? (Data readily available will jump start 

your project. Use it whenever possible, even if minor adjustments to the project 

scope are needed.)

276Notes
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277Case study example: Tool Development

❑ How, and from what basic quantities, will Y be calculated?
A representative sample of in-scope tools will be chosen.
Y = count of tool rework occurrences / total number of tools

❑ If Y is a lead time, what are the exact start and stop points?
NA to this metric but for learning purposes: Average order-to-sell time in 
days is another Y metric that will be calculated using the same sample 
described in the first question above. Start point = date of Order 
Receipt; End point = Shipment date to customer. Will calculate from ERP 
records, using Y = (Ship Date – Order Date) + 1.

❑ If Y is unplanned downtime, how will you record your data, e.g., 

hourly/daily/weekly summaries, event log, etc.?
NA to this project but for learning purposes: if we needed this data, we 
would access the Facilities department’s maintenance/time logs kept for 
each piece of equipment.

❑ What measurement system will be used?
Can pull number of reworks from the job order record in the ERP system, 
using the record of routings between Tool Testers and Machining Group. 
Alternately, Tool Testers could maintain a spreadsheet of # of reworks per 
tool PN, by job order and dates.

Name of Y variable: Average number of reworks per tool

278Case study example: Tool Development (cont’d)

❑ If Y is pass/fail, what are the possible defects? 
NA to this metric but for learning purposes: cosmetic quality is a “Do No 
Harm” metric for this project. The inspection procedure would be referenced 
for the defects associated with the inspection criteria.

❑ If you are going to count defects per opportunity (DPMO), how are the 

opportunities defined?
NA to this metric but for learning purposes: the inspection criteria would be 
used to define the defect opportunities, as above.

❑ If there is existing data, can you use it? What minor modifications to your 

operational definition(s) may be needed? 
There is existing data for reworks per tool available in the ERP system. We 
will work with IT to create a report for extracting this data in a useable 
format. No modifications to the operational definition are needed.

Name of Y variable: Average number of reworks per tool
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279Exercise 15.3

Working with one or more others:

1. Give an operational definition for PO-PD in the Mounting Bracket Development 

Process (MBDP) project. 

Refer to the file MBDP charter in Student Files \ Case Studies \ MBDP. 

Use the checklist on the next slide to address the relevant questions. 

2. (Optional) Give an operational definition for one of the Y variables for your 

project. Use the checklist on the next slide to address the relevant questions.

280Exercise 15.3 (cont’d)

Name of Y variable: __________________________________

❑ How, and from what basic quantities, will Y be calculated? (Write out the formula.)

• If Y is a Lead Time, what are the exact start and stop points?

o If using start/stop dates to calculate Lead Time, consider how to account for same-

day times, e.g., (stop date – start date) + 1.

• If Y is unplanned downtime, how will you record your data, e.g., hourly/daily/weekly 

summaries, event log, etc.?

❑ What measurement system will be used?

❑ If Y is pass/fail, what are the possible defects? 

❑ If you are going to count defects per opportunity (DPMO), how are the opportunities defined?

❑ If there is existing data, can you use it? What minor modifications to your operational 

definition(s) may be needed? 

❑ Additional thoughts?
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281“Big Y” and “little y”

Sort & collate

Code

Identify billables 

Assign charges 

Prepare bill 

A billing process:
by main steps

Regional Sales 

Technical Sales Coordinator 

Business Unit Sales 

Business Unit Engineering 

Service 

Finance 

Legal 

A quotation process:
by functional roles

The MBDP:
by main steps and 

functional roles

PO:  Sales/PE

Design Spec:  PE

Design Spec:  ME/QE

Drawing:  Drafting/PE

Drawing:  ME/QE

Proto

Often, we collect data based on a high-level breakdown

of the in-scope workflow

282“Big Y” and “little y” (cont’d)

In-scope workflow

“Little y” variables

Output CustomersY  = y1 + y2 + y3

y3y1 y2

• Each “little y” is specific to one element 

in the breakdown

• Common types of “little y” data:

✓ WIP

✓ process time

✓ lead time

✓ Number of defects

✓ Cost of waste

• “Big Y” is the sum of “little y” over all 

elements

• “Big Y” is what the customers care about
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283Pitfall:  setting goals for each “little y”

• Suppose Y = y1 + y2 + y3

• Suppose we have a 50% reduction goal for Y

• One way to achieve this is to reduce each of y1, y2, and 

y3 by 50% . . .

• . . . but we should not set separate 50% reduction goals 

for y1, y2, and y3

• Why?

284SIPOC with X & Y variables

• The SIPOC diagram is an excellent way to summarize 

the X and Y variables to be studied

• Prioritized X variables are listed with the associated 

Suppliers, Inputs and Process steps 

• Finalized Y variables are listed for the associated 

Outputs delivered to Customers

• The case study examples of SIPOC diagrams with X and 

Y variables provided in the following slides can be found 

in the applicable folder of Student Files \ Case Studies, 

labeled by case as SIPOC #2 with Xs and Ys
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285SIPOC with X’s & Y’s example 1: Quotation Process

286SIPOC with X’s & Y’s example 2: Titanium Casting 
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287SIPOC with X’s & Y’s example 3: Tool Development

288Notes
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16  Data Formatting

290

A B C D

1

2

3

4

5

6

7

8

9

The spreadsheet:  a truly marvelous invention

• Automates arithmetic

• Dynamic cell formulas

• Addins expand functionality

• No rules for formatting data

• No rules for analyzing data

“They’re my numbers.
I can do whatever I

want with them.”
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291Standard data matrix format

Each row

• A unique record (database 

terminology)

• An observation (Statistical 

terminology)

• A part, sample, lot, batch, 

transaction, time period, 

person, . . . 

• The number of rows is the 

sample size

Each column

• A unique field (database terminology)

• A unique variable (statistical terminology)

292Data matrix example 1

Data variables

Each row represents one 
serial number of a 

particular part number

S/N Length Diameter

501 599.54 48.92

502 598.31 47.89

503 598.37 48.16

504 599.06 48.06

505 598.14 47.78

506 598.93 48.21

507 599.28 47.44

508 599.66 48.22

509 599.60 49.09

510 597.52 47.38

511 598.39 48.78

512 599.31 48.48

513 600.20 48.89

514 599.63 48.23

291

292



Copyright © 2025  ETI Group

293

Quote Num AcctMgr BU Initial RFQ Month Cycles Finance reviews TAT

3250024 8 3 12-Jun-03 2003.06 1 1 2

3250029 2 3 04-Jul-03 2003.07 1 0 2

3250031 5 3 29-Aug-03 2003.08 1 1 1

3250032 4 3 16-Jun-03 2003.06 1 0 1

3250033 3 3 06-Jun-03 2003.06 1 1 2

3250034 20 3 30-Jun-03 2003.06 1 1 4

3250035 3 3 09-Jun-03 2003.06 1 1 1

3250036 4 3 16-Jun-03 2003.06 1 0 1

3250037 4 3 16-Jun-03 2003.06 1 0 2

3250038 4 3 26-Jun-03 2003.06 1 0 1

3250039 8 3 30-Jun-03 2003.06 1 1 9

3250040 4 3 26-Jun-03 2003.06 1 0 1

3250041 4 3 26-Jun-03 2003.06 1 0 1

3250042 4 3 01-Jul-03 2003.07 1 0 1

3250043 11 3 07-Jul-03 2003.07 1 0 1

3250045 20 3 12-Aug-03 2003.08 1 1 2

3250046 3 3 14-Jul-03 2003.07 1 0 11

3250047 2 3 14-Jul-03 2003.07 1 0 3

Data matrix example 2

Each row represents one quote

Data variables

294

WORK ORDER PARENT P/N COMP P/N AREA CATEGORY SCRAP QTY

35709 672-5668-00 162-4219-66 HDSI TRAINING ISSUE 16

88198 174-B983-00 178-2758-66 WC RECUT 40

88198 174-B983-00 178-2764-66 WC RECUT 82

96772 180-9272-66 M83519/2-3 CH TRAINING ISSUE 5

97130 672-6163-66 174-5274-00 HDSI SPLICES 22

97166 180-8208-66 178-2564-66 WC FAILED TEST 16

97166 180-8208-66 388-5021-66 NC BAD MOLDING 1

97166 180-8208-66 388-5021-66 NC FAILED TEST 1

97327 H542E371-01 162-4356-66 CH FAILED TEST 1

97327 H542E371-01 162-4718-66 CH FAILED TEST 2

97327 H542E371-01 47180GY-25 CH FAILED TEST 1

97544 180-0829-66 178-1565-66 PR FAILED TEST 5

97555 196-3501-66 47439-001LF WC MACHINE/TOOLING 200

97563 170-0135-66 178-0103-66 WC MACHINE/TOOLING 12

97563 170-0135-66 178-0104-66 WC MACHINE/TOOLING 7

97564 170-0148-66 131-0965-00 WC MACHINE/TOOLING 300

97570 180-8728-66 132-6158-66 CH TRAINING ISSUE 10

97582 010-0735-00 131-7989-00 HDSI VENDOR MATL 32

97582 010-0735-00 174-5274-00 HDSI TRAINING ISSUE 25

97582 010-0735-00 174-5274-00 HDSI VENDOR MATL 17

Data matrix example 3

Each row represents one work order, one component part number, 
one process area, one defect category 

Data variables

293
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295Data matrix example 4

Each row

represents

one week

Data variables

Week Inspected Defective

1 400 2

2 169 1

3 208 1

4 510 3

5 132 1

6 500 3

7 393 2

8 625 3

9 167 1

10 395 3

11 200 1

12 122 1

13 178 2

14 527 4

15 132 1

16 171 2

17 610 5

18 446 5

19 428 5

20 207 3

21 708 15

22 565 13

23 149 3

296Exercise 16.1 (a)

Average monthly WIP

Is this a valid data matrix? 

If not, give the column headings for the 
standard data matrix format. 

2001 2002 2003

Jan 19 20 20

Feb 27 22 15

Mar 20 19 27

Apr 16 16 25

May 18 22 17

Jun 25 19 19

Jul 22 25 28

Aug 24 22

Sep 17 18

Oct 25 20

Nov 15 16

Dec 17 17
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297Exercise 16.1 (b)

Patients admitted to an emergency department

Jan '01 Feb '01 Mar '01 Apr '01 May '01 June '01 July '01 Aug '01 Sept '01 Oct '01 Nov '01 Dec '01

3114 2778 3026 2869 3009 3119 3000 3069 2841 2962 2707 2815

Jan '02 Feb '02 Mar '02 Apr '02 May '02 June '02 July '02 Aug '02 Sept. '02 Oct. '02

3015 2991 2769 2961 2991 3055 3328 3337 3209 2921

Is this a valid data matrix? 

If not, give the column headings for the standard data matrix 
format. 

298

Test Date & Time Model Number Serial Number Test Station Result Failure Reason

3/1/2006 6:02 690 6099948 3 Passed

3/1/2006 6:03 692 6087149 1 Passed

3/1/2006 6:05 690 6099949 3 Failed DoBatteryAccuracyTest

3/1/2006 6:06 690 6099949 3 Passed

3/1/2006 6:12 692 6087150 1 Passed

3/1/2006 6:12 690 6099932 3 Passed

3/1/2006 6:13 692 6099622 2 Passed

3/1/2006 6:15 690 6099933 3 Failed Operating current outside of allowed range

3/1/2006 6:17 692 6099623 2 Passed

Pass/fail & failure reasons

Exercise 16.1 (c)

...

Is this a valid data matrix? 

If not, give the column headings for the standard data matrix 
format. 
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299Exercise 16.1 (d)

De-ionized (DI) water used in machining and cutting operations

 is sampled every 20 minutes

.

.

.

Is this a valid data matrix? 

If not, give the column headings for the standard data matrix 
format. 

. . .

Resist ResistResist Resist

300Notes
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301Exercise 16.2

Wafer 1

Wafer 3 Wafer 4

Wafer 2

C

ED

BA

C

ED

BA

C

ED

BA

C

ED

BA

Y

X

302Exercise 16.2 (cont’d)

Computer chips are cut from silicon wafers. We selected chips cut from the same 

5 locations on 4 wafers. We measured the X and Y dimensions of each chip. (It 

may help to sketch the data matrix.)

(a) Give the column headings for the standard data matrix format. 

(b) How many rows are there? 

(c) What does each row represent?
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303Example formats for manual data collection

DATE JOB NO. TASK OPER T0TAL HOURS VA HOURS

Format: 10/28/04 31, 32, etc. See code sheet AG, ET, GR, etc. X.XX X.XX

Business 

Unit

Quote 

Number Rev

First           

quote?

FY      

Requested

Date         

Requested

Service 

Approval

Finance 

Approval Date Sent Region

Account              

Manager

1, 2, etc. XXXXXXX AA, AB, etc. Yes/No 06, 07, etc. Format: 6/2/06 Yes/No Yes/No Format: 6/3/06 See code sheet AG, ET, GR, etc.

304

These examples are set up to match the desired data matrix format. This makes data 

entry easier.

The most important thing about a data collection form is to eliminate as much 

variation in data entry as possible. Specify desired date and time formats. Use codes 

instead of free form text. Use uppercase initials instead of names. Specify desired 

numeric formats precisely.

Try to fit all the variables for which you want data collected on one page. Try to make 

the spaces big enough to write in. These things may work against each other. If there 

are too many columns to fit into portrait mode, use landscape mode instead. Do not 

include variables that can be calculated from other variables after the data are entered 

into a spreadsheet.

Best Practice: Have at least one person test the form or spreadsheet by collecting data 

for a short period of time, to make sure it works well before deploying it more broadly 

for data collection.

Data collection forms (cont’d)
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17  Types of Data

306

Also known as Examples

Quantitative

measurement

✓Continuous

✓Variable

✓Parameter

Physical/chemical/electrical/optical 
properties, dimensions, distance, time, 

counts, . . .

Categorical

classification

✓Qualitative

✓Discrete

✓Attribute

Y variables
 Pass/fail, type of defect, quality rating, . . .

X variables
Batch, lot, part number, supplier, customer, 

machine, operator, method, time period, 
location, condition, . . .  

Summary of data types
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307

...

Dimensions of cylindrical castings

S/N Length Diameter

501 599.54 48.92

502 598.31 47.89

503 598.37 48.16

504 599.06 48.06

505 598.14 47.78

506 598.93 48.21

507 599.28 47.44

508 599.66 48.22

509 599.60 49.09

510 597.52 47.38

511 598.39 48.78

512 599.31 48.48

513 600.20 48.89

514 599.63 48.23

515 601.10 50.14

516 599.90 49.20

517 599.37 49.17

Quantitative Y variables

• True values may be infinitesimally close 
to each other

• Data resolution is determined by the 
measurement system

• Is S/N a quantitative measurement?

308

Resistivity of DI water

Quantitative Y variables

• De-ionized water used in machining and 
cutting operations

• Electrical resistivity is the opposite of 
conductivity

• Higher resistivity means lower 
conductivity, which is good

• Data resolution is determined by the 
measurement system

• Day of week is a categorical 
classification

• Hour of day:  quantitative or 
categorical?
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309

X dev Y dev

8 -6

-7 -2

-9 -4

-10 -5

-21 -7

-20 6

-13 -3

-16 9

-20 -1

-14 -4

-14 -6

-16 3

-14 -6

-23 -4

-11 -10

-19 7

-14 3

-10 -6

Alignment of assembled components

...

Quantitative Y variables

• Deviations from target in X and Y 
directions

• Reported to the nearest thousandth of 
an inch 

• Decimal point dropped

X dev

Y dev

310Quantitative Y variables

ED patient visits

Jan '01 Feb '01 Mar '01 Apr '01 May '01 June '01 July '01 Aug '01 Sept '01 Oct '01 Nov '01 Dec '01

3114 2778 3026 2869 3009 3119 3000 3069 2841 2962 2707 2815

Jan '02 Feb '02 Mar '02 Apr '02 May '02 June '02 July '02 Aug '02 Sept. '02 Oct. '02

3015 2991 2769 2961 2991 3055 3328 3337 3209 2921

✓ Count data ⎯  number of occurrences of some defined event

✓ Whole numbers only, no negative numbers

✓ Month-year is categorical
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311

Defects per unit
Date # Units # Defects DPU

9-Feb-90 8 8 1.00

10-Feb-90 8 17 2.13

11-Feb-90 9 18 2.00

12-Feb-90 8 15 1.88

15-Feb-90 8 23 2.88

16-Feb-90 7 9 1.29

17-Feb-90 7 19 2.71

18-Feb-90 8 6 0.75

19-Feb-90 8 14 1.75

22-Feb-90 8 17 2.13

23-Feb-90 7 13 1.86

24-Feb-90 8 15 1.88

25-Feb-90 9 16 1.78

26-Feb-90 9 22 2.44

1-Mar-90 8 13 1.63

2-Mar-90 8 10 1.25

3-Mar-90 4 14 3.50

4-Mar-90 8 9 1.13

5-Mar-90 12 23 1.92

8-Mar-90 12 21 1.75

9-Mar-90 16 51 3.19

10-Mar-90 8 31 3.88

11-Mar-90 4 3 0.75

Quantitative Y variables

• Scratches on lenses, particles on silicon 
wafers, bubbles in a laminate, errors in 
documents, . . . 

• DPU = number of defects divided by number 
of units inspected

• Used instead of DPMO when multiple 
defects per unit are possible, but there is 
not a finite number of identifiable defect 
opportunities per unit

• In this case, because the defect count is 
relatively high, DPU is treated as 
quantitative data

• If the number of units is always 1, this is 
count data

• Date:  quantitative or categorical?

312Quantitative Y variables

Transaction turnaround time

• (Date sent) - (date requested)

or

• (Date sent) - (date requested) + 1

• Calendar or business* days 

• The whole number resolution is a 
limitation of the measurement 
system

Date 

requested

Date      

sent

Calendar 

days

Business 

days

05/26/04 05/26/04 1 1

05/26/04 05/26/04 1 1

06/02/04 06/02/04 1 1

06/02/04 06/02/04 1 1

06/02/04 06/02/04 1 1

06/02/04 06/02/04 1 1

06/02/04 06/03/04 2 2

06/03/04 06/04/04 2 2

06/04/04 06/04/04 1 1

06/04/04 06/07/04 4 2

06/07/04 06/07/04 1 1

06/07/04 06/07/04 1 1

06/07/04 06/08/04 2 2

06/08/04 06/08/04 1 1

06/08/04 06/08/04 1 1

06/08/04 06/08/04 1 1

06/09/04 06/09/04 1 1

06/11/04 06/11/04 1 1

06/11/04 06/11/04 1 1

06/14/04 06/14/04 1 1

06/14/04 06/14/04 1 1

*The Excel function NETWORKDAYS subtracts 
  out the weekends 
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313Pass/fail Y variable

Testing fit, form and function on the mounting bracket 

production line

Pass/fail Good/bad

314

Can be derived from quantitative data and spec limits

LSL USL

Pass

Fail

Pass/fail Y variable

• Necessary for computing % out of spec

• Do not discard or ignore the underlying quantitative data!
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315

Monthly late account closings

2001 2002 2003

Jan 3 6 2

Feb 5 4 2

Mar 3 3 4

Apr 2 2 6

May 3 4 2

Jun 7 4 5

Jul 5 1 10

Aug 4 5

Sep 3 2

Oct 3 7

Nov 3 2

Dec 2 1

Pass/fail Y variable

• Data for 35 offices

• Tabulated pass/fail data

• Underlying raw data:  

On time or late for each
office for each month

• What we really want is days late 
for each office for each month

316

Test Date & Time Model Number Serial Number Test Station Result Failure Reason

3/1/2006 6:02 690 6099948 3 Passed

3/1/2006 6:03 692 6087149 1 Passed

3/1/2006 6:05 690 6099949 3 Failed DoBatteryAccuracyTest

3/1/2006 6:06 690 6099949 3 Passed

3/1/2006 6:12 692 6087150 1 Passed

3/1/2006 6:12 690 6099932 3 Passed

3/1/2006 6:13 692 6099622 2 Passed

3/1/2006 6:15 690 6099933 3 Failed Operating current outside of allowed range

3/1/2006 6:17 692 6099623 2 Passed

3/1/2006 6:18 690 6099933 3 Failed DoBatteryAccuracyTest

3/1/2006 6:18 690 6099933 3 Failed Operating current outside of allowed range

3/1/2006 6:19 692 6087151 1 Passed

3/1/2006 6:20 690 6099782 3 Passed

3/1/2006 6:21 692 6099624 2 Passed

3/1/2006 6:22 692 6087152 1 Passed

3/1/2006 6:22 690 6099934 3 Passed

3/1/2006 6:24 690 6099935 3 Failed DoSwitchTest

3/1/2006 6:24 692 6087153 1 Failed Sleep current outside of allowed range

3/1/2006 6:25 692 6099625 2 Passed

3/1/2006 6:27 690 6099935 3 Failed DoSwitchTest

Result & failure reasons

Pass/fail Y variables
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317

Date Shift Defect Freq

3/1/1991 A Contamination 15

3/1/1991 A Corrosion 2

3/1/1991 A Doping 1

3/1/1991 A Metallization 2

3/1/1991 A Miscellaneous 3

3/1/1991 A Oxide Defect 8

3/1/1991 A Silicon Defect 1

3/1/1991 B Contamination 8

3/1/1991 B Corrosion 2

3/1/1991 B Doping 1

3/1/1991 B Metallization 4

3/1/1991 B Miscellaneous 2

3/1/1991 B Oxide Defect 10

3/1/1991 B Silicon Defect 3

3/2/1991 A Contamination 16

3/2/1991 A Corrosion 3

3/2/1991 A Doping 1

3/2/1991 A Metallization 3

3/2/1991 A Miscellaneous 1

3/2/1991 A Oxide Defect 9

3/2/1991 A Silicon Defect 2

Defects by type

Tabulated defect data

• Defect is a categorical classification

• Freq is quantitative ⎯ it counts the 
number of defects of each type for 
each day and shift

• Good for Pareto analysis

• Can we get actual occurrence rates? 
What is missing?

• Shift is a categorical classification

• Date:  quantitative or categorical?

318Categorical Y variable

Application Appraiser Rating

1 Simpson 5

1 Montgomery 5

1 Holmes 5

1 Duncan 4

1 Hayes 5

2 Simpson 2

2 Montgomery 2

2 Holmes 2

2 Duncan 1

2 Hayes 2

3 Simpson 4

3 Montgomery 3

3 Holmes 3

3 Duncan 3

3 Hayes 3

4 Simpson 1

4 Montgomery 1

4 Holmes 1

4 Duncan 1

4 Hayes 1

5 Simpson 0

5 Montgomery 0

Quality rating

• Five-point scale:  1,  2,  3,  4,  5 

• In this case, higher is better 

• Treated as quantitative when we want to 
average the ratings (for example, GPA)

• Appraiser is a categorical classification

• Application: quantitative or categorical?
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319Exercise 17.1

Quantitative Categorical

Model year

Origin

Make

Model

Cylinders

Displacement

Horsepower

Weight

Accel

MPG

Pretend the data shown below 

contains actual data on actual 

cars. Check the appropriate 

data type for each variable.

In some cases, the data type 

may go either way, depending 

on how the variable is used. 

320Exercise 17.1 (cont’d)

Model year Origin Make Model Cylinders Displace Horsepower Weight Accel MPG

79 Europe Mercedes 300D 5 183 77 3530 20.1 25.4

80 Europe Mercedes 240D 4 146 67 3250 21.8 30.4

79 America Cadillac Eldorado 8 350 125 3900 17.4 23.0

81 Japan Toyota Cressida 6 168 116 2900 12.6 25.4

81 Europe Volvo Diesel 6 145 76 3160 19.6 30.7

81 Europe Peugeot 505S Dl 4 141 80 3230 20.4 28.1

82 America Chevrolet Camaro 4 151 90 2950 17.3 27.0

81 Japan Datsun 810 Maxima 6 146 120 2930 13.8 24.2

81 Europe Saab 900S 4 121 110 2800 15.4

80 Japan Datsun 280-ZX 6 168 132 2910 11.4 32.7

80 Europe Audi 5000S Dl 5 121 67 2950 19.9 36.4

82 Japan Toyota Celica GT 4 144 96 2665 13.9 32.0

82 America Oldsmobile Cutlass Dl 6 262 85 3015 17.0 38.0

82 America Buick CenturyLmt 6 181 110 2945 16.4 25.0

80 Japan Mazda RX-7 GS 3 70 100 2420 12.5 23.7

80 Europe Volkswagen Rabbit 4 98 76 2144 14.7 41.5

80 Europe Volkswagen Rabbit 4 89 62 1845 15.3 29.8

81 America Oldsmobile Cutlass LS 8 350 105 3725 19.0 26.6

81 America Buick Century 6 231 110 3415 15.8 22.4

82 Japan Honda Accord 4 107 75 2205 14.5 36.0

82 Japan Nissan Stanza XE 4 120 88 2160 14.5 36.0
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321Exercise 17.2

(a) Which useful statistical project metrics can be calculated from a quantitative Y 

variable?

(b) Which useful statistical project metrics can be calculated from a pass/fail Y 

variable?

322Notes
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18  Basic Statistics and Normal Distribution

324Basic statistical summary for quantitative data

( )

populationa  from samplea  of Average      mean Sample

NnumbersN  of Sum      Average        

=

=

A set of numbers:  76, 80, 80, 81, 82, 82, 88, 92

           N  =  8

Average  =  (76 + 80 + 80 + 81 + 82 + 82 + 88 + 92) 8  

         =  661/8 

         =  82.6

                  Minimum  =  76

                  Maximum  =  92
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325Basic statistics (cont’d)

Sample standard deviation  =

( ) ( ) ( ) ( )

( ) ( ) ( ) ( )

7

6.8292 6.8288 6.8282 6.8282                      

6.8281 6.8280 6.8280 6.8276

2222

2222

−+−+−+−+

−+−+−+−

=  

326Average and standard deviation in Excel
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327Open Student Files → anatomy of STDEV

Difference

328Anatomy of STDEV (cont’d)

This sheet lays out the calculation of the sample standard deviation (the STDEV.S 

function in Excel). 

The Data column contains 8 independent measurements (no constraints among 

them). We describe this by saying this column has 8 degrees of freedom (DFs).

The Average column contains a single value, repeated 8 times. We describe this by 

saying this column has 1 DF.

The Difference column is mathematically constrained to sum to 0, so it contains only 

7 mathematically independent values. From any 7 values in this column, we can 

calculate the remaining value. (What is the formula?) We describe this by saying this 

column has 7 DFs.

This is why the sum of the squared differences is divided by 7 rather than 8. Dividing 

by 8 would bias it downwards.
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329

a) Open Data Sets → solution properties. Calculate the average and standard 

deviation for Spec grav. Save your work and keep this file open for the next 

exercise. 

b) Open Data Sets → ED patient visits. ED stands for Emergency Department (aka 

ER, Emergency Room). Calculate the average and standard deviation of Visits. 

Save your work and keep this file open for the next exercise.

Exercise 18.1

330Notes
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331The Normal Distribution

Also known as 

• Gaussian distribution 

• Bell-shaped curve

Everyone believes in the Normal curve: experimenters think it is a mathematical

theorem, mathematicians think it is an experimental fact. —G. Lippman

332Normal distribution (cont’d)

The Normal distribution is an abstraction, an idealization, a mathematical construct. 

At the same time, it has been a device of great practical value in Statistics.

It’s called the Gaussian distribution because the German mathematician Carl 

Friedrich Gauss made important early applications to astronomy in the 1820s. As we 

will see, it was actually discovered a century earlier by the French mathematician 

Abraham de Moivre. 

Life really isn’t fair…
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333Origin of the Normal distribution

Number of heads in 50 tosses of a fair coin

0.00

0.02

0.04

0.06

0.08

0.10

0.12

As the number of tosses of a fair coin increases, 

the probability distribution of the number of heads

approaches a bell shaped curve.

Abraham de Moivre

1657 - 1754

334Origin of Normal distribution (cont’d)

The statistical model for the number of heads in N tosses of a coin is called the 

Binomial distribution. In 1730, the French mathematician Abraham de Moivre 

discovered the bell-shaped curve as the limiting form approached by the Binomial 

distribution as the sample size N increases without bound. He never made any money 

on his discovery of the Normal distribution, and in fact died a pauper. To add insult to 

injury, it was eventually named after someone else (Gauss).

Over the next 200 years, de Moivre’s discovery was extended far beyond coin tossing. 

Today, we know that many quantitative measurements are sums of large numbers of 

small, independent, possibly unobservable contributing factors. Measurements of this 

type in a stable population will follow the Normal distribution, at least as a good 

approximation. Statisticians call this phenomenon the Central Limit Theorem.

The Normal distribution is the default population model for quantitative measure-

ments.  
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335

35 45 55 65

 = 
 = 

 = 
 = 

 = 
 = 

 =  Greek letter mu        →   Population mean

 =  Greek letter sigma   →   Population standard deviation  

40 50 60

The bell shaped curve

336Bell-shaped curve (cont’d)

A population model is an equation that can be used to make predictions about a 

population. When we represent the mean and standard deviation by Greek letters, as 

above, we are thinking of the mean and standard deviation of the entire population, 

not just the numbers in our data set. It means we are thinking of the Normal 

distribution as a population model.

The formula for the bell shaped curve is given below. In this equation, f (y) is the 

height of the curve above the value y on the horizontal axis.

( )

2

2

1
1

2

1 






 −
−

= σ

μy

e
σπ

yf

You may have been graded “on the curve” at some point in your academic career. 

Well, this is the curve.
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337Area under curve = % of population

− − −  + + + +−

95.4%

68.3%

99.73%

99.99%

338Area under curve (cont’d)

For a Normal population:

• The 1.960  limits contain 95% of the population. 

• The 2 limits contain 95.45% of the population. 

• The 2.576  limits contain 99% of a Normal population

• The 3 limits contain 99.73% of the population. 
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339Area under curve = % of population

− − −  + + + +−

1350
 ppm

1350
 ppm

2.3%2.3%

31.7
 ppm

31.7
ppm

15.9%15.9%

Usually we care mostly about % beyond certain points

340Fitting the bell curve to data

1200 1300 1400 1500 1600 1700 1800 1900 2000

Sample data Possible bell curves

( )

2

2

1
1

2

1 






 −
−

= σ

μy

e
σπ

yf
Sample mean (1628.7) → 𝜇

Sample standard deviation (142.8) → 𝜎 
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341Why use fitted distributions?

LSL USL

?

342Why distributions? (cont’d)

The practice of calculating % defective or DPPM by means of fitted distributions 

instead of raw data came about historically as a crude but effective way for customers 

in the aerospace and automotive supply chains to expose the “hidden factories” of 

their suppliers. 

Suppliers would present final inspection data to customers to document their process 

capability. In the example shown above, the supplier claims 100% yield. When 

plotted as a histogram, the data mysteriously disappears right at the upper spec limit. 

This is because parts exceeding the upper limit are either scrapped or reworked to the 

limit. Often the rework is done by the inspector and not recorded as rework. In many 

cases, the first pass data is not recorded.

A distribution curve pays no attention to spec limits and will always produce a 

positive value for % defective or DPPM. This gives an estimate of the supplier’s first 

pass yield. In the example shown above, it is obvious that the first pass yield is far 

below 100%.
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343Using the Normal curve to predict % defective or DPPM

Allows extrapolation (          ) 

1200 1300 1400 1500 1600 1700 1800 1900 2000

0.12% of

future outcomes

(1188 ppm)

LSL

Resist

344

Student Files → calculator - Normal distribution

% below 1500
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345% below 1500 or above 1800

Student Files → calculator - Normal distribution

346

a) Open Data Sets → solution properties. Use the mean and standard deviation you 

calculated in the previous exercise to find the % or PPM for which Spec grav is 

greater than 0.925. 

b) Open Data Sets → ED patient visits. Use the mean and standard deviation you 

calculated in the previous exercise to find the % or PPM for which Visits is either 

less than 2700 or greater than 3300. 

Exercise 18.2
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19  Measurement Variation

348Topics

• Population model for measurement variation

• How components of variation add up

• Calculating measurement variation*

• Degrees of freedom

*In the situation where there is only one appraiser.
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349

True value

(TV)

ms True value according to the 
           measurement system

ms Random variation due to
            the measurement system 

Bias

Measurement error  =  Systematic error (bias)  +  Random error

Population of measurements
of a single unchanging

characteristic

Population model for measurement variation

350Population model (cont’d)

• The purpose of calibration is to eliminate gage bias

• Calibration requires standards (measurable items whose true values are 

known) or a calibrated second gage of higher accuracy 

• The primary objective of quantitative measurement system analysis (MSA) 

is to determine the variation contributed by the measurement system, ms, 

which is more than gage bias

• Quantitative MSA does not require standards

• If gage bias is constant during the MSA, the resulting ms will be accurate

• If gage bias changes during the MSA, the resulting ms will be biased 

upwards

To be clear, calibration is not enough!
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351

Variation in
true values

Measurement
variation

Observed
Variation

How components of variation add up for the overall process

tv

ms

22 σσσ mstvobs +=

obsσ
ms

tvσ

352

Appraisers not
agreeing with

each other

Appraisers not
agreeing with
themselves 

Measurement
system

variation

How components of measurement system variation add up

rpd

rpt

22

rpdrptms +=

“Reproducibility”

“Repeatability”

ms
rpt

rpd
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353STDEV revisited

Difference

354STDEV (cont’d)

The slide above is a screen shot of the worksheet Observed variation in Student Files 

→ MSA - one appraiser. This sheet reviews the calculation of the sample standard 

deviation. In MSA, this is called the “observed variation.” In other types of data 

analysis, it is called the “total variation.”

Recap of degrees of freedom (DFs)

• The Data column has 15 DFs because it consists of 15 independent 

measurements.

• The Average column has 1 DF because it consists of a single value repeated 15 

times.

• The Difference column is constrained to sum to 0, so it contains only 14 

independent values, so it has 14 DFs.

• DFs have to add up. For example, 15 = 1 + 14.
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355MSA with one appraiser (cont’d)

356MSA with one appraiser (cont’d)

The slide above is a screen shot of the sheet Measurement variation. It lays out the 

calculation of ms when each of 3 parts is measured 5 times by one appraiser.

The Part averages column has 3 DFs because it consists of 3 independent values (the 

part averages).

In the Measurement variation column, the values for each part are constrained to sum 

to 0, so any 4 of them determine the remaining value. There are 3 parts, so there are 

only 3  4 = 12 independent values in this column, so it has 12 DFs.

Because the calculation of ms involves only 12 independent values, we could refer to 

ms itself in this case as having 12 DFs. The greater the DFs for ms, the more 

accurate it is.

As before, DFs have to add up:  15 = 3 + 12.

355

356



Copyright © 2025  ETI Group

357MSA with one appraiser (cont’d)

Excel data format for MSA with one appraiser

Instructions for
doing the analysis

Screen shot of the sheet Data format & analysis

File: Student Files \MSA-one appraiser 

358MSA with one appraiser (cont’d)

Screen shot of the sheet Default output 
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359MSA with one appraiser (cont’d)

Screen shot of the sheet Edited output 

=SQRT(D13)

=3*D14

360Exercise 19.1

Open file Student Files \ MSA-one appraiser 

Perform the analysis shown in the last three slides.

The value 3ms is the measurement error ― the amount by which a single 

measurement could vary (+ or -) from the true value.
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361

• Let:  N  =  sample size of an MSA (total number of measurements)

             I  =  number of items in the MSA (parts, transactions, samples, . . .)

• DF for ms  =  N – I

Degrees of freedom for MSA with one appraiser

• In the previous example:  N = 15,  I = 3

• DF for ms  =  N – I  =   −  = 

• For Degrees of Freedom, higher is better

NOTE: 
I, not 1 (one) !

362Exercise 19.2

N DF for ms

(a) 1 item is measured 15 times

(b) Each of 15 items is measured 1 time

(c) Each of 3 items is measured 5 times 

(d) Each of 3 items is measured 10 times

(e) Each of 15 items is measured 2 times

(f) Each of 4 items is measured 10 times

(g) Each of 20 items is measured 2 times

(h) Each of 8 items is measured 8 times

(i) Each of 36 items is measured 2 times

For each scenario below, give the total number of measurements and the degrees of 

freedom for ms.
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363

• Let: I = number of items in the MSA (parts, transactions, whatever)

            A = number of appraisers 

            S = number of sessions (measurements per item per appraiser)

 N = sample size of an MSA, i.e., total number of measurements

 (N = I x A x S)

• In general: DF for ms . . . . . . . . . . . . . . . . . . . . N – I

                  DF for rpt (repeatability) . . . . . IA(S – 1)

                 DF for rpd (reproducibility) . . . . I(A – 1) 

• Note that the DFs for rpt and rpd add up to the DF for ms

(because N = I x A x S)

Degrees of freedom for MSA with multiple appraisers

364

• 5 items, 7 appraisers, 2 sessions

• N  =  (5)(7)(2)  =  70

• DF for ms  =  N – I  =  −  = 

• DF for rpt (repeatability)  = IA(S – 1)  =  ()() =   

• DF for rpd (reproducibility)  = I(A – 1)  =  () = 

Example 

Exercise 20.3
Repeat these calculations for 10 items, 3 appraisers, and 3 sessions.
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20  Measurement System Analysis

366Topics 

• Gages

• Measurement systems

• Statistical model for measurement variation

• Impact of measurement variation

• Measurement system analysis (MSA)

• Basic assumption for MSA

• MSA for quantitative measurements
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367Gages

• A gage is a measurement device 

• Gages can produce quantitative measurements or categorical 

classifications

• The people who use the gages are usually called appraisers, 

inspectors, or operators

• For visual inspections, the appraisers are themselves the gages, 

but they are not called that

• For automated measurement systems, the appraisers may not 

play a significant role in producing the results

368Measurement system

• A set of gages used to measure defined characteristics of a 

defined class of objects or events 

• The gages produce the same type of data

• For quantitative measurements, the gages provide the same 

data resolution (x.x, x.xx, x.xxx, xx.x, . . .)

• The appraisers are part of the system

• The methods and documentation are part of the system

• If there are standards, they are part of the system

367
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369Impact of measurement variation

Action taken

Pass Fail

True

outcome

Good “False alarm”

Bad “Escape”

Which type of error is more costly?  For which is the cost easier to quantify? 

370Impact of measurement variation (cont’d)

LSL USL

Variation in

true values

Measurement

variation

Variation in

observed

values

Failing good itemsPassing bad items

tv

ms

22 σσσ mstvobs +=
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371Measurement system analysis (MSA)

• Companies should make decisions based on data 

• Bad data → bad decisions

• One large company estimated the annual cost impact of 

excessive measurement variation as $33M 

• MSA quantifies and classifies measurement variation

• MSA → corrective action → reduced measurement variation 

→ reduced cost

372Common corrective actions

• Improving procedures and fixtures

• Improving gages

• Training appraisers

• Acquiring better gages

371
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373Exercise:  count the black dots

374Basic assumption for MSA 

• MSA requires multiple measurements of  “unchanging objects”

• This is not always possible

✓ Measurement process may destroy measured items

✓ Measurement process may change measured characteristics

✓ Measured characteristics may change over time

• In such cases, ad hoc workarounds are used

✓ Treat contiguous material samples as the same sample

✓ Treat items categorized as “very similar” as the same item

• Workarounds bias ms upwards

✓ Measurement system looks worse than it really is

373
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375Capability metrics for quantitative MSA

% Tolerance

• Most common metric

• Must have both LSL and USL (usually 
product or process specs)

% Tolerance 

LSL only

• Use when there is only LSL

• Process mean () should be based on 
historical data, not the MSA data

% Tolerance

USL only

• Use when there is only USL

• Process mean () should be based on 
historical data, not the MSA data

% Process

• Doesn’t require spec limits

• Process standard deviation (obs) should be 
based on historical data, not the MSA data

Measurement 

error
3ms

• Has units of the measured characteristic

• Intrinsic capability, not relative to product 
or process requirements

( ) 2LSLUSL

3σ
100

−
 ms

obs

ms100





LSL

ms

−




3
100

−




USL

ms3
100

376Acceptability criteria for “percent” metrics

10% or less Excellent

10-20% Good

20-30% Acceptable

Greater than 30% Unacceptable
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377

1. Choose at least 5 items (parts, samples, documents…) spanning the range of  

    application of the measurement system. (Spanning the range is more important 

than the actual number of items.)

2. If the measurement system has only a few appraisers, include them all in the study.  

If there are many appraisers, include as large a representative sample as possible.

3. Let I = the number of items, A = the number of appraisers, and S = the number of 

    sessions (measurements per item per appraiser). 

• The quantity IA(S – 1) is the number of independent opportunities for 

appraisers to agree with themselves (repeatability). It should be at least 30.  

• The quantity I(A – 1) is the number of independent opportunities for 

appraisers to agree with each other (reproducibility). It also should be at least 

30. 

    It is best to satisfy these requirements by increasing A, with I = 5 and S = 2. If this 

is not possible, increase I.

Designing a quantitative MSA

378Designing a quantitative MSA (cont’d)

4. If the measurements are taken by devices, and operators have no influence on the 

    results, the devices are the appraisers.

5. If devices are used to aid human inspection, combinations of devices and human 

inspectors should be treated as the appraisers. The ideal is to use all possible 

combinations of human inspectors and devices. If this is not possible, a DOE 

matrix with an acceptable number of combinations should be created. 

377
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379Examples of step 3

• The standard automotive gage study (“10 3 3”) 

• Not enough opportunities for appraiser cross agreement

• Unnecessarily many opportunities for appraiser self agreement

Open Student Files → calculator - sample size → MSA sheet

380Examples of step 3

A better plan

• Better balance of opportunities for self and cross agreement

• Same total sample size

379
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381Examples of step 3

Best plan, assuming there are actually 7 appraisers

• Adequate opportunities for self and cross agreement

• Smaller total sample size

382Conducting a quantitative MSA

1. Perform this sequence for each session: 

First appraiser measures all items once

Second appraiser measures all items once
.
.
.

Last appraiser measures all items once. 

2. The order in which the items are measured should be reversed each time the 

appraiser changes. Or, better yet, randomize the order each time.

3. The full measurement set-up process must be repeated each time a 

measurement is taken.

4. Allow some time separation between sessions to represent variation in 

operating conditions, and for human appraisers to “forget” the parts.

381
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383

• Open Data Sets → msa velocity 

gage 

• Measurements are of Drop Velocity

• Measurements need to be 

“unstacked” by Operator for 

analysis in Excel

• The standard analysis requires that 

every appraiser measures every part 

the same number of times

• I = 8,  A = 3,  S = 2 

• Was this a well designed MSA?

Analyzing a quantitative MSA

What do the numbers in cell range C2:C9 represent:
 part variation, measurement variation, or observed variation?

What do the numbers in cell range C2:E2 represent:
part variation, measurement variation, or observed variation?

384

1. Sort the data by Part as shown to 

the right (the Excel procedure needs 

this). Select ALL columns (A thru E) 

for this sorting.

2. Data → Data Analysis → Anova: 

Two-Factor With Replication → OK.

3. Set up as shown below, click OK.

Worked example

Enter the number
 of sessions here

Place cursor here,
highlight this range

383
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385

4. Scroll down to the ANOVA table as shown here.

5. Open Student Files → calculator − Gage R&R. 

Example (cont’d)

386

6. Copy the shaded area.

Example (cont’d)

Copy this area.
Paste into ANOVA table.
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387

7. Paste the shaded 

area below your 

ANOVA table 

exactly as shown.

ms  =  0.2179

Example (cont’d)

%2.13    
1.65

3
    100    Tol% ms =


=

Reproducibility is the 
dominant component, 

but not by much. 

8. For this measurement “Drop Velocity,” 

(USL−LSL)/2 = 1.65.

     Use Excel to calculate the % Tolerance 

metric. How would you classify this 

measurement system?

388

9. Create a line chart of the operator columns by part (Highlight columns > Insert 

Line Chart)

10. This is what a good one looks like. The operator curves are close together and 

roughly parallel, showing they are getting similar measurements for each part.

Example (cont’d)

387
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389

• If part variation is large enough relative to measurement variation, the lines on 

the previous chart will appear to be superimposed on each other

• The file Data Sets → msa velocity gage with charts gives the calculations for the 

chart below, which shows the data with the part averages subtracted out. 

• This helps you see what’s going on with the measurements by each operator, 

when part variation in the study is large compared to measurement variation.  

Example (cont’d)

390Interpreting ms

• In this example, 3ms  =  0.2179

• For a given measurement m, the true value lies in the interval

m ± 0.2179

   with 99.7% confidence

• The tolerance for drop velocity is ±  (Given on previous 

slide)

• 1.65 – 0.2179 = 1.4321

• To be confident that a drop velocity is in spec, it must be 

within 1.4321 of the target value (see next slide)

389
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391

Target ± 1.65

Target ± 1.4321
? ?

Interpreting 3ms (cont’d)

These are also 

known as 

“Guard Bands”

392Exercise 20.1

Open Data Sets → msa weight. Three operators weighed 10 samples 3 times each, all 

using the same scale. 

(a) The tolerance for the weight is target  1g. Find 3ms and calculate the % 

Tolerance metric. Classify the measurement system as excellent, good, acceptable, 

or unacceptable. (Target is another word for center of the spec.)

(b) Create a line chart of the operator columns. If this is not informative, create a tab 

titled with avg to mimic the calculations in msa velocity gage with charts. Create a 

plot of the weights with the part averages subtracted out. What seems to be the 

problem here? (It might help to use Session as the X-axis variable.)

Target USL = Target + 1gLSL = Target - 1g

1g 1g
 USL – LSL = 2g
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393Exercise 20.2

Open Data Sets → msa calipers. These are dimensional inspections of PVC extrusions 

made with a hand held digital caliper. 

(a) The tolerance for this dimension is Target  0.020 inch (which is the same as 

saying USL-LSL = 0.04). Find 3ms and calculate the % Tolerance metric. 

Classify the measurement system as excellent, good, acceptable, or unacceptable.

(b) Create a line chart of the operator columns with the data sorted by Sample (this 

will be the format you used for ANOVA). Who seems to be the greatest 

opportunity for improvement? To investigate further, make a second line chart 

with the data sorted by Session.

394Exercise 20.3

Open Data Sets → msa gloss. These are measurements of % gloss on 7 sheets of 

photographic paper (the “parts”) by 9 technicians. MSAs were conducted at 3 

different angles of view to determine the effect of angle on measurement variation.

a) Find the measurement error (3ms) at 20 deg. Identify the dominant component 

of ms. 

b) Find the measurement error (3ms) at 60 deg. Identify the dominant component 

of ms. 

c) Find the measurement error (3ms) at 85 deg. Identify the dominant component 

of ms. 

d) What is the effect of angle of view on measurement variation?
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395Exercise 20.4

Each team is to conduct an MSA involving coins of different diameters. Every team 

member will be an appraiser in the study. Each appraiser will measure the diameter of 

each coin twice (S = 2). Each team is to do the following:

a) Develop a procedure for measuring the diameter.

b) Determine the number of coins needed for the study.

c) Create an appropriately formatted Excel worksheet for data collection.

d) Follow the guidelines for conducting a quantitative MSA.

e) Collect and enter the data. Give the 3ms value and calculate the % Tolerance 

metric. (The tolerance for all diameters is target  0.050 inches or + 1.27 mm))

f) Is the measurement system excellent, good, acceptable or unacceptable?

396Notes

395
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21  Categorical MSA 

398

Determine the % agreement with standard 
(Also known as % correct)

Categorical MSA

• Also known as Attribute Gage Study

• Applied most often to pass/fail inspections

• The terms repeatability and reproducibility are not used in this 

context

• In this section we assume that the study is based on standards 

(items for which we know the true value)

• Primary objective in this case:

397
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399Impact of measurement variation for categorical MSA

Action taken

Pass Fail

Standard

Good “False alarm”

Bad “Escape”

Which type of error is more costly?  For which is the cost easier to quantify? 

400Notes

399
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401

1. Choose at least 10 items (parts, samples, documents…) to be inspected. There     

should be roughly equal numbers of items that are clearly passing, borderline     

passing, borderline failing and clearly failing. Choose an expert appraiser to 

function as the reference standard.

2. If the measurement system has only a few appraisers, include them all in the study. 

If there are many appraisers, include as large a representative sample as possible.

3. Let I = the number of items, A = the number of appraisers, and S = the number of     

measurements per item per appraiser. 

• The quantity IA(S – 1) is the number of independent opportunities for 

appraisers to agree with themselves. It should be at least 60. 

• The quantity I(A – 1) is the number of independent opportunities for 

appraisers to agree with each other. It should be at least 60.

    It is best to satisfy these requirements by increasing A with I = 10 and S = 2. If this 

is not possible, increase I. 

Designing a categorical MSA

402Designing a categorical MSA (cont’d)

4. If the measurements are taken by devices, and operators have no influence on the 

    results, the devices are the appraisers.

5. If devices are used to aid human inspection, combinations of devices and human 

inspectors should be treated as the appraisers. The ideal is to use all possible 

combinations of human inspectors and devices. If this is not possible, a DOE matrix 

with an acceptable number of combinations should be created. 
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403Examples of step 3 

Best plan if there are only 3 appraisers

Open Student Files → calculator - sample size → MSA sheet

404Examples of step 3 

Best plan if there are 7 appraisers

403
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405Conducting a categorical MSA*

1. Perform this sequence for each session: 

First appraiser measures all items once

Second appraiser measures all items once
.
.
.

Last appraiser measures all items once. 

2. The order in which the items are measured should be reversed each time the 

appraiser changes.

3. The full measurement set-up process must be repeated each time a measurement 

is taken.

4. Allow some time separation between sessions to represent variation in operating 

conditions, and for human appraisers to “forget” the parts.

*Same as for quantitative MSA

406Analyzing a categorical MSA

• Open Data Sets \ msa passfail

• I = 50,  A = 3,  S = 3

• Did they follow the best plan for 

3 appraisers? If not, what would 

be better?

• P = pass, F = fail

• Standard gives the correct   

answer for each part inspected

• The analysis is based on %   

agreement with the standard

405
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407Worked example

The first step is to define new columns indicating whether A, B, and C agree or 

disagree with Standard in each case (1 = agree, 0 = disagree)

Drag

Double click

408Example (cont’d)

• Use the Average function on the AutoSum button to get the % agreement with 

standard for each inspector (cells G152 through I152)

• Use it again to get the overall % agreement with standard (cell J152)

• If improvement is needed, Inspector C is the greatest opportunity

407
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409Example (cont’d)

Highlight columns A-F → select the Insert ribbon → select PivotTable → OK

• We want to find out 

what kind of mistakes 

Inspector C is making

• Go to the next slide

410Example (cont’d)

The resulting table gives the raw data for 

Inspector C: 

• 48 bad parts: Insp. C failed 42 but passed 6.

• 102 good parts: Insp. C passed 93 but failed 9.

1. Drag and drop Fields as shown

2. Filter out the blanks

3. To get Standard and Insp C in header:

Rt click in Pivot Table> Pivot Table Options > 

Display (tab) > Check Classic PivotTable layout

4. Click OK

409
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411Example (cont’d)

• Inspector C 

passed 12.5% of 

the bad parts

• and failed 8.8% 

of the good 

parts

• Inspector C 

needs further 

training to 

reduce both 

types of errors

Click dropdown on 

Count of Insp C >

 Value Field Settings >

 Show Values As > 

% of row total

412Exercise 21.1

Open Data Sets → msa print samples 1. These are visual inspections of print samples 

by 3 inspectors. The standards were determined by a committee of experienced print 

quality evaluators. 

(a) Calculate the % agreement with standard by inspector and overall. 

(b) Which inspector offers the greatest opportunity for improvement? Make a pivot 

table to determine whether the main problem is passing bad samples, failing good 

ones, or both.

(c) Save your work.

411
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413Exercise 21.2

Open Data Sets → msa print samples 2. These are visual inspections of new print 

samples by the same 3 inspectors after additional training.

(a) Calculate the % agreement with standard by inspector and overall. Have we 

improved?

(b) There is something interesting about the data for sample 18 (not row 18). What 

are the possible explanations? (Sorting by sample number will help.)

(c) It turns out the standard for sample 18 was wrong. Reclassify the standard for 

sample 18 as passing. What is the % agreement now? 

(d) Save your work.

414

Open Data Sets → msa ratings. Each of 15 employment applications was rated twice 

on a five point scale (1 = worst, 5 = best) by each of five appraisers. 

a) Calculate the % agreement by appraiser and overall. 

b) Which inspector offers the greatest opportunity for improvement? Make a pivot        

table to determine the particular error this inspector often makes. 

Keep the default format of Show Values as Count; it will be easier to discern any 

pattern this way.

c) Save your work.

Exercise 21.3

413
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41522  Data Collection
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416Purposes of data collection

• Calculate project metrics for the current state

• Pareto analysis of defect types, error types, failure reasons, etc.

• Comparisons within the current state (stratification analysis)

• Correlation of X and Y variables

• Use analysis results to help identify root causes

415
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417Population sampling

Population
• A specified collection of people or 

things

Sample

• A subset of a population

• Usually relatively small

• Intended to represent the population

418

Population of

registered

voters

“Do you support
the current policy 
on ____ ?”

 ☺

Example:  opinion poll

We want

to determine

the percentages

417

418



Copyright © 2025  ETI Group

419


☺

The sample must be representative

“Do you support
the current
policy on ____ ?”

420Representative sampling (cont’d)

• Examples of obvious biases: sample includes only 
✓ Democrats

✓ Republicans

✓ Men

✓ Women

✓ Residents of Wyoming

✓ Convicted white collar criminals

✓ Relatives of elected government officials

• Standard survey sampling technique 

✓ All counties are categorized into something like 30 groups 
(“strata”) according to population density

✓ Each stratum (group of counties with similar population density) 
is randomly sampled in proportion to its population

• This is an example of stratified random sampling

419
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421

Population Purpose Proposed sample

(a) Former Enron      
employees

Opinion on culpability of 
top Enron executives

Those with the largest retirement 
accounts, comprising 85% of lost 

value

(b) A year, make, and 
model of car

Surreptitiously 
determine % with a given 

defect

Offer a free ____ until 100 cars 
have been inspected at each US 

dealership

(c) ER patients at a      
hospital last year

Customer satisfaction
survey

Those whose last names begin with 
the letter M

(d) Lambs born in 
New Zealand last 
year

Determine % with “mad 
lamb” disease

Random sample of each ranch in NZ, 
proportional to # of lambs

(e) Registered voters
Opinion on presidential

 candidate
Generate telephone numbers at 

random, call those people

Decide whether or not the proposed sample in each case below will be representative 

of the population. If not, note obvious or possible biases on the slide below.

Exercise 22.1

422

(a)

(b)

(c)

(d)

(e)

Exercise 22.1 (cont’d)
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423


☺

 51% of the people     

responding to the     

survey say “yes”

Incorrect interpretation of survey data

Click Bait Reporting 
“According to a recent 
survey, the majority of 

registered voters support 

the President’s policy.” 

“Do you support
the current
policy on ____ ?”

424Interpretation of survey data (cont’d)

• Suppose the sampling plan was perfectly representative of the 

population

• Still, we cannot say that what is true in the sample is true in the 

population

• The sample data does not prove that 51% of registered voters agree 

with the President’s policy

423
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425


☺

Must quantify the uncertainty

Accurate Reporting

“51% of sampled voters 
supported the President’s 

policy. The margin of 
error is ±3 percentage 
points, so the survey is 

inconclusive.” 

“Do you support
the current
policy on ____ ?”

426Quantifying uncertainty (cont’d)

• “Margin of error” (MOE) is how we quantify our uncertainty 

about the population in light of the sample data

• The most we can say:  “The percentage of registered voters 

agreeing with the President’s policy is between 48% and 54%”

• The data fails to demonstrate a majority on either side of the 

question

425
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427

A predetermined sequence of actions and decisions

intended to produce a desired outcome. (A way of 

doing something.)

✓Manufacturing process

✓Service process 

✓ Business process

✓Transactional process

✓Decision process

✓Design process

Process

For any process, there is an associated population

Process sampling

428Process sampling (cont’d)

Process
Materials, methods,

equipment, operators,
environments

Population
All parts or transactions ― past, present, 

or future― within the project scope

Sample
Outcomes the process

has produced or is now 
producing

How do we know the
extrapolation is valid?

427
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429Process sampling for LSS projects

• 100% sampling for a period of time, is the most 

common method

• What are some situations where 100% sampling is 

not possible? 

• The sample must cover a representative time period

• The sample must capture all typical sources of 

variation (see slide below)

430Typical sources of variation

Process participants

 “Identical” pieces of equipment

 Time of day, week or month

 Batches or lots of raw material or components

 Different suppliers

Production lots, work orders, . . . 

 Different locations

 Changing environmental conditions

Inconsistent practices/procedures

 Multiple measurement systems

In summary, the “6 M’s”

429
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431

Items are selected by a random number generator

Items are selected at regular intervals

Items are sampled from homogeneous 

subpopulations, in proportion to subpopulation size

Items are selected using knowledge of the process

Items are selected based on cost or ease of access

“Less than 100%” sampling methods

Random

Systematic

Stratified random*

Judgment

Convenience

*Usually considered to be the most representative sampling method.  

432

(a) Pulled 10 parts off the high volume 
production line at the top of each hour

(b) Reviewed Enron electricity trades 
during periods of highest demand

(c) Used random numbers to select 10% of 
patient charts for the past year

(d) Monitored every 1000th customer 
service call

(e) Downloaded invoices with numbers 
ending in 0 or 5

(f) Inspected the first 3 parts from each 
production lot             

(g) Took a sample from the top of each 
barrel on the top layer of the stack

Exercise 22.2

Check the sampling methods that apply in 

each case based on the given information.
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433Sample size

• Amount of data:  more is better than less

• Time period:  longer is better than shorter* 

• Capturing all typical sources of variation usually gives an 

adequate sample size

• You should do a sample size calculation just to make sure

*But beware of old data that is no longer relevant to your current state.

434Sample size calculation:  opinion poll example



The fraction (proportion) of people in the population who would say yes to 

the survey question if asked. 

We don’t know, and will never know, the exact value of . However, we can 

get an accurate estimate of  if we collect enough data.

Sample
The people who respond to the survey. Usually, this is a very small subset of 

the population.

sample 

The fraction (proportion) of the respondents who say yes to the survey 

question. This is our estimate of . 

We don’t know this now, but we will after we get the data.

MOE

Margin of error:  the amount by which sample could differ from , based on 

an established statistical standard of evidence. 

The most common standard of evidence is called “95% confidence.”

N
The number of people who respond to the survey ⎯ the sample size.

The required sample size depends on sample and the desired MOE. 

433
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435Sample size (cont’d)

In most opinion polls, sample is assumed to be close to 0.5 when determining sample 

size.  This gives the largest sample size needed to achieve the desired margin of error 

(MOE). If sample is not 0.5, the MOE will be smaller, which is desirable. The 

approximate formula for the MOE (with 95% confidence) is:

( ) ( )

N

0.98
   =   

N

0.5 0.5
 1.96   =  

N

 - 1
 1.96  =  MOE

samplesample 

MOE N

0.05 384

0.04 600

0.03 1067

0.02 2401

0.01 9604

We can solve this equation for N:

N = (0.98  MOE)2 

436Sample size calculation:  process applications for pass/fail Y

• In process applications (as opposed to survey data),  represents the 

fraction defective

• In this case, the margin of error on the high side is of greatest interest:

 sample +  MOEupper  =  Upper bound on  (with 95% confidence)

• To do a sample size calculation, we must provide two inputs:

a) A guess for  sample 

b) An acceptable upper bound on  (giving the desired MOE, 

which is the difference between this upper bound and sample)

• Open Student Files →  calculator - sample size  →  % Defective
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437Example calculator - sample size  →  % Defective

• We think sample will be close to 0.05 (5% defective)

• If this turns out to be true, we want to be able to say (with 95% confidence) 

that  is no larger than 0.075 (7.5% defective)

• Enter 1 in cell C2, 5 in C3, and 7.5 in C5

• We want to set cell C6 to 7.5 by changing cell C2

• Select Data → What If Analysis → Goal Seek → set 

  up as shown to the right → click OK

438Exercise 22.3 

We want to get an accurate estimate of the population % defective. Use calculator - 

sample size →  % Defective to find the required sample size in the following 

scenarios:

Guess for 
sample % 
defective

Desired upper bound 
on population % 

defective

Sample 
size

(a) 10 20

(b) 10 15

(c) 10 13

(d) 1 4 

(e) 1 3

(f) 1 2
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439Finite population sampling for pass/fail Y

Open Student Files → calculator - sample size → Finite population sampling

• We want to determine the % defective in a finite population of size 2000

• Enter the values shown below in cells C4, C6, and C7

• We want to set cell C9 to 3 by changing C10

Data



What If Analysis



Goal Seek 



Set up as shown on 

the next slide

440Finite population sampling for pass/fail Y (cont’d)
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441Sample size for estimating a population mean (quantitative Y)

• Open Student Files →  calculator - sample size  → Pop. mean for 

quant. Y 

• Requires an estimate of the standard deviation

• Common practice:  

✓ Collect a small amount of data, calculate the standard deviation

✓ Do a sample size calculation to see how much more you need

✓ You can also get a rough estimate of the mean from this data

• Suppose our rough estimates are  = 50.4 and  = 9.8

• We want our MOE to be 10% of the mean → MOE = .1 * 50.4 = 5

• Enter the value 2 in cell C2,  9.8 in C3, and 5 in C4

• Select Data → What If Analysis → Goal Seek

442Sample size for population mean (quantitative Y) (cont’d)

• We want to set cell C5 to 5 by changing cell C2

• Set Goal Seek up as shown here, click OK 
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443Exercise 22.4

a) For the previous example, use calculator - sample size → Pop. mean for quant. Y 

to calculate the sample size assuming we want our MOE to be 5% of the mean 

instead of 10%.

b) Use calculator - sample size → Pop. mean for quant. Y to calculate the sample size 

assuming we want MOE to be 1% of the mean.

444Notes

443
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23  Establishing Baselines ― Pass/fail Y

446Topics

• Calculating % defective from “raw” pass/fail data

• Pareto analysis of failure reasons from “raw” failure/defect data

• Calculating % defective from tabulated pass/fail data

• Pareto analysis from tabulated failure/defect data

445

446



Copyright © 2025  ETI Group

447% Defective from “raw” pass/fail data

Open Data Sets → ATE Mar & Apr

• Medical devices are tested for 20 or so failure 

modes by automated test equipment (ATE)

• Part level data (not tabulated)

• Y variables  =  Result, Failure Reason

• X variables  =  Date, Time, P/N, Tester

448% Defective (cont’d)

1. Select columns 

A-F

2. Insert → Pivot 

Table → OK 

3. Go to the next 

slide.
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449% Defective (cont’d)

4. Drag/drop Result 

into the Columns 

box

5. Drag/drop Result 

into the Values 

box

6. Go to the next 

slide.

450% Defective (cont’d)

7. Pull down the Column Labels 

menu (shown above)

8. Uncheck (blank) on that menu, 

select OK

9. Go to the next slide.

Should look like this 
after dropping in 

fields

Column Labels Menu
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451% Defective (cont’d)

Project metric % Defective

Baseline value 20.95%

10. Right-click drop down on Count 

of Result

11. Choose Value Field Settings

12. Select Show Values As, then % of 

Grand Total.

Next, we’ll format the data as a percentage for reporting purposes.

Format for reporting:

452Pareto analysis of failure reasons

1. Go back to the 

data sheet, launch 

a new PivotTable 

2. Drag/drop Failure 

Reason to Rows 

and to Values

3. Uncheck (blank) 

on the Row Labels 

menu as needed

4. Go to the next 

slide

Menu
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453

5. Copy Pivot table 

except for the 

Grand Total

6. Paste one 

column to the 

right

7. Highlight entire 

table you just 

pasted

8. Select Insert > 

Charts Section > 

Insert Statistic 

Chart dropdown 

> Pareto

9. Go to the next 

slide

Pareto analysis of failure reasons (cont’d)

Paste

454

Click the “+” button to edit chart 
elements

Select and edit desired elements 
including Chart Title, Axes Titles, and 
Secondary Axis 

Pareto analysis of failure reasons (cont’d)
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455

All files are in the Data Sets folder. 

 

a) Open lot sampling. Find the % failing. Save your work.

b) Open old cars. Assume that each row represents one automotive product recall, 

and the make column lists the brand of car involved in the recall. Create a Pareto 

chart of make by frequency of occurrence. Save your work.

Exercise 23.1

456Exercise 23.1 (cont’d)

c) Open supplier comparison. Find the % failing. Save your work.

d) Open unplanned downtime log. Each row represents a downtime event in a 

manufacturing process. Create a Pareto chart of Problem area by frequency of 

occurrence. Save your work.
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457% Defective from tabulated pass/fail data

• Open Data Sets → ATE failure 

occurrence tabulated

• Daily summaries, not part level 

data

458% Defective from tabulated data (cont’d)

• Insert a pivot 

table

• Set up as shown 

here

• Calculate the % 

defective 
(Do ‘manually’ with 

a formula since 

Value Field Settings 

won’t work due to 

the tabulated data.)
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459Pareto analysis from tabulated data

• Open Data Sets → ATE failure 

reasons tabulated

• Daily summaries, not part 

level data

• Freq = number of failures for 

each day, P/N, tester, and 

failure reason

• The total number of tests for 

each  day, P/N, and tester is 

not given

• This situation is very common 

in tabulated failure/defect data

460Pareto from tabulated data (cont’d)

• Insert a pivot table

• Set it up as shown 

here

• Failure reasons can 

be sorted in 

descending order by 

number of 

occurrences in the 

Pivot Table, but this 

step is not necessary 

when creating a 

Pareto with Excel

• The Pareto chart 

will turn out the 

same as the one 

generated from the 

“raw” data

459
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461

All files are in the Data Sets folder. 

a) Open parts inspected & defective. Find the % defective. Save your work.

b) Open defects & types. Create a Pareto chart of defect types by frequency of 

occurrence. Is it possible to obtain % defective from this data set? Explain your 

answer. Save your work.

c) Open out of box failures. The data represent results of a customer’s incoming 

inspection of purchased components. Find the % failing. Save your work.

Exercise 23.2

462

d) Open unplanned downtime log. Create a Pareto chart of Problem area by total 

downtime. Save your work.

e) Open scrap quantity and cost. Create a Pareto chart of scrap category by quantity 

scrapped. Is it possible to obtain scrap as a % of total production from this data 

set? Explain your answer.

f) Create a Pareto chart of scrap category by total cost of scrap. (You will have to 

create a new data column defined by a formula.) Compare this to the chart in (e). 

Save your work.

Exercise 23.2 (cont’d)
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24  Establishing Baselines ― Quantitative Y

464Topics

• Basic statistical summary 

• Frequency histogram

• Calculating % defective from quantitative data 

463
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465Basic statistical summary

• Open Data Sets → DI water

• Measurements of de-ionized water 

used in machining and cutting 

operations taken 3 times an hour 

for 8 days

• Y variable  =  Resist (higher is 

better)

• X variables  =  Day, Hour

466Basic statistical summary (cont’d)

1. Select the Data ribbon

2. Select Data Analysis

3. Select Descriptive Statistics

4. Click OK

5. For Input Range select all of 

column C (click on the 

column header)

6. Select Labels in first row

7. Select Summary statistics

8. Click OK

465
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467Basic statistical summary (cont’d)

• Stretch 
column A to 
avoid using 
the wrong 
standard 
deviation

• Edit down to 
the “vital 
few” 

• Correct the 
default 
numerical 
formats

Resist

Project metric Average Resistivity

Baseline value 1628.8

468Frequency histogram

A statistical graphic for displaying variation in quantitative data

467
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469Histogram (cont’d)

• Shows variation without plotting the data over time

➢ Heights of bars show the number of data points in 

each bin

➢ Bin widths are equal, and are a range of numbers

• Histograms and time plots are complementary ― they can 

reveal different aspects of the data

• We will discuss time plots later

470Histogram (cont’d)

Excel path to create Histogram:  

 Data → Data Analysis → Histogram

469
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471Histogram Setup:  Data → Data Analysis → Histogram

Select the data range only

Click in C2 and press Ctrl-Shift- 
to grab whole column of data

472Histogram output*

The numeric format for the bin
endpoints should not vary

*Modified to improve on the terrible Excel defaults

471
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473Histogram output that you don’t want

If you get a graph that looks like this,
you selected the entire column, not just the data.

474Histogram (cont’d)

It looks better if we format the bin endpoints (A2:A22) to an 
appropriate number of significant digits

473
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475% Defective from quantitative data

• Averages are common project metrics 

for quantitative Y variables

• Averages are useful for statistical 

comparisons

• However, customers feel the variation, 

not the average

• The best metric for customer 

dissatisfaction is the % of parts or 

transactions that do not meet a 

requirement or expectation

476Percent less than 1500

• Let’s say the lower spec limit 

(LSL) for Resist is 1500. 

• Use the requirement to be met as 

the name for a new column (cell 

D1)

• We want the new column to say 

“Pass” when Resist  1500 and 

“Fail” when Resist < 1500 

• Enter the corresponding IF 

statement into cell D2

   =IF(C2 >= 1500,”Pass”,”Fail”)

475
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477Percent less than 1500 (cont’d)

Now we need to copy the formula 

down to end of the column: 

• Click on D2

• Double-click on the lower 

right-hand corner of D2

• If there are blank cells, repeat 

this process until you get 

down to the last row of data

478Percent less than 1500 (cont’d)

• Run a pivot table on the new column: highlight columns A-F, Insert → 

Pivot Table → OK, drag R>=1500 to Columns and Values

• Calculate the % less than 1500 

• Use Value Field Settings to format as a percentage

Project metric % < 1500

Baseline value 19.4%

Format for reporting:

477
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479Percent greater than 1800

• Let’s pretend Resist has a USL 

at 1800 

• Use the requirement to be met 

as the name for a new column 

(cell E1)

• We want the new column to say 

“Pass” when Resist  1800 and 

“Fail” when Resist > 1800 

• Enter the corresponding IF 

statement into cell E2

• Copy the formula down to the 

end of the data set

480Percent greater than 1800 (cont’d)

• Run a pivot table on the new column

• Calculate the % greater than 1800

• The total % defective would be 19.4 + 13.3  = 32.7%

• Save your work 

Format for reporting:

479
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481

Open Data Sets → number & size of defects. Max size is the area of the largest 

weld repair on a casting. 

(a) Create a basic statistical summary for Max size. 

(b) Create a frequency histogram for Max size.

(c) The customer will accept a casting only if Max size is less than or equal to 15. 

Find the percentage of castings that exceed 15.

(d) Save your work.

Exercise 24.1

482

Open Student Files → Case Studies → quotation process → 

quotation process current state. TAT is the turnaround time in business days for each 

quote. 

(a) Create a basic statistical summary of TAT. Update the charter* by entering the 

baseline average TAT. Enter 1.5 days as the goal for that metric.

(b) Create a frequency histogram of TAT.

(c) Customers have been told quotes will be turned around in 3 days or less. Find 

the percentage of quotes that do not satisfy this expectation. Update the charter 

by entering this as the baseline value. Enter 10% as the goal for that metric.

(d) Calculate the purchase order hit rate (% Yes in the PO column). Update the 

charter by entering this as the baseline value.

(e) Save your work.

Exercise 24.2

* Student Files → Case Studies → quotation process → quotation process charter

481
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483Exercise 24.3

Open Student Files → Case Studies → MBDP → MBDP current state. 

a) Create a basic statistical summary of PO-PD. Update the charter* by entering 

the average PO-PD as the baseline value.

b) Create a frequency histogram of PO-PD.

c) Find the % of orders for which PO-PD exceeds 30 days. Update the charter by 

entering this as the baseline value.

d) Find the % of orders for which MFG is not happy. Update the charter by 

entering this as the baseline value.

e) Save your work.

* Student Files → Case Studies → MBDP →MBDP charter

484Notes

483
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25  Plotting Data Over Time

486Why plot data over time?

By plotting data in time sequence, we can see how the process 

is performing over time. We can quickly see: 

• the amount of variation and whether it changes over time

• upward or downward trends

• unusual data points

• cycles or other patterns in the data

485
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487Example 1:  Plotting quantitative data

Open Data Sets → DI water

• De−ionized water is used in machining and 

cutting operations

• Y = electrical resistivity (Resist)

• Want lower conductivity, so higher Y is better

• Baseline data was collected over 8 days, 3 

measurements per hour

• Want to make a time plot

488Example 1 (cont’d)

1. Select column C, then select column A while holding down the Ctrl key

2. Insert a line chart (“Line with Markers”)

3. Behold: your typically terrible default Excel chart

4. Desperately needs “graphical 5S”

487
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489Example 1 (cont’d)

5. With a single data series the legend is pointless ― delete it

6. Format the vertical axis as shown below:  more data, less empty space

7. Format the data series to reduce the size of the markers and lines

490Example 1 (cont’d)

• Good graphics are “lean” graphics

• General principle for lean graphics:

Reduce the ink-to-data ratio! 

• There are a couple of interesting observations 

about the data plotted above ⎯ what are they?
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491Example 2: Plotting quantitative data

Open Student Files → Case Studies → quotation process

 → quotation process current state

=YEAR(D2)+MONTH(D2)/100 =IF(H2>3,”Fail”,”Pass”)

492Example 2 (cont’d)

1. Select column H, then select column D while holding down the Ctrl key

2. Insert a line chart (“Line with Markers”)
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493Example 2 (cont’d)

Changes in variation, no discernable changes in the mean
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494Example 3:  Plotting pass/fail data

Open Data Sets → ATE Mar & Apr

• Part level data (not tabulated)

• Y variables  =  Result, Failure Reason

• X variables  =  Date, Time, P/N, Tester

493
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495Example 3 (cont’d)

• Medical devices are tested for 20 or so failure modes by 

automated test equipment (ATE)

• Every time a unit is tested, a new record is added to the 

database 

• This is part level data ― one part for each row 

• Let’s say we want plot the daily % failing 

496Example 3: (cont’d)

1. Select columns A-F

2. Insert a PivotTable (see next slide)

495
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497Example 3 (cont’d)

3. Set up as shown here

4. Go to the next slide

498Example 3 (cont’d)

5. Format the data as percentages 

using Value Field Settings

6. Because we are using individual 

samples (rows) of data, we need to 

calculate the percentage based on 

the row total

7. Go to the next slide
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499Example 3 (cont’d)

8. Next, Copy and Paste the Count of Result 

Row Labels and the Fail % columns to a 

blank area of the worksheet.

9. Click in any Fail data cell and Insert a Line 

Chart with Markers

500Example 3 (cont’d)

• The outlier is 

3/18/06, a Saturday

• The plant is closed 

on weekends ― an 

engineer came in to 

troubleshoot one of 

the testers 

• De-select 3/18/2006 

in the original pivot 

table and redo the 

Line chart.

• Looks like steady 

variation around a 

mean of about 20%.

• Close and save the 

data set

499
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501Example 4:  Plotting summary statistics

• Can also plot summary statistics by time period 

• Average, % too high, % too low, etc.

• May give a clearer picture of certain patterns of 

variation

Open Data Sets → DI water

502Example 4 (cont’d)

1. Let’s plot average resistivity by hour of day

2. Insert a pivot table, set it up as shown below
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503Example 4 (cont’d)

Click on any data cell in the Pivot 

Table (the Pivot Table Fields dialog 

will be showing), select Insert ribbon 

→ Line Chart

• There was a cyclical 

daily pattern, most 

pronounced from 

noon to midnight

• It was caused by 

everyone taking 

lunch and breaks at 

the same time

504

Open Student Files → Case Studies → quotation process → quotation process 

current state. Create the following charts. Make them look the way they should. 

a) Monthly % TAT > 3.

b) Monthly PO hit rate (% Yes).

c) Close and save the data set.

Exercise 25.1
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26  Process Capability Indices

506Topics

• Purpose of Process Capability Indices 

• Commonly used indices

• Important assumptions for validity
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507Process capability indices

LSL USL

• Some industries focus on “capability indices” instead of DPPM or DPMO 

• These are calculated from the specification limit(s) and a fitted distribution

• Back in the day, the distribution was always assumed to be Normal

508Process capability indices (cont’d)

• Do your organization’s external customers ask for 

process capability reporting?

• Are there internal requirements or needs for  process 

capability reporting?
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509Cp index

LSL USL



Spec width

In this case, Cp is less than 1

Cp =  
Spec width

6σ
 



−
=

+
=

6

LSLUSL
 

2

CC
C

pupl

p

510Cp index (cont’d)

• The Cp index was historically the first to be used. 

• It is defined as the specification width (USL – LSL) divided by the process 

spread (6). 

• It set the precedent for capability indices to be defined so that “higher is 

better.”

• In the example above, the process spread is greater than the spec width, so 

Cp is less than 1. 

• It is common for customers to push suppliers to achieve index values of 

1.33 or higher for key Y variables. 
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511Cp (cont’d)

LSL USL



Spec width

In this case, Cp is greater than 1, but what’s a potential problem here?

512

• In the example above, the process spread is less than the spec width, so Cp 

is greater than 1. 

• The limitation of Cp is that it doesn’t depend on the process mean. 

➢ If the process mean is equal to the midpoint of the specification range, 

then Cp is directly related to first pass yield. 

➢ If the process mean does not equal the midpoint of the specification 

range, Cp represents the capability that could be attained by moving the 

process mean to the midpoint.

Cp (cont’d)
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513Cpl and Cpu and Cpk indices

 
3σ

A
    lower" C"    C ppl ==  

3σ

B
    upper" C"    C ppu ==

LSL USL



 

514

• The indices Cpl and Cpu, pronounced “Cp lower” and “Cp upper”, were 

introduced to overcome the deficiency of Cp. 

• They depend on both the mean and standard deviation of the process. If we 

know both Cpl and Cpu we can determine the first pass yield of the process.

• Cpk is the final index reported from Cpl and Cpu ; it is the lower of the two 

indices, i.e., the worst-case scenario.

• Like the Cp index, Cpl, Cpu , and Cpk  are defined so that “higher is better.” 

• In the example shown above, the main problem is on the high side, 

with Cpk less than 1.

Cpl and Cpu and Cpk indices (cont’d)
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515

LSL USL




 



Cpl and Cpu and Cpk indices (cont’d)

Cpl is greater than 1,  Cpu is equal to 1

516

• Cpk is equal to 1 in the example above. The improvement opportunity is on 

the high side.

• We’ve used “A” and “B” to conceptually represent the comparison of each 

half of the Spec width to the associated half of the process spread. 

• How would you write the actual formulas for Cpl and Cpu?

Cpl and Cpu and Cpk indices (cont’d)
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517Process Capability Formulas (Normal distribution) 
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Many people have asked what the k in Cpk stands for. To everyone’s great disappointment, the k seems 
to have been chosen arbitrarily and may not stand for anything. 

There is, however, a bit of historical trivia that may give us a clue: 

➢ Cpk was first popularized by a man named Victor Kane. 

➢ Is it possible Victor simply used the first letter of his last name?

518

• Use Cpl if you have only a lower spec limit

• Use Cpu if you have only an upper spec limit

• Use Cpk (smaller of Cpl and Cpu) if you have both lower and 

upper spec limits

 

• As noted previously, Cp indicates what Cpk would be if the 

process mean were equal to the midpoint of the spec range. 

➢ If this is not the case, Cp represents a potential capability.

➢ Centering a process at this midpoint may not always be 

desirable. 

Guidelines for Process Capability Indices

517
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519Important assumptions in Process Capability

For Process Capability indices to be valid, the following must be true:

• The process is in statistical control (we will discuss this topic in the Control 

phase)

• The measurement data is normally distributed*

• The sampling method used is representative of day-to-day process operation

There are times when we want to calculate process capability before the process is 

under control, for example to set an initial baseline or make a rough prediction. 

• The purpose of a process capability study should always be communicated along 

with the numbers.

*Handling situations when the data is not normally distributed is beyond the scope of this course. Some 

statistical software packages offer options for calculating Process Capability for non-Normal 

distributions, along with indices for other special cases.

520Exercise 26.1 Calculating Process Capability indices

• For this distribution, the mean = 76 

and the standard deviation = 1. 

• We will calculate the Process 

Capability Indices together, writing 

out each fraction in detail to better 

visualize the Spec Width vs 

Process Spread.

Cp =
USL−LSL

6σ
 =

 
=

 
=

Cpl =  
μ−LSL

3σ
 =

 
=

 
=

Cpu =  
USL− μ

3σ
 =

 
=

 
=

Cpk = min Cpu, Cpl  =
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521Exercise 26.2

(a) Calculate Cp and Cpk for a process with mean = 55, standard deviation = 1, 

USL = 60 and LSL = 50. 

Sketch the distribution.

(b) Calculate Cp and Cpk for a process with mean = 100.20, 

standard deviation = 0.20, USL = 101.00 and LSL = 100.00. 

Sketch the distribution.

522What is “good” process capability?

Capability  How good is this?  Sigma Level

 Cp = 1.0  Marginally capable  3 sigma

 Cp = 1.33  Good    4 sigma

 Cp = 2.0  World-class   6 sigma

The indices Cp and Cpk are assumed to be measures of the long-term 

capability of the process. Therefore,

• the data needs to be gathered over a long enough period of time to 

capture all regular contributors to process variation, 

• and a sample size of at least 70 is needed, with 100 preferred.
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523Predicting defects

Cp, Cpk 

Value 
Cp Fallout 
(centered) 

Cpk Fallout 
(not centered) 

.5  133,620 PPM  66,810 PPM 

.6  71,860  35,930 

.7  35,720  17,860 

.8  16,400  8,200 

.9  6,940  3,470 

1.0  2,700  1,350 

1.1  966  483 

1.2  318  159 

1.3  96  48 

1.33  66  33 

1.4  26  13 

1.5  7  3 

1.6  2  800 PPB 

1.7  340 PPB  170 

1.8  60  30 

1.9  12  6 

2.0  2  1 
 

PPM = Parts Per Million

PPB = Parts Per Billion

Note: 1%=10,000 PPM

524Notes
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525
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27  Testing for Statistical Significance

526

• Comparing populations with quantitative Y

• Comparing populations with categorical (pass/fail) Y

• Correlating quantitative X and Y variables

Topics

525
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527

Example
Is there a difference between molding machines A and B with 

respect to average diameter of molded parts?

Required data
Diameters for representative samples of parts molded on 

machines A and B.

Y variable Diameter ⎯ quantitative

X variable Machine (A or B)

Comparing populations with quantitative Y

528

Example
Is there a difference between molding machines A and B with 

respect to the percentage of parts with cosmetic defects?

Required data
Defective (yes/no) for representative samples of parts 

molded on machines A and B.

Y variable Defective (yes/no)

X variable Machine (A or B)

Comparing populations with categorical (pass/fail) Y

527
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529Correlating quantitative Y and X variables

Example If we reduce our billing lead time, will we get paid sooner?

Required data
Days in accounts receivable and billing lead times for a 

representative sample of invoices.

Y variable Days in accounts receivable 

X variable Billing lead time

530

X data type Analysis type The X column contains . . .

Categorical
Comparing
populations

• Labels identifying logical subgroups 
(strata) within the current state data, or

• Labels distinguishing the current state 
data from the future state pilot data

• Each group must contain multiple rows (Y 
data values)

Quantitative
Correlating
variables

• Quantitative measurements

• The data consists of (X, Y) pairs (values in 
the same row)

• Don’t need to have multiple Y values for 
each X value

The role of the X variable in significance testing

529
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531

X data type Y  data type Excel tool

Categorical

Quantitative
Data Analysis



Anova: Single Factor

Categorical 
(Pass/fail)

Student Files
 

 calculator - chi square test

Quantitative

Quantitative
Data Analysis



Regression

Categorical 
(Pass/fail)

Logistic Regression 
(Not an Excel option and not 

covered in this course)

Excel tools for significance testing

532Exercise 27.1

For questions (a) through (g) on the next three slides, identify the X and Y variables 

and their data types, then write the letter in the appropriate box.

X data type Y  data type Questions Analysis tool

Categorical

Quantitative
Data Analysis



Anova: Single Factor

Categorical 
(Pass/fail)

Student Files 


 calculator - chi 
square test

Quantitative Quantitative
Data Analysis



Regression

531
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533Exercise 27.1 (cont’d)

(a) We applied a functional test to circuit boards from the standard process and our 

new lead-free process.  We counted the number that passed and failed for both 

processes and want to know if the failure rate is the same.

(b) We sealed potato chip bags using various bonding pressures, then measured the 

bond strengths. Is bond strength correlated with pressure?

(c) We conducted a Kaizen event in order processing. We measured lead times before 

and after the event. Is average lead time after the event shorter than it was before 

the event?

534Exercise 27.1 (cont’d)

(d) For each customer support call we record the wait time and a customer satisfaction 

score on a scale from 1 to 10. Is customer dissatisfaction correlated with wait 

time?

(e) Measuring the fat content of milk by chemical analysis is very accurate, but it 

takes too long and costs too much to use in production. We need a faster, cheaper  

method. For a set of milk samples, we have the fat content based on chemical 

analysis, as well as a different kind of measurement based on infrared (IR) 

spectroscopy of the milk sample. Is fat content correlated with the IR 

measurement?

533
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535Exercise 27.1 (cont’d)

f) Engineers complete change orders which are then sent back to the customer for 

approval.  Each change order has been counted as being complete and accurate or 

not based on the customer’s approval.  Are there differences among the engineers 

in their change orders’ “complete and accurate” rate?

g) We use several different machines to seal potato chip bags. Do the machines give 

the same average bond strength?

536

Standard data matrix format


Data format required for Anova: Single Factor


• Open Data Sets → significance testing examples

• We want to determine whether or not there a significant difference between 

machines A and B. 

• Reformat the data into columns A and B, as shown, to perform ANOVA.

Significance testing:  example 1

Comparing samples with quantitative Y

535
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537

Data
 

Data Analysis


 Anova: Single Factor


Set up as shown


OK

Significance testing:  example 1 (cont’d)

538

Default Excel output

Significance testing:  example 1 (cont’d)

Go to the next  slide
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539

Cleaned up Excel output

Significance testing:  example 1 (cont’d)

P value

The probability that there is no difference between the populations.

The probability that there is no difference in average diameter between 

machines A and B. The sample is used to infer a difference in the 

machines’ performance.

540Interpreting P values - “Statistical Standard of Evidence”

None None

Some 85%  CL < 95%

Strong 95%  CL < 99%

Very Strong CL  99%

0.05  

0.15  

0.01  

1.00  

P
 v

al
u

e

Probability of NO 

difference or correlation

Level of evidence that samples ARE 

different or variables ARE correlated

Confidence level (CL)

for difference/correlation

& 

lower 

toward 

zero
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541

• In this example, the P value is 0.0401

• There is strong evidence of a difference between the samples 

• Based on this analysis, we expect that parts molded on machine B will have 

larger diameters than parts molded on machine A

Significance testing:  example 1 (cont’d)

542

It may seem odd that P values are defined in relation to hypotheses of no difference or 

no correlation. This practice evolved from an emphasis in applied scientific research 

on preventing false positives (i.e., concluding there is a difference or correlation when 

there really isn’t).  

When communicating significance testing results to those unfamiliar with P values, it 

can be less confusing to express the evidence supporting differences or correlations in 

terms of confidence levels. The levels shown on the P value interpretation chart are 

also analogous to legal standards of evidence used in court trials: Some ― a 

preponderance of evidence; Strong ― clear and convincing evidence; Very strong ― 

beyond a reasonable doubt.

In process development and improvement, we are concerned about false positives, but 

we should also be concerned about false negatives (i.e., concluding there is no 

difference or correlation when there really is). False negatives are missed 

opportunities. Allowing the “preponderance of evidence” standard in our decision-

making reduces the chance of missed opportunities when large sample sizes are not 

feasible (although performing a sample size calculation is always recommended). 

We’ll circle back to this topic in the Improve phase.

Notes on p-values, confidence, and false-positives
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543Displaying the data graphically using Box and Whisker Plots

1. Highlight the two columns 
for molding Machines A&B

2. Navigate to the Insert 
Ribbon and then the Charts 
section

3. Choose the Insert 
Statistics Chart dropdown 
and then the Box and 
Whisker plot

544Displaying the data graphically Using Box and Whisker Plots (cont’d)

• Edit legends, titles, etc. as desired.

• Rule of thumb – if the median line for one data set is outside of the box of the 
other data set, then the two samples are significantly different 

• If we wanted to reduce the overall variation in diameter, would we focus on within 
or between machine variation first?  What follow up action is needed here? 

“One picture is worth 1000 words.”
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545Anatomy of a Box and Whisker Plot

• Box and Whisker plots display data 

distributions based on Quartiles.

• The data is divided in four equal parts, 

with the Box drawn from Q1 (25%) to Q3 

(75%).

• The Median line is drawn at Q2 (50%).

• The Mean (aka Average) may also be 

marked (with a dot, x, etc.).

• The Inner Quartile Range (IQR) provides 

a robust measure of spread.

• The Min/Max Whiskers are drawn at the 

lowest/highest of the actual data points 

inside (1.5)IQR.

• Outliers are defined as data falling outside 

the range Q1 – (1.5)IQR and Q3 + 

(1.5)IQR.

IQR1.5 IQR

546Notes

545
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547

• During process observation, a suspicion was raised that the 
defect rate at ATE* had decreased in the last month. 

• Based on the data, it looks like this could be the case.

• But is it a statistically significant difference?

Process Sample size No. Failed % Defective

March 10760 2277 21.16

April 8748 1809 20.68

Significance testing:  example 2

Comparing samples with pass/fail Y

*from Data Sets \ ATE Mar & Apr

548

• Open Student Files  → calculator - chi square test 

• Fill out the 2 groups sheet as shown

Significance testing:  example 2 (cont’d)

P value

The probability that there is no difference between the populations.

The probability that that there is no difference in the defect rate between 

March and April. 

Note that the Group Labels can be changed Columns F-J are hidden
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549Interpreting P values - “Statistical Standard of Evidence”

None None

Some 85%  CL < 95%

Strong 95%  CL < 99%

Very Strong CL  99%

0.05  

0.15  

0.01  

1.00  

P
 v

al
u

e

Probability of NO 

difference or correlation

Level of evidence that samples ARE 

different or variables ARE correlated

Confidence level (CL)

for difference/correlation

& 

lower 

toward 

zero

550

• In this example for ATE defect rate, the P value is 0.4099

• There is no evidence of a difference between the samples 

• Based on this analysis, the team should not investigate differences 

based on month any further but should test other X variables for 

significant differences.

Significance testing:  example 2 (cont’d)
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551

If we reduce our billing lead time, will we get paid sooner?

1. Open Data 
Sets → 
significance 
testing 
examples

2. Highlight 
column B

Significance testing:  example 3

Correlating quantitative X and Y variables

3. Highlight column A while holding down the Shift key

4. Insert → Scatter plot

5. Right click on a data point → Add Trendline → Fill & Line (looks like a 
bucket) → Solid line → Dash type → Solid → Trendline Options (looks 
like a bar chart) → Display equation on chart 

6. See next slide

552Significance testing:  example 3 (cont’d)

7. Click on the graph, select Chart Tools → Design

8. Select Add Chart Element → Axis Titles → Primary Horizontal and 
Primary Vertical

• It looks like 
there may be a 
correlation, but 
appearances can 
be deceiving!

• We need to 
calculate the P 
value before we 
know for sure
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553

Data



Data Analysis



Regression



set up as shown



OK 

Significance testing:  example 3 (cont’d)

554

SUMMARY OUTPUT

Regression Statistics

Multiple R 0.6351

R Square 0.403352

Adjusted R Square0.105028

Standard Error0.365377

Observations 4

ANOVA

df SS MS F Significance F

Regression 1 0.1805 0.1805 1.35206 0.364900043

Residual 2 0.267 0.1335

Total 3 0.4475

CoefficientsStandard Error t Stat P-value Lower 95% Upper 95%Lower 95.0%Upper 95.0%

Intercept 58.85 0.447493 131.5104 5.78E-05 56.92459295 60.77541 56.92459 60.77541

Billing LT (days) 0.19 0.163401 1.162781 0.3649 -0.513059249 0.893059 -0.51306 0.893059

P value

The probability that there is no correlation between X and Y. 

The probability of no correlation between billing lead time and days in 

accounts receivable

Significance testing:  example 3 (cont’d)

For very very small numbers, Excel 
will default to Scientific Notation 
format. This P-value is actually 
0.0000578, or 5.78 x 10-5.

Excel uses “E-” to indicate a 
negative exponent, meaning the 
decimal point should be moved to 
the left.
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555

SUMMARY OUTPUT

Regression Statistics

Adjusted R Square 0.1050

Residual standard deviation 0.3654

Observations 4

ANOVA

df SS MS F P value

Regression 1 0.18 0.18 1.35 0.3649

Residual 2 0.27 0.13

Total 3 0.45

Interpreting P values (and other stuff) for correlation

• In this example, only 10.5% of the 

variation in Y is caused by variation in X

• This is one standard deviation of the data 

variation above and below the trend line

• The P value is 0.3649

• There is no evidence of a correlation between billing lead time and days in AR

• The trend line is of no use when there is no evidence of a correlation

556Exercise 27.2

Open Data Sets → DPPM vs dwell time. Is DPPM correlated with dwell time? 

a) Identify the data types for the X and Y variables, then perform the appropriate 

analysis.

b) Give the P value and its interpretation in terms of standards of evidence.

c) Create an appropriate chart to illustrate the analysis.

d) Describe an appropriate follow-up to this analysis.

e) Close and save the data set.

555
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557Exercise 27.3

Open Data Sets → number & size of defects. Is there a significant difference in 

Max size between welders A and B?

a) Identify the data types for the X and Y variables, then perform the appropriate 

analysis.

b) Give the P value and its interpretation in terms of standards of evidence.

c) Create an appropriate chart to illustrate the analysis.

d) Describe an appropriate follow-up to this analysis.

e) Save the data set and keep it open for the next exercise.

558Exercise 27.4

Open Data Sets → number & size of defects. Someone hypothesizes that Max size 

(the size of the largest weld repair area) depends on # Defects (the number of weld 

repair areas).

a) Identify the data types for the X and Y variables, then perform the appropriate 

analysis.

b) Give the P value and its interpretation in terms of standards of evidence.

c) Create an appropriate chart to illustrate the analysis.

d) Describe an appropriate follow-up to this analysis.

e) Close and save the data set.
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559

Open Data Sets → supplier comparison. This file contains data for raw material 

lots from suppliers A and B. Is there a significant difference between these 

suppliers?

a) Identify the data types for the X and Y variables, then perform the appropriate 

analysis.

b) Give the P value and its interpretation in terms of standards of evidence.

c) There is something in this data set that casts doubt on your conclusion in (b). 

Make a pivot table with Supplier as the Column Label, Inspector as the Row 

label, and Result in the Values area. What is the potential issue?

d) Close and save the data set.

Exercise 27.5

560Exercise 27.6

Open Data Sets → computer chips. Is Y correlated with X? 

a) Identify the data types for the X and Y variables, then perform the appropriate 

analysis.

b) Give the P value and its interpretation in terms of standards of evidence.

c) Create an appropriate chart to illustrate the analysis.

d) Describe an appropriate follow-up to this analysis.

e) Close and save the data set.
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561

Open Student Files → Case Studies → quotation process 
→ unstacked quotation process current state

We want to test for significant differences among the 
business units (BUs) with respect to turnaround time (TAT)

28  Stratification Analysis ⎯ Quantitative Y

First, the data needs to be reorganized into the format required 
for ANOVA.

FYI:  this file has been sorted by Initial RFQ (Request for Quote) 
and Quote Num

562Stratification with quantitative Y (cont’d)

1. Click on tab “TAT by BU” to find this worksheet of reorganized data. (For 
your reference, instructions for creating this worksheet can be found at the 
end of this section.)

2. Go to the next slide
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563Stratification with quantitative Y (cont’d)

3. Go to the Data ribbon, select Data Analysis, select Anova: Single Factor

4. Fill out as shown here, click OK

5. Go to the next slide

564Stratification with quantitative Y (cont’d)

6. Here is the unedited default output

7. Go to the next slide for the cleaned-up output

For very very small numbers, Excel will default to 
Scientific Notation format. This P-value is actually 
0.000000783, or 7.83 x 10-7.

Excel uses “E-” to indicate a negative exponent, meaning 
the decimal point should be moved to the left.
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565

8. Very strong evidence of differences among the five BUs with respect to TAT

9. See next slide for a column chart of the averages

Stratification with quantitative Y (cont’d)

566

10. BUs 3 and 7 represent best practice.  Follow up: find out what they are 
doing and make it the standard for all BUs. 

11. Close and save your workbook .

Stratification with quantitative Y (cont’d)

0.0

0.5

1.0

1.5

2.0

2.5

3.0

3.5

4.0

BU 3 BU 5 BU 6 BU 7 BU 8

Average TAT by BU
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567

Open Data Sets → alignment process. Three alignment tools of the same type are used 

to attach orifice plates to chips. We want to know if there are significant differences 

among the three tools in terms of radial alignment error R dev. 

(a) Test for significant differences in average R dev among the 3 aligners. (Data is 

arranged for ANOVA under tab R dev by Aligner.) Give the P value and its 

interpretation in terms of standards of evidence.

(b) Smaller R dev is better. Which aligner represents best practice? Describe the 

appropriate follow up action.

(c) Close and save the data set.

Exercise 28.1

568

Open Data Sets → casting dimensions. Metal parts are cast from wax patterns molded 

on machines A or B. We want to know if there is a significant difference in average 

casting dimensions depending on which machine molded the pattern. 

a) Test for a significant difference in average length between machines A and B. 

Give the P value and its interpretation in terms of standards of evidence.

b) The target value for length is 600. Which machine is closer to target?

Exercise 28.2
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569

c) Test for a significant difference in average diam between machines A and B. Give 

the P value and its interpretation in terms of standards of evidence.

d) The target value for diam is 50. Which machine is closer to target?

e) Describe an appropriate follow up action.

f) Close and save the data set.

Exercise 28.2 (cont’d)

570Example: Unstacking Data using Filtering

For reference only:

1. Highlight BU column

2. Select the Data ribbon

3. Select Filter

4. Go to the next slide
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571Example: Unstacking Data using Filtering (cont’d)

For reference only:

5. Highlight the TAT column (H)

6. Click on the arrowhead next to the 
BU header in column C

7. Deselect all but BU 3 → OK

8. Right click on the TAT column 

9. Select Copy

10. Go to the next slide

572Example: Unstacking Data using Filtering (cont’d)

For reference only:

11. Create  a blank worksheet, Paste in cell A1

12. Change the header in cell A1 as shown below

13. Repeat steps 7 through 12 
for BUs 5, 6, 7, and 8
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57329  Stratification Analysis ⎯ Pass/Fail Y

Open Student Files → Case Studies → quotation process 
→ quotation process current state

We want to test for significant differences among the business units 
(BUs) with respect to PO hit rate

574Stratification with pass/fail Y (cont’d)

1. Highlight all columns

2. Insert → PivotTable 
→ OK

3. Drag/drop BU to the 
Rows area

4. Drag/drop PO to the 
Columns area

5. Drag/drop PO to the 
Values area

6. Go to the next slide
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575Stratification with pass/fail Y (cont’d)

7. Click on the arrowhead next to 
Row Labels (or Column Labels)

8. Uncheck (blank) → OK

9. Go to the next slide

576

10. Open Student Files → calculator - chi square test

11. Select the 5 groups sheet, select and copy the cell range shown below

Stratification with pass/fail Y (cont’d)

12. Go to the worksheet containing your pivot table

13. Go to the next slide
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577Stratification with pass/fail Y (cont’d)

14. Paste in cell E3

15. The P value is 0.9192.  There is no evidence of differences among the BUs 
with respect to PO hit rate. 

16. Note: for this calculator to work, your pivot table has to contain raw counts, 
not percentages  of row totals.

17. Close and save your workbook.

578

Open Data Sets → ATE Mar & Apr. 

a) Test for significant differences in the Fail Result (aka % Defective) among the 

four test stations. Give the P value and its interpretation in terms of standards of 

evidence. 

b) Based on the Fail Result for each test station, which pairs of stations appear to be 

statistically similar? Which pairs appear to be statistically different? Describe an 

appropriate follow up action.

c) Test for a significant difference between the two part numbers (P/N). Give the P 

value and its interpretation in terms of standards of evidence. Describe an 

appropriate follow up action.

d) Close and save the data set.

Exercise 29.1
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579

Open Data Sets → out of box failures. This file has tabulated pass/fail data of a 

customer’s incoming inspection of purchased components. Set up your pivot table as 

shown on the next slide, then enter the values into the appropriate cells in calculator – 

chi square test. (Pasting from the calculator to the pivot table won’t work in this 

case because we’re using sums.)

a) Compare processes A, B, and C in terms of % failing. Give the P value and its 

interpretation in terms of standards of evidence. 

b) Is there a significant difference between processes B and C? Give the P value and 

its interpretation in terms of standards of evidence. Describe an appropriate follow 

up action.

c) Close and save the data set.

Exercise 29.2 (Read all instructions carefully!)

580Exercise 29.2 (cont’d)
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581

Open Student Files → Case Studies → MBDP→ unstacked MBDP current state. In 

your group, perform the stratification tests indicated in the table on the next slide:

a) Determine the type of Y data (PO-PD and MFG happy)

b) Determine the type of analysis for each. Find examples to follow.

c) Do the first one, the Sales row, together. Make sure everyone in the group knows 

how to do the analysis for the two types of data.

d) Assign one of the remaining rows to each group member. 

e) Each group member performs the analysis on their row. (The fastest in the group 

can help others or pick up one more row, as needed.)

f) If there is a significant difference (P  0.15), identify the process participant with 

best practice.

g) Share results, so each person has a completed table of results.

h) Discuss the results. Where would you focus your efforts to make improvements?

Exercise 29.3 --Small group exercise

582

Avg. PO-PD
(P value)

Best practice
(Who)

% MFG           
(P value)

Best practice
(Who)

X’s

Sales

PE

ME

QE

Drafter

Proto

oper.

Baseline 

values:
29.5 days 49.4%

Exercise 29.3 --Small group exercise (cont.)
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30  Root Cause Analysis

584

We’ll discuss tools and techniques to use in conjunction with 

data analysis for identifying root causes:

• Failure Modes and Effects Analysis (FMEA)

• Multi-level Pareto Analysis

• Five Whys  

• Five Whys/Cause and Effect Diagram based on Y = f 

(X) 

Topics
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585Tools used in Root Cause Analysis

Usually we identify 

problems while mapping 

and observing the 

current state during the 

Measure phase

(aka opportunities for 

improvement)

586Tools used in Root Cause Analysis (cont.)

Analyses such as Cause & Effect diagrams, Pareto Charts and Testing 

for Statistical Significance point us in the direction of the root causes 

or critical x’s

But, we usually need to dig deeper . . .
p < 0.05?

585
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587Failure Modes and Effects Analysis (FMEA)

FMEA can be used in the Analyze Phase to prioritize X’s

• It is helpful at the beginning of the Analyze Phase:

o to identify the X variables that are likely to have a significant impact on the primary metric Y, 

and to remove from consideration those that are deemed trivial

o data collection and analysis are required for verification of prioritized failure modes, to validate 

their significant impact on Y, as FMEA is an opinion-based tool

• Actions for remedying failure modes with high RPNs are not discussed or taken in Analyze

• We will learn about FMEA in the Improve Phase, where it is used to evaluate risk and 

prevent problems before they occur in the proposed process, its original application.

Process Functions Requirements Failure Modes Effects SEV Causes OCC CN

Current 

Controls DET RPN Actions Planned Responsible Due Date

Actions 

Taken

Reagent lot creation

New lot information 

distributed to OPS 

team

Printer malfunction
Delay in distribution to 

the OPS team
1 Electrical 1 1 One printer 1 1

Reagent creation

New reagent created 

based on processing 

demand

Operator error 

during manufacture 

of reagent

Processing delay, 

wasted sub-reagents, 

time lost, labor money

5
Did not use trained 

witness
1 5

SOP requires 

trained witness 

for procedure

1 5

Reagent storage

Storage of new 

reagent at point of 

use (laboratory)

Insufficent storage 

space in freezer or 

fridge

Reagent stock-out 4
Freezer space not 

reconciled
5 20 No control. 5 100

Insufficient shelf 

space for materials.
Material stock-out 3

Too many items on 

shelving
3 9

Shelving units 

with four 

shelves

5 45

Staff is unclear 

where material 

items should be 

stored

Materials not stocked in 

designated location 

within the functional 

area

2

Insufficent labeling 

system to designate 

material and reagent 

locations 

3 6
Labels on 

shelving only
3 18

Material Distribution

Distribution of 

materials based on 

MIN/MAX 

forecasting 

MIN/MAX values 

not accurate
Material shortage 2

Forecasting not 

accurate
3 6

Master Science 

Forecasting
5 30

Material storage

Stocking of materials 

and reagents in 

designated location 

within the functional 

laboratory

588Multi-Level Pareto Analysis

We can drill down to root causes using a series of Pareto Charts

• From a first-level Pareto Chart, we can see which categories are contributing the 

most to our problem

• It’s helpful to analyze the same categories based on Frequency, Cost &/or Time; 

using at least two is recommended

First-Level Pareto

587
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589Second-Level Pareto Chart

The highest bar(s) from the first-level Pareto can be broken 

down further into a second-level Pareto Chart:

Second-Level Pareto Chart

Reasons for Flight Delays

590Multi-Level Pareto Analysis (cont.)

By continuing to drill down, we can determine root causes of most frequently occurring 

defects.

Third-Level Pareto

First-Level Pareto

Sub-causes

Second-Level Pareto

Sub-causes

When data is not available for multi-level Pareto analysis, use the first-level Pareto 

Chart with 5 Whys to determine root causes.

589
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591Example 2: Multi-Level Pareto Analysis

Lead time by high-level process step is measured:

Sub-causes

First-Level Pareto

Second-Level Pareto

5925 Whys

• We work our way back to root causes by asking “why” questions

Cause

Cause

CauseCause

Cause

Cause

• This process is called “5 whys” because it usually takes no more than 

5 questions

• The goal of 5 Whys is to get to a deep, actionable cause.

591
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593Getting to root cause with Five Whys

“The number of accidents in the plant was way up last month” 

Do you know what caused the increase?
Workers are slipping and falling in Aisle 7 
next to the molding machine. 

Why are workers slipping and falling? There’s a puddle of water on the floor.

Where did the water on the floor come from? It’s dripping from the ceiling.

What caused it to start dripping from the 

ceiling?
A pane of glass is broken in the skylight.

How did the glass get broken?
A tree branch broke the glass during a 
storm.

How did the tree branch manage to hit the 

skylight?

The tree it came from was close to the 
building.

594

• Your instructor will now lead you through a verbal 
exercise to practice the Five Whys technique.

• The instructor will make the opening statements and 
answer the questions.

• Class members will ask the questions.

• The instructor will indicate which class member is to ask 
the next question.

Please close your workbook now! 

Exercise 30.1: Five Whys

593
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595Exercise 30.1: Five Whys (cont’d) “There’s too much scrap in the Coiling Department”

What kinds of defects are causing the scrap? The vast majority are due to bad welds.

Why do we have so many bad welds? The welders aren’t very good. 

Why aren’t they very good?
Well, they’re hired off the street, and they 
don’t get much training. 

You don’t hire certified welders?
Are you kidding? We would have to pay them 
too much.

In that case, why aren’t your welders given 

more training?

I don’t know. I guess there isn’t enough time. 
This is the way we’ve always done it.

Don’t they get better as they become more 

experienced?

Well yeah, but they don’t stay in this 
department long enough for that to help.

596Exercise 30.1: Five Whys (cont’d) “There’s too much scrap in the Coiling Department”

Why do they leave this department so soon?
There’s another department where welders 
are used. As soon as there’s an opening over 
there, everybody here applies for it.

Why are they so eager to work in the other 

department?

For one thing, the working conditions over 
there are much better. We have the highest 
accident rate in the company.

Is there another reason?
Over there they pay a dollar an hour more 
than here. 
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597“I was late for work today.”

Why were you late for work today? I overslept.

Why did you oversleep? My alarm didn’t go off.

Why didn’t your alarm go off? The power went out last night.

Why did the power go out last night? There was a thunderstorm.

What is wrong with this 5 Whys path?

If you get to a non-actionable root cause, back 
up and try to find a different path to an answer.

598Five Whys based on Y = f (X) analysis

Cause

Cause

CauseCause

Cause

Cause

• Data analysis provides the basis for penetrating questions

• After we have completed our Y = f (X) analyses, we should interview 

process participants again to determine the causes of significant 

comparisons or correlations.

• 5 Whys and Cause and Effect (Fishbone) Diagrams are helpful 

“interviewing” tools.
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599Want to reduce external failures

Q “There is a significant correlation between dwell time and DPPM. What 

causes the variation in dwell time?”

A “The dwell time stretches out when operators are called away to do other 

things while they’re getting ready to mold parts.”

Q “Isn’t there an upper spec on the dwell time?”

A “Yes. The operators are supposed to purge the tank if the dwell time gets 

too long, but they don’t always do that.”

Q . . . 

Whenever we can collect data to verify the root cause found through 5 Whys, 

that should be done.

600Want to reduce turnaround time 

Q “The turnaround time is significantly longer for some account managers 

than for others. What do you think causes that?”

A “They don’t all use the same quotation preparation process.”

Q “Why not?”

A “There is no standard process. They have all developed their own way of 

doing it.”

Q . . . 

Whenever observation can verify the root cause found through 5 Whys, that 

should be done

599
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601Want to reduce turnaround time (cont’d)

Q “The turnaround time is significantly longer for some business units than 

for others. What do you think causes that?”

A “Some of the business units aren’t using the automated configuration tool.”

Q “Why not?”

A . . . 

Whenever observation or data collection can verify the root cause found 

through 5 Whys, that should be done.

602Want to improve internal customer satisfaction

Q “The tool development process often results in slow line speeds and 

overweight material. What causes that?” 

A “The testers slow the line down and increase the weight to get the 

dimensions on target.”

Q “Why do they use weight and line speed instead of other variables?”

A “They’re usually in a hurry. They’ve discovered that manipulating weight 

and line speed is the fastest way.”

Q  . . . 

Whenever observation or data collection can verify the root cause found 

through 5 Whys, that should be done.
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603Cause & Effect diagram revisited

It is important to note that Cause and Effect diagramming is a team 

process. Getting ideas from a variety of people involved in the process 

will be more effective than if one person tried to think of all the 

possibilities.

• This tool uses brainstorming, so remember to frame an open 

question and use clear ground rules.

• A good technique is to have people write ideas on sticky notes first 

(one idea per note), then place the notes under the appropriate 

heading.

• A facilitator should have some good prompts handy to help catalyze 

ideas.

604Cause & Effect Diagram — Questions

The Materials category groups root causes related to parts, supplies, forms or 

information needed to execute a process:

Examples of questions to ask: 

• Are bills of material current? 

• Are parts or supplies obsolete?

• Are there defects in the materials?

Examples of questions to ask: 

• Is the process adequately planned/designed?

• Are procedures correct, adequate, followed?

• Are checks in place?

• What might be an unusual situation? 

The Method category groups root causes related to how the work is done, the way 

the process is actually conducted: 

Effect

Method

Effect

Materials

603

604



Copyright © 2025  ETI Group

605Cause & Effect Diagram — Questions

The Machine category groups root causes related to tools used in the process:

Examples of questions to ask: 

• Have machines been serviced/changed recently? 

• Have equipment/tools been properly 

maintained?

• Are proper equipment/tools available?

• Is there machine to machine variation?

The Environment (a.k.a. Mother Nature) category groups root causes related to our work 

environment, market conditions, and regulatory issues.

Examples of questions to ask: 

• Are there impacts from physical factors 

(temperature, humidity, lighting, particles, etc.)?

• Is the workplace safe and comfortable? 

• Are outside regulations a factor?

• Does the company culture aid the process?

Effect

Machine

Effect

Mother Nature

606Cause & Effect Diagram — Questions

The Measurement category groups causes related to the measurement and 

measuring of a process activity or output:

Examples of questions to ask: 

• Is there an appropriate measurement?

• Is there a valid measurement system? 

• Is the data accurate &/or precise enough?

• Is data readily available?

The Members category groups root causes related to people, staffing, and 

organizations:

Effect

Measurement

Effect

Members
Examples of questions to ask: 

•  Are people trained properly, do they have 

the right skills and mental/physical capabilities?

• Is there person to person variation?

• Are people over–worked, stressed, etc.?

• Are short-cuts/noncompliance tolerated by management?
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607What if People are the Cause?

When considering variation from “Members,” we have to dig deeper 
than a simple root cause of “operator error.”

• A symptomatic “fix” of retraining a single operator won’t 
necessarily prevent another person from making the same error.

• Training may not be an effective solution if the process itself is 
poorly designed, not documented, ineffective, etc.

608Considering Human Factors

Studying human factors will be helpful in situations where the initial 
cause appears to be a person’s behavior.

The FAA describes a simple method for categorizing human factor 
errors into two types:

• A Mistake happens when a person takes an action on purpose 
that is misguided or wrong, possibly due to an incorrect 
assumption, lack of understanding, misinterpretation, etc. 

• A Slip is when a person plans to do one thing, but inadvertently 
does something else due to forgetfulness, confusion, time 
pressure, fatigue, etc.         

Based on the Federal Aviation Administration’s “Dirty Dozen”    

https://www.faasafety.gov/files/gslac/library/documents/2012/Nov/71574/DirtyDozenWeb3.pdf

607
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60912 Common Causes of Human Factors Errors

1. Lack of 

Communication

Failure to transmit, receive, or provide sufficient feedback in order 

to complete a task. 

2. Lack of knowledge Failure to have training, information, &/or ability to conduct a task.

3. Lack of teamwork Failure to work together to complete a shared goal.

4. Lack of Resources Not having enough people, equipment, information, 

documentation, time, parts, materials, supplies, etc., to complete a 

task.

5. Lack of Assertiveness Failure to speak up or otherwise document concerns about 

instructions/orders or actions of others. 

6. Lack of awareness Failure to recognize a situation, understand what it is, and predict 

the possible results.

Mistakes are often due to a lack of something:

610

7. Complacency Overconfidence from repeated experience on a specific activity.

8. Distractions Anything that draws attention away from the task at hand; can be 

events or surrounding conditions.

9. Fatigue Physical or mental exhaustion that threatens work performance. 

10. Pressure External or internal forces demanding high-level job performance; 

can be real or perceived.

11. Stress Physical, emotional or chemical factor that causes physical or 

mental tension.

12. Norms Expected, yet unwritten, rules of behavior.

Slips are often due to the presence of something; often too much of it:

12 Common Causes of Human Factors Errors
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611Identifying root causes

At the conclusion of the Analyze Phase, the team must list those specific root 

causes or critical x’s to be acted upon during the Improve Phase

• Review the analyses completed to:

✓ determine those critical x’s and root causes that have been validated 

as significant contributors to unsatisfactory performance in the 

primary metric 

✓ list those that are no longer under consideration

• The team should show the analyses that support their decision on which 

opportunities to address in the Improve Phase

612Notes
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31  Developing and Prioritizing Solutions

614Topics

• Developing solutions

• Solution categories

• Mitigation for Human Factors Errors

• Prioritizing solutions
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615

Solutions come from many sources

Best practices
revealed by

stratification 

Best practices
from 

benchmarking

Developing solutions

Observations 
and interviews

Obvious once the root
cause is found

Brainstorming 
on accumulated 

information

Lean solutions
Design of 

Experiments
?

616Developing solutions (cont’d)

Improvement ideas can come from many sources. Some ideas will contribute more to 

the success of the future state than others. The greater the number of ideas, the greater 

the probability of discovering successful solutions. The team should generate as many 

improvement ideas as possible. 

The nature of this process is that the initial list gets shorter. Some ideas are discarded 

along the way, others are retained intact, still others are modified or combined. This 

process leads to a future state that is likely to be best available within the constraints of 

the project.

615
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617Common solution categories

• Technology upgrades 

• Lean solutions (we’ll learn more about these in the 

next section of the course)

• Standardization

• Modification of procedures

• Optimization of processes or products (DOE) 

• “Just do it” solutions that haven’t yet been 

implemented

618Solution categories (cont’d)

LSS projects address problems for which solutions are not known. Nevertheless, there 

are commonly occurring categories. 

A common example of technology upgrade would be switching to a better 

measurement system. 

We don’t need a LSS project to tell us that Lean is good. But what if the organization 

lacks consensus on the benefits of these methods? A high priority LSS project that 

makes significant improvements by applying Lean solutions could help the 

organization recognize the value of Lean across the board.

The same applies for “just do it” solutions. Everyone knows what needs to be done, 

but it isn’t getting done. A LSS project identifying and quantifying the need for the 

“just do it” solution might get some high level attention, cut through the lethargy, and 

stimulate action on the issue.

617
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619Mitigation for Human Factors Errors — Mistakes

1. Lack of 

Communication

• Never assume anything. 

• Improve communication: only 30% of verbal communication is 

remembered — usually the first and last part. Say the most important 

things at the beginning and repeat at the end. 

• Document instructions.

2. Lack of knowledge • Don’t guess or assume, ask when you don’t know.

• Use current documentation.

• Access training/sources for knowledge.

3. Lack of teamwork • Build a solid team; develop trust in the team.

• Discuss how a task should be done.

• Make sure everyone understands and agrees on tasks/commitments.

4. Lack of Resources • Plan for resource needs, including sharing or pooling resources.

• Identify  and mitigate resource constraints.

5. Lack of Assertiveness • Put safety first.

• Express feelings, opinions, beliefs and needs in a positive, productive 

manner (offer positive solutions, resolve one issue at a time).

6. Lack of awareness • See the whole picture: see dependencies and relationships between 

processes and systems.

• Fully understand the procedure(s) to be used.

620Mitigation for Human Factors Errors — Slips

7. Complacency • Expect to make/find errors. 

• Learn from the mistakes of others.

• Use checklists/documentation.

• Don’t sign/check-off if you didn’t/haven’t yet done it.

8. Distractions • Get back in the groove after a distraction/interruption.

• Use checklists/documentation.

• Go back 3 steps when restarting a task.

9. Fatigue • Watch for symptoms of fatigue in yourself and others.

• Use buddy checks.

10. Pressure • Put safety first.

• Communicate concerns.

• Ask for extra help.

11. Stress • Use rational problem-solving approaches.

• Take a short break when needed.

• Discuss the problem with someone who can help.

12. Norms • Put safety first.

• “We’ve always done it that way” doesn’t make it right.

• Identify and eliminate negative norms.

619
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621Prioritizing solutions

• Uses the impact/feasibility method ― same as prioritizing 

projects

• Defines “impact” as addressing the root causes identified by 

the project team

• Gives the organization a basis for making sound decisions in 

light of project findings

✓Opportunity to expedite implementation of solutions with 
high impact or high feasibility

✓Opportunity to postpone implementation of solutions with 
low impact and low feasibility

622Instructions for prioritizing solutions

1. Open Student Files → blank C&E matrix - impact & feasibility.

2. In the Metrics sheet, change Impact metrics to Root causes.

3. List your prioritized root causes and relative weights (overall rankings).

4. List your feasibility metrics and relative weights.

5. Go to the Impact ratings sheet, change Items to be ranked to Solutions.

6. List the solutions you wish to rank.

7. Rate each solution for impact on each root cause (H, M, L).

8. Go to the Feasibility ratings sheet, rate each solution for each feasibility 

metric (H, M, L).

9. Go to the sheet Impact - feasibility plot to evaluate the results.

621
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623Student Files → prioritizing solutions - exercise

Root causes of Long Lead Time

Root causes 
determined in
Analyze Phase.

Weights indicate 
relative impact of 
cause on project 

metric

These are common
feasibility metrics,
but you can define 

the metrics and 
weights to suit your 

own situation.

Metrics

sheet

ATE = Automated Test Equipment

624Prioritizing solutions (cont’d)

Impact

ratings

sheet 
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625Prioritizing solutions (cont’d)

Feasibility

ratings

sheet

626Prioritizing solutions (cont’d)

Impact-feasibility plot
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627Exercise 31.1

Open Student Files → prioritizing solutions - exercise. 

Use the root causes and solution ideas as provided. Note that the first row of each 

sheet is frozen for ease of use during ranking.

Use your knowledge and experience to complete the following tasks:

a) Change the relative weights for the feasibility metrics as you see fit.

b) Fill out the Impact ratings sheet using H, M, L or blank.

c) Fill out the Feasibility ratings sheet using H, M, or L.

d) Use your impact-feasibility plot to decide which solution ideas should be 

implemented sooner, which should be implemented later, and perhaps, which 

should not be implemented.

628Notes
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32  Lean Solutions

630Commonly used Lean solutions

5S

Stop & fix

Pull systems

Standardization

Mistake proofing

Reduce batch sizes

Value stream teams

Visual management

Changeover reduction (SMED)

Work balancing (leveling)

.

.

.
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631

D Defects: Failure to meet expected standards of quality or delivery

O Over production: Making or doing more than is needed at the time

W Waiting: People waiting to work, or things waiting to be worked on

N
Not utilizing creativity: Failure to integrate improvement cycles into the 

daily work of all employees

T Transportation: People or things being moved from one place to another

I
Inventory: Storing supplies, WIP, or finished goods beyond what is 

needed

M Motion: Excessive motion in the completion of work activities

E
Extra processing: Producing or delivering to a higher standard than is 

required

Categories of NVA

632The 5S Vision

A Workplace that is:

• Clean, organized, orderly

• Safe

• Efficient and pleasant

• The foundation for all other 
improvement activities

Resulting In:

• Fewer accidents

• Improved efficiency

• Improved quality

• Workplace control

And therefore:

• Reduced waste

• Reduced cost
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6335S

• Sort – Sort through and Sort out

• Keep what is needed – Eliminate what is not

• Reduce quantity of items to what is needed

• Set in Order – A place for everything and everything in its place

• Identify best location and relocate out-of-place items

• Make locations visually identified – easy to see missing items

• Set height, quantity, and size limits

• Organize for safety

• Shine – Shine and Inspect through cleaning

• Filthy work environments lead to poor morale

• Spills and debris are safety hazards

• Its easier to identify a maintenance need on clean equipment

• Standardize

• Build the framework for maintaining Sort, Set in Order, and Shine

• Clarity about what is and is not normal with simple action plans

• Sustain

• Incorporate 5S into the daily work cycle

634Pull systems for supply replenishment

• Material usage should be first-in-first-out (FIFO)

• Supply orders are triggered by kanbans (cards, 

empty bins, or other signals)

• The objective is to minimize stock-outs without 

keeping excessive supply quantities on hand 
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635

• The maximum quantity should represent a desired upper bound for supply 

quantity on hand

Kanban card for supply items

Item Name ________________________

Max. Quantity __________

Min.  Quantity __________

Re-order Qty. __________    (Max – Min)

Vendor ___________________________

Catalog Pg. No. ________

• An order is triggered when the 

minimum quantity is reached*

• A kanban card goes with the order, 

returns with the delivery

• The minimum quantity should 

represent what is needed to span 

the delivery cycle time 

*What can cause this system to fail?

636Example:  two-bin kanban system

• Two bins for each item (see next slide)

• Amount in each bin  =  min. quantity  =  order quantity

• Order when top bin is empty, move bottom bin to top

• Visual system, easy to use

• The max and min quantities can be determined by trial and 

error

• If usage data is available, there is a better way
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637Two-bin system (cont’d)

638Using data to set max/min values

• Required inputs

✓ Time basis for usage data (hourly, each shift, daily, weekly, . . .)

✓ Average usage per time period

✓ Standard deviation of usage per time period

✓ Minimum order quantity

✓ Min. value (number of orders)

✓ Max. value (number of orders)

• Values calculated in the simulation

✓ Starting quantity for each period

✓ Quantity received during each period

✓ Quantity used during each period

✓ Ending quantity for each period

✓ Quantity ordered during each period

637
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639Setting max/min values (cont’d)

Data Sets → usage of disposable gloves

Average  = 63.9

Std. dev.  = 17.2

640Setting max/min values (cont’d)

Student Files → kanban setup
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641Setting max/min values (cont’d)

Student Files → kanban setup - weekdays only

642Examples of mistake-proofing (Poke Yoke)

• Designing connecting cables and ports so that a cable cannot be 

plugged into the wrong port

• Programming software so that the user cannot proceed unless 

necessary information is filled in

• Auto fill of previously entered information on electronic forms 

• Pull down menus in computer programs ― especially for data entry

• Using feedback control systems and alarms on equipment 

• Fixturing to prevent incorrect placement and hold things in place

641

642



Copyright © 2025  ETI Group

643Reduce batch sizes (keep the work moving)

Don’t do things in batches.

The ideal is to do one thing at a time.

Come as close to this as you can.

• Wait a minute ― batching is supposed to be “efficient”

• Maybe, but here are some problems with batching: 

✓A customer who wants just one item has to wait for a whole batch to 

be completed

✓ Reduces flexibility in building different products.

✓ Items accumulate until the batch quantity is reached ⎯ wastes 

    space, creates opportunities for defects

644Reduce batch sizes (cont’d)

Of course, there can be a legitimate problem with reducing batch sizes:  it increases 

the number of changeovers.

Fortunately, this is a problem for which Lean has excellent solutions. Lean projects 

have reduced changeover times by 80% or more. 

✓ Shigeo Shingo pioneered the Single Minute Exchange of Die (SMED) 

methodology

643
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645Current state:  daily batching

Lead time  =  24 hours (3 days)

3 operations
2 hours per transaction per operation

646Future state:  continuous flow 

Lead time  =  6 hours (less than one day)

3 operations
2 hours per transaction per operation

645
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647Organizing by departments

• Departmental boundaries create “silos”

• Often, no single entity has overall responsibility for customer 

satisfaction

• Vestige of industrial revolution ⎯ need for specialization

• Hand offs between silos are opportunities for poor 

communication and lack of coordination
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648Organizing by value stream
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Customer value stream

• Customer value stream spans all silos 

"We want to not only show respect to our people, the same way we want to show 

respect to everyone we meet in life, we also want to respect their humanity, what it 

is that makes us human, which is our ability to think and feel – we have to respect 

that humanity in the way we design the work, so that the work enables their very 

human characteristics to flourish." 

— Fuji Cho, as quoted in John Shook’s “Managing to Learn”

Mr. Fuji Cho has held many leadership positions at Toyota,  including President and is currently an 

Honorary Chairman of the company. He was explaining in this quote why they did not call their 

operating philosophy the “Toyota Production Method” but the "Respect for Humanity" system.
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649Organizing by value stream (cont’d)
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Cross-functional work group

• Responsible for entire value stream for a product/service “family” 

• Physical co−location is ideal (work cells)

▪  Alternative:  “value stream team” 

• Stand-up meetings: every day, shift, or other frequent interval

▪  Alternative:  virtual meetings

650Notes
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651Manufacturing operation in silos

• 18 workers, no cross training

• Minimal communication between silos

• Each silo handles all products

• Silos produce as much as possible, all the time (push system)

• WIP moves between silos in large batches → long lead time

PressLatheHeat

treat

Saw Deburr

Saw Saw

Saw

Lathe Lathe

Lathe

Deburr

Deburr Deburr

Press

Press Press

Finishing

652Manufacturing operation in U-shaped work cells*

• Each cell handles all operations for one product family, and produces just 

what is needed to meet current demand (pull system)

• Continuous flow → minimal WIP → short lead time

• Rapid response to workflow or quality problems

• 16 workers instead of 18 ― what happened to the other 2?

Exit Finish

Enter

Press

Heat

treat

DeburrLatheSaw

One of 4 cells
“Right size”

equipment for
each cell

Lathe

*Physical co-location is not always possible in process industries, where equipment 
determines capacity and is difficult or impossible to relocate. See Lean for the Process 
Industries by Peter King for ideas on how to apply Lean in this situation.
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653Transactional process in silos

• 16 workers (    ), no cross training 

• Each silo handles all transactions

• Minimal communication between silos

• Lots of do overs (not shown in diagram)

• Lots of WIP → long turnaround time

Initial contact Configuration Scheduling

Procurement

Request for quote Order processing

Drawing

1

2
3

4

6

7

8

5

654Transactional process in U-shaped work cells

• Each cell handles all steps for one transaction family

• Continuous flow → minimal WIP→ short turnaround time 

• Rapid response to errors or workflow problems 

• 15 workers instead of 16 ― what happened to the other one?

Initial 

contact

Request

for quote

Order 

processing
Configuration

Drawing
Request

for quote
ProcurementSchedulingExit

Enter

One of 3 cells
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655

Available Working 

Time (AWT)

• The time a process is available to conduct work

• AWT excludes time when work isn’t occurring such as time 

for breaks, meetings, lunch, preventative maintenance, 

estimates of unplanned downtime, change overs, etc.

Throughput (Tput)

• The average number of good parts or transactions completed 

over a period of time

• Typically measured as average over at least several days

• Throughput, lead time, and inventory are related through 

Little’s Law

Definitions

656

Lead time (LT)

• The total elapsed time to produce one defect free product or 

transaction

• The time difference between when a part or transaction 

enters and leaves a process

Customer 

Demand Rate 

(CDR)

• The number of parts or transactions that the customer 

desires over a period of time (usually a day, week, or month)

Definitions (cont’d)

655
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657

Takt time (TT)

• The pace at which an operation should complete products or 

transactions in order to meet customer demand during the 

Available Working Time.

• Available working time during a period divided by the 

number of products or transactions required during that same 

period

Cycle time (CT)

• The fastest repeatable time between part or transaction 

completions using the current processes and resources

• Shows how a process is capable of performing

• Combines with AWT to determine capacity

Definitions (cont’d)

658

Process Cycle 

Efficiency (PCE)

• The percentage of time that WIP is being transformed by VA 

activities.  In other words, the percentage of lead time that is 

value added.

Work In Progress 

(WIP)

• Includes items waiting to be worked on and items actively 

being worked on. WIP includes all of the inventory in the 

production system.

Definitions (cont’d)
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659Work balancing

Minutes

0

2

4

6

8

10

Op A

(Bob)

Op B

(Carol)

Op C

(Ted)

Op D

(Alice)

Op E

(Larry)

• Cycle time for the process

•  Takt time

StarvedBlocked

• Cycle time for a process  = cycle time for the slowest operation

• This process is unable to meet the customer’s needs

Cycle time for each 
operation

660Work balancing (cont’d)

• Operation A can complete 1 part every 2.2 minutes, operation B can 

complete 1 part every 9 minutes 

• If A runs at full capacity, its output will pile up in front of B

• Common example of waste:  overproduction

• Operations C, D, and E can produce faster than B, but their capacity cannot 

be utilized

• They can complete parts only as fast as B supplies them

▪ Cycle time for C, D, and E is 9 minutes

▪ Cycle time for the process is 9 minutes

659
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661Improving work balance by adding resources

• Add a second resource (Moe) to operation B

• Together, Carol and Moe can complete 2 parts or transactions 

every 9 minutes

• New cycle time for operation B is 9 ÷ 2 = 4.5 mins (see next 

slide)

• New cycle time for the process is 5.8 mins (cycle time for 

operation D)

662Effect of multiple resources on cycle time

• Remember: the lead time is the time interval between units 

leaving a process.

• If a resource processes only one unit at a time, then the cycle 

time for that resource equals the lead time.

• Suppose the cycle time for one resource (machine or person) 

is 6 minutes and 4 workers (or machines) perform this task.

• Collectively, they can complete 4 parts or transactions every 

6 minutes

• Their cycle time is:  

(6 mins) / (4 parts or transactions)  =  1.5 mins

• Similarly, if a machine processes a batch of 4 parts every 6 

minutes, the cycle time is 1.5 minutes.
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663Effect of multiple resources on cycle time (cont’d)

• For a conveyorized process, the cycle time is the time interval between 

units exiting the conveyor.

• Imagine a conveyorized wash process that runs at a speed such that parts 

are washed for 6 minutes.  Given its length and conveyor speed, a part 

exits the machine every 1.5 minutes.  Its cycle time is 1.5 minutes.

• If there were two identical wash processes in a production line, their 

combined cycle time would be 1.5/2 = 0.75 minutes = 45 sec.

664Multiple resources (cont’d)

• In general:

Cycle time of multiple resources  =  (Cycle time of one resource)
                                    (# Resources)

• To determine the number of resources required to meet customer demand, we 

can substitute ‘Takt time’ for ‘Cycle time of multiple resources’ in the 

equation above and solve the equation for ‘Resources’:

# Resources needed  =  (Cycle time of one resource)
                                    (Takt time)
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665Improving work balance by cross training

• Teach Bob how to do B, teach Carol how to do A, have them both do 

A & B

• Process time for A & B  =  2.2 + 9.0 = 11.2 

• New cycle time for A + B  =  11.2 / 2   =  5.6 mins

• Process cycle time is once again 5.8 mins, and we didn’t have to add a 

resource

• Cross training is a more cost-effective way to meet customer demand.

• Where is the next best opportunity for cross training?

666Cross training (cont’d)

0

2

4

6

Ops A & B

(Bob & Carol)

Op C

(Ted)

Op D

(Alice)

Op E

(Larry)

Production rate for 
the new process:

 1 part every 5.8 
mins

1 part every

5.6 mins
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667Exercise 32.1 Lean workshop 

The Instructor will provide directions for this workshop.

668Notes

667
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33  Theory of Constraints (TOC)

670

0

2

4

6

8

10

A B C D E

Capacity
Cycle Time

StarvedBlocked

TOC (cont’d)

What if cross training is not feasible? 

What if the bottleneck is machine capacity?

669

670



Copyright © 2025  ETI Group

671TOC (cont’d)

TOC improvement cycle Lean terminology

1. Identify the system constraint (the  

    “drum”)
Find the bottleneck (“pacemaker”)

2. Exploit the identified constraint 

    (includes establishing the “buffer”)

• Move resources to the bottleneck

• Minimize NVA at the bottleneck

• Maintain needed level of “safety” WIP

3. Subordinate everything else to the 

    constraint (establish the “rope”)

Pull system synchronized with the takt 

time of the bottleneck

4. Elevate the constraint
Add enough resources to eliminate the 

bottleneck

5. Return to step #1 Find the new bottleneck, repeat same steps

672Ways to identify the constraint

• Greatest WIP

• Longest cycle time

• Longest process time

• Highest % utilization
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673Example: current state

4 machines

4 operators

Front end

4 machines

4 operators

Back end
1 machine

1 operator

Max qty = 60

Heat treat

Lead time 120 mins

“process” time 0 4 min 0

90 mins

(load change 

= 30 mins)

0 4 min

Cycle time 
4 mins/4 pcs

 = 1 min

120/60 =

 2 mins

4 mins/4 pcs

= 1 min

Constrained cycle time 1 min 2 mins 2 mins

StarvedBlocked

674Future state #1:  reallocate resources

4 machines

(1 idle)

3 operators

Front end

4 machines

(1 idle)

3 operators

Back end

1 machine

3 operators

Max qty = 60

Heat treat

Lead time 100 mins

“process” time 0 4 min 0

90 mins

(load change 

= 10 mins)

0 4 min

Cycle time 
4 mins/3 pcs

 = 1.33 mins

100/60 =

 1.67 mins

4 mins/3 pcs

= 1.33 mins

Constrained cycle 

time
1.33 mins 1.67 mins 1.67 mins

..
 _

..
 _

Less over-
production

Less
WIP

Faster load
change
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675Future state #2:  improve load change process

4 machines

(1 idle)

3 operators

Front end

4 machines

(1 idle)

3 operators

Back end

1 machine

3 operators

Max qty = 60

Heat treat

Lead time 95 mins

“process” time 0 4 min 0

90 mins

(load change 

= 5 mins)

0 4 min

Cycle time 
4 mins/3 pcs

 = 1.33 mins

95/60 =

 1.58 mins

4 mins/3 pcs

= 1.33 mins

Constrained cycle 

time
1.33 mins 1.58 mins 1.58 mins

Even faster
load change

676Future state #3:  pull system in front end

4 machines

(1 idle)

3 operators

Front end

4 machines

(1 idle)

3 operators

Back end

1 machine

3 operators

Max qty = 60

Heat treat

Lead time 95 mins

“process” time 0 4 min 0

90 mins

(load change 

= 5 mins)

0 4 min

Cycle time 
4 mins/3 pcs

 = 1.33 mins

95/60 =

 1.58 mins

4 mins/3 pcs

= 1.33 mins

Constrained cycle 

time
1.58 mins 1.58 mins 1.58 mins

0

60

WIP at

heat treat

 95 mins →  
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677Future state #4:  establish and maintain safety WIP

4 machines

(1 idle)

3 operators

Front end

4 machines

(1 idle)

3 operators

Back end

1 machine

3 operators

Max qty = 60

Heat treat

Lead time 95 mins

“process” time 0 4 min 0

90 mins

(load change 

= 5 mins)

0 4 min

Cycle time 
4 mins/3 pcs

 = 1.33 mins

95/60 =

 1.58 mins

4 mins/3 pcs

= 1.33 mins

Constrained cycle 

time
1.58 mins 1.58 mins 1.58 mins

60

120

WIP at

heat treat

 95 mins →  
Safety WIP

678Notes
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34  Reviewing the Proposed Future State

680Reviewing the future state

• Use Failure Modes and Effects Analysis to identify problems 

(failure modes) that could occur in your new process and their 

impact (effects)

• Put things in place in the new process, to prevent or mitigate 

these failure modes, before they happen

• After you develop your proposed future state, the next step is 

to review it with stakeholders

▪ Give them an opportunity to voice concerns or suggest 

enhancements prior to piloting

▪ This can be an informal process of presentation and 

discussion
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681Failure Modes & Effects Analysis (FMEA)

Effect

Effect EffectCause

Cause

Cause Effect

1. Identify potential failure modes before 

deploying a new product, service, or process

2. Identify and evaluate 

ultimate effects of 

potential failure modes

3. Identify and prioritize root 

causes of potential failure 

modes 

4. Identify and take corrective actions to eliminate 

or reduce the occurrence of root causes

682The role of FMEA in a LSS project

• Identify and prioritize stakeholder concerns with the 

proposed future state

• Take appropriate corrective action prior to piloting the 

future state

• Use results to strengthen the control plan for the future 

state

681
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683Detailed FMEA process

Identify functions

& requirements for

 the future state

Identify possible problems 

Identify effects of problems

Assign Severity ratings to effects

Identify root causes of problems

Assign Occurrence ratings to causes

Identify current controls

Assign Detection ratings to causes

Calculate risk priority numbers (RPNs)

Prioritize the problems

Take actions to reduce risk
Pilot the future

state

Stakeholder
input

Stakeholder
input

RPN = S x O x D

684Example of a Severity rating

Level Description

10
Hazardous, 

no warning

May endanger machine or assembly operator. Failure causes unsafe product operation or 

noncompliance with government regulation. Failure will occur without warning.

9
Hazardous, 

warning

May endanger machine or assembly operator. Failure causes unsafe product operation or 

noncompliance with government regulation. Failure will occur with warning.

8 Very high
Major disruption to production line. 100% of product may have to be scrapped. Product is 

inoperable with loss of Primary Function.

7 High
Minor disruption to production line. Product may have to be sorted and a portion scrapped. 

Product is operable but at a reduced level of performance.

6 Moderate
Minor disruption to production line. A portion of the product may have to be scrapped (no 

sorting). Product is operable but comfort or convenience item(s) are inoperable.

5 Low
Minor disruption to production line. 100% of the product may have to be reworked. Product 

is operable but comfort or convenience item(s) operate at a reduced level of performance.

4 Very low
Minor disruption to production line. Product may have to be sorted and a portion reworked. 

Fit/finish or squeak/rattle item does not conform. Most customers notice defect.

3 Minor
Minor disruption to production line. Some product may require rework on-line but out-of-

station. Fit/finish or squeak/rattle item does not conform. Average customers notice defect.

2 Very minor
Minor disruption to production line. Some product may require rework on-line but in-station. 

Fit/finish or squeak/rattle item does not conform. Discriminating customers notice defect.

1 None No effect.

683
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685Example of an Occurrence rating

Level Description Failure Rate

10
Very high Failure is almost inevitable.

  in 

9  in  

8
High

Generally associated with processes similar to 

previous processes that have often failed.

 in  

7  in  

6

Moderate

Generally associated with processes similar to 

previous processes which have experienced 

occasional failures, but not in major proportions. 

 in  

5 1 in 400 

4 1 in 2000 

3 Low
Isolated failures associated with similar 

processes. 
1 in 15,000 

2 Very low
Only isolated failures associated with almost 

identical processes. 
1 in 150,000 

1 Remote
Failure is unlikely. No failures ever associated 

with almost identical processes. 
  in  

686Example of a Detection rating

Level Description

10 Almost impossible No known controls available to detect failure mode or cause. 

9 Very remote Very remote likelihood current controls will detect failure mode or cause.

8 Remote Remote likelihood current controls will detect failure mode or cause.

7 Very low Very low likelihood current controls will detect failure mode or cause.

6 Low Low likelihood current controls will detect failure mode or cause.

5 Moderate Moderate likelihood current controls will detect failure mode or cause.

4 Moderately high Moderately high likelihood current controls will detect failure mode or cause.

3 High High likelihood current controls will detect failure mode or cause.

2 Very high Very high likelihood current controls will detect failure mode or cause.

1 Almost certain 
Current controls almost certain to detect failure mode or cause. Reliable 

detection controls are known with similar processes.

685
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687

• The previous three slides give examples of traditional 1−10 

ratings for severity, occurrence, and non−detection

• Note the detailed quantitative operational definitions 

• Customers or regulatory agencies may require this level of detail

• For the application to LSS projects, qualitative 1−5 ratings are 

often sufficient:

1. Very low

2. Low

3. Moderate

4. High

5. Very high

FMEA ratings

688Project example

Problem statement 
Operations staff within the Gene Expression Lab (GEL) are experiencing 

frequent material stock outs while performing procedures. They have to stop 

processing samples until the missing material is delivered. This increases 

process cycle time and reduces the quality of the data deliverables. Other labs 

directly affected by this problem are:

✓ Tissue Homogenization

✓ Experiment Processing

✓ Sample Processing

Goal statement

• Reduce frequency of stock outs by 50%.

• Reduce time lost due to stock outs by 50%.

Constraint

No increase in labor cost.
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689Current state data

Average daily number of stock outs 2.1

Average time to fill material requests 4 hrs

Annualized direct labor cost $91,000

690FMEA step 1 for Proposed Future State Process

Process Functions Requirements Failure Modes Effects Sev

Reagent lot creation
New lot information 

distributed to OPS team

Reagent creation
New reagent created based 

on processing demand

Reagent storage
Storage of new reagent at 

point of use (laboratory)

Material Distribution
Replenishment of materials 

based on MIN/MAX values

Material storage

Stocking of materials and 

reagents in designated 

location within the 

functional laboratory

689
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691FMEA step 2

Process Functions Requirements Failure Modes Effects Sev

Reagent lot creation
New lot information 

distributed to OPS team
Printer malfunction

Reagent creation

New reagent created 

based on processing 

demand

Operator error during 

manufacturing of 

reagent

Reagent storage
Storage of new reagent at 

point of use (laboratory)

Insufficent storage 

space in freezer or 

fridge

Insufficient shelf space 

for materials.

Staff is unclear where 

material items should be 

stored

Material Distribution

Distribution of materials 

based on MIN/MAX 

forecasting 

MIN/MAX values not 

accurate

Material storage

Stocking of materials and 

reagents in designated 

location within the 

functional laboratory

692FMEA step 3

Process Functions Requirements Failure Modes Effects Sev

Reagent lot creation
New lot information 

distributed to OPS team
Printer malfunction

Delay in distribution to 

the OPS team
5

Reagent creation

New reagent created 

based on processing 

demand

Operator error during 

manufacturing of 

reagent

(1) Processing delay      

(2) Wasted sub-

reagents (3) Time lost                     

(4) Labor money

10

Reagent storage
Storage of new reagent at 

point of use (laboratory)

Insufficent storage 

space in freezer or 

fridge

Reagent stock-out 8

Insufficient shelf space 

for materials.
Material stock-out 5

Staff is unclear where 

material items should be 

stored

Materials not stocked in 

designated location 

within the functional 

area

5

Material Distribution

Distribution of materials 

based on MIN/MAX 

forecasting 

MIN/MAX values not 

accurate
Material shortage 5

Material storage

Stocking of materials and 

reagents in designated 

location within the 

functional laboratory
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693FMEA step 4

Effects Sev Causes Occ Current Controls Det RPN
Recommended 

Actions

Delay in distribution to 

the OPS team
5 Electrical 1

(1) Processing delay 

(2) Wasted sub-

reagents (3) Time lost 

(4) Labor money

10
Did not use trained 

witness
1

Reagent stock-out 8
Freezer space not 

reconciled
10

Material stock-out 5
Too many items on 

shelving
5

Materials not stocked 

in designated location 

within the functional 

area

5

Insufficent labeling 

system to designate 

material and reagent 

locations 

5

Material shortage 5
Forecasting not 

accurate
5

694FMEA step 5

Failure Modes Effects Sev Causes Occ Current Controls Det RPN

Printer malfunction
Delay in distribution to 

the OPS team
5 Electrical 1 One printer 1

Operator error 

during 

manufacturing of 

reagent

(1) Processing delay 

(2) Wasted sub-

reagents (3) Time lost 

(4) Labor money

10
Did not use trained 

witness
1

SOP requires trained 

witness for 

procedure

5

Insufficent storage 

space in freezer or 

fridge

Reagent stock-out 8
Freezer space not 

reconciled
10 No control. 10

Insufficient shelf 

space for materials.
Material stock-out 5

Too many items on 

shelving
5

Shelving units with 

four shelves
10

Fisher staff is 

unclear where 

material items 

should be stored

Materials not stocked 

in designated location 

within the functional 

area

5

Insufficent labeling 

system to designate 

material and reagent 

locations 

5
Labels on shelving 

only
5

MIN/MAX values 

not accurate
Material shortage 5

Forecasting not 

accurate
5

Master Science 

Forecasting
10
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695FMEA step 6

Effects Sev Causes Occ Current Controls Det RPN
Recommended 

Actions

Delay in distribution to 

the OPS team
5 Electrical 1 One printer 1 5

(1) Processing delay 

(2) Wasted sub-

reagents (3) Time lost 

(4) Labor money

10
Did not use trained 

witness
1

SOP requires trained 

witness for 

procedure

5 50

Reagent stock-out 8
Freezer space not 

reconciled
10 No control. 10 800

Material stock-out 5
Too many items on 

shelving
5

Shelving units with 

four shelves
10 250

Materials not stocked 

in designated location 

within the functional 

area

5

Insufficent labeling 

system to designate 

material and reagent 

locations 

5
Labels on shelving 

only
5 125

Material shortage 5
Forecasting not 

accurate
5

Master Science 

Forecasting
10 250

696Pareto of causes by RPN
RPN Before Action

0
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Reagent lot
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Causes

R
P
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697FMEA step 7

Effects Sev Causes Occ Current Controls Det RPN
Recommended 

Actions

Delay in distribution to 

the OPS team
5 Electrical 1 One printer 1 5 Install back-up printer

(1) Processing delay 

(2) Wasted sub-

reagents (3) Time lost 

(4) Labor money

10
Did not use trained 

witness
1

SOP requires trained 

witness for 

procedure

5 50
No further action 

required

Reagent stock-out 8
Freezer space not 

reconciled
10 No control. 10 800

Frequent consolidation 

of freezer inventory

Material stock-out 5
Too many items on 

shelving
5

Shelving units with 

four shelves
10 250

Add more shelves to 

accommodate 

additional materials

Materials not stocked 

in designated location 

within the functional 

area

5

Insufficent labeling 

system to designate 

material and reagent 

locations 

5
Labels on shelving 

only
5 125

Place labels on freezer 

canes and fridge 

shelves to designate 

locations

Material shortage 5
Forecasting not 

accurate
5

Master Science 

Forecasting
10 250

Review MIN/MAX 

values quarterly for 

frequently used 

materials

698Results from pilot data

Current

state

Future

state
Reduction

Average daily number of stock outs 2.1 0.02 99%

Average time to fill mat’l requests 4 hrs 2.3 hrs 42%

Annualized direct labor cost $91,000 $1,000 99%
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35  Piloting the Future State

700Piloting the future state

• Small scale implementation under close observation

• Scope should be limited* 

• Time period should be relatively short

*We try to scope LSS projects into manageable chunks. Because of this, the pilot scope may 
sometimes be the same as the project scope. 
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701Benefits of piloting

• Identify unanticipated failure modes 

• Identify unintended consequences 

• Indicates whether or not improvement objectives will 

be met

• Reduces problems in full scale implementation

702Piloting checklist

❑ What is the scope? (Location, work area, product, customer, 

duration, . . .)

❑ Who are the participants? (Process owner, process participants, 

stakeholders, team members, . . .)

❑ What data is to be collected? (Y variables and project metrics 

should be same as in Define and Measure phases.) 

❑ What measurement systems will be used? (These may have been 

improved during the project.)

❑ What is the sampling plan and sample size necessary to represent 

typical variation sources? 

❑ Have we communicated plans to all concerned parties? 

701
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703Sample size calculation for a pilot study

Student Files → calculator - sample size → Comparisons

Baseline value from charter

Goal from charter

Sample size for the pilot

Sample size for the pilot

Current state standard deviation

Baseline average minus goal

Set C7 to the value in C6 by changing C4 

(Use Data → What-If Analysis → Goal Seek)

DTD = Difference to Detect

704Example:  quotation process pilot study

Metric Baseline (BU 8) Goal

Average TAT 3.6 days 1.5 days

TAT > 3 37.9% 10%

Scope of the pilot:  Business Unit 8

DTD = 2.1 daysStd Dev = 3.3 days

Sample size for
the pilot should be 
at least 20

If you have more 
than one statistical 

metric, you must 
use the largest of 

the calculated
sample sizes

TAT = Turnaround Time
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705Exercise 35.1

Open Student Files → calculator–sample size → Comparisons and use the 

information given below to calculate the sample size for each metric for the MBDP 

pilot. 

Metric Baseline Goal DTD Sample Size 

(n)

Average PO-PD* 29.5 days 50% reduction

% PO-PD > 30 38.7% 50% reduction

% MFG not happy 49.4% 50% reduction

* PO-PD = time from Purchase Order receipt to Product Delivery

   Std Dev of PO-PD = 19.5 days

706Analyzing pilot results

• Collect observations ⎯ what worked, what didn’t

• Statistical comparison of “before” and “after”

• Evaluate improved project metrics relative to goals 

• Establish new statistical baselines

➢ They will form the basis for statistical monitoring after 

implementation
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707Redux: Significance testing ⎯  Pass/Fail Y

Based on the data given below, did our project achieve the goal of a 

50% reduction in % defective? 

Sample size No. defective % Defective

Current state 500 147 29.4%

Future state pilot 10 1 10.0%

Did we use an adequate sample size for the Future State pilot study?

Yes No

Current 147 353 500 29.40 0.1808

Future 1 9 10 10.00

Totals 148 362 510

P-valueGroup labels

Sample 

size % Defective

Defective?

Student Files  → calculator - chi square test 

708Redux: Significance testing ⎯  Quantitative Y

Open Data Sets → lead time. 

Did our project achieve the goal of a 50% reduction in average lead time? 

Process Lead time

Current 71

Current 81

Current 75

Current 87

Current 93

Current 67

Current 89

Future 61

Future 58

Future 42

Future 55

Future 54

Future 61

Future 49

Current Future

71 61

81 58

75 42

87 55

93 54

67 61

89 49

Data
 

Data Analysis


 Anova: Single Factor


OK

Anova: Single  Factor

SUMMARY

Groups Count Sum Average Variance Std Dev

Current 7 563 80.42857 95.61905 9.8

Future 7 380 54.28571 47.2381 6.9

ANOVA

Source of Variation SS df MS F P-va lue F crit

Between Groups 2392.1 1 2392.071 33.489 8.65E-05 4.747225

Within Groups 857.14 12 71.42857

Total 3249.2 13

Did we use an 

adequate sample size 

for the Future State 

pilot study?

p = 0

707
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709Redux: Interpreting P values - “Statistical Standard of Evidence”

None None

Some 85%  CL < 95%

Strong 95%  CL < 99%

Very Strong CL  99%

0.05  

0.15  

0.01  

1.00  

P
 v

al
u

e

Probability of NO 

difference or correlation

Level of evidence that samples ARE 

different or variables ARE correlated

Confidence level (CL)

for difference/correlation

& 

lower 

toward 

zero

710Exercise 35.2

Open Student Files → Case Studies → MBDP → MBDP current & future pilot. 

a) Test for a significant improvement in average PO−PD. Give the P value and its 

interpretation in terms of standards of evidence.

b) Did we achieve our goal of 50% reduction for average PO−PD? 

c) (Optional) Create a Box and Whisker Plot showing the change in PO−PD from 

the current state to the future state pilot. 

d) Test for a significant improvement in % PO−PD > 30. Give the P value and its 

interpretation in terms of standards of evidence.
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711Exercise 35.2 (cont’d)

e) Did we achieve our goal of 50% reduction for % PO−PD > 30?

f) Test for a significant improvement in % MFG not happy. Give the P value and its 

interpretation in terms of standards of evidence.

g) Did we achieve our goal of 50% reduction for % MFG not happy?

h) Save your work and keep the file open.

712Exercise 35.3

Open Student Files → Case Studies → quotation process → quotation process current 

& future pilot.

a) Test for a significant improvement in average TAT (turnaround time). Give the P 

value and its interpretation in terms of standards of evidence.

b) Did we achieve our goal of 1.5 days for average TAT? 

c) Optional: Create a Box and Whisker Plot showing the change in TAT from the 

current state to the future state pilot. 
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713Exercise 35.3 (cont’d)

d) Test for a significant improvement in % TAT > 3. Give the P value and its 

interpretation in terms of standards of evidence. 

e) Did we achieve our goal of reducing % TAT > 3 to 10%?

f) Test for a significant improvement in the PO hit rate. Give the P value and its 

interpretation in terms of standards of evidence.

g) Save your work and keep the file open.

714Margin of Error (MOE) calculation for a pilot study

• In Module 22 Data Collection, we explored the concept of the Margin of 

Error (MOE) and how to use it to calculate a sample size to estimate 

Current State population baselines for project metrics.

• We learned that the more precisely we wanted to estimate an overall 

percent defective or average, the more we had to “spend” in sample size. 

• When we are analyzing results from a Future State pilot study, the resulting 

P value will be affected by the sample size. 

➢ If we get a P value of 0.05 or less, we have strong evidence of a difference. In 

this case, it may be helpful to get a prediction of how high an overall defect rate 

could go, or an upper and lower bound on the average for the Future State 

process.

➢ If we get a P value of greater than 0.05, i.e., some or no evidence of a 

difference, and we suspect we didn’t “spend” enough on our sample size, it 

could be helpful to get a prediction of whether a larger sample size would have 

made a difference. 

• The Student Files→ calculator – margin of error will give us these 

boundaries.
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715MOE calculation for a pilot study — Pass/Fail Y

Student Files→ calculator – margin of error  % Defective

Sample size for the pilot of 
Future State

Result from the pilot of Future 
State

Worst case prediction (with 95% 
confidence) of the Future State 

% defective

716Example: pilot study MOE calculation — Pass/Fail

We’ll use our Redux on Significance testing for Pass/Fail Y 

Sample size 10

Number defective in the sample 1

Fraction defective in the sample 0.1000

% Defective in the sample 10.00

Upper bound on population % defective 39.4 95 % Confidence level

In our Redux, we found p = 0.18 — no evidence of difference. A higher upper bound on the 

future state % defective than the current state baseline is another way of saying there is no 

evidence of difference. However, we noted the fact of the small sample size for the pilot. 

Open Student Files→ calculator – margin of error  % Defective
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717Example: pilot MOE calculation — Pass/Fail (cont’d)

We can use the calculator – margin of error to make some predictions of what 

would happen if a larger sample size with the same defect rate were used.

• An upper bound of 14.6% overall defective sounds a lot better than the 

Current State average of 29.4%.

• It may be worth collecting more samples for the Future State process before 

giving up on the proposed improvements.

Sample size 170

Number defective in the sample 17

Fraction defective in the sample 0.1000

% Defective in the sample 10.00

Upper bound on population % defective 14.62195 95 % Confidence level

718MOE calculation for a pilot study — Quantitative Y

Open Student Files→ calculator – margin of error  Pop. mean of quant.Y

Sample size, mean and std. dev. 
for the pilot of Future State

Predicted 95% confidence interval on 
the population mean (range within 
which the center of the population 
distribution would fall).

Sample size (N)

Sample mean

Sample standard deviation ( #NUM! , #NUM! )

% Confidence level 95

t-value #NUM!

MOE for population mean #NUM!

Confidence interval

Using the MOE calculator is a way to be a careful consumer of data. 

In addition to the P value, it helps us evaluate whether the significant 

difference is worth the cost to implement it by giving us a

 “confidence interval” on the benefit.
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719Example:  pilot study MOE calculation — Quantitative Y

We’ll use our Redux on Significance testing for Quantitative Y 

Sample size (N) 7

Sample mean 54.29

Sample standard deviation 6.87 ( 46.57 , 62.00 )

% Confidence level 95

t-value 2.9687

MOE for population mean 7.7119

Confidence interval

In our Redux, we found p = 0 — very strong evidence of a difference. The MOE on the 

average lead time gives us an upper bound of 62 days, much lower than the Current State 

average of 80.4!

Open Student Files→ calculator – margin of error  Pop. mean of quant.Y

Anova: Single  Factor

SUMMARY

Groups Count Sum Average Variance Std Dev

Current 7 563 80.42857 95.61905 9.8

Future 7 380 54.28571 47.2381 6.9

ANOVA

Source of Variation SS df MS F P-va lue F crit

Between Groups 2392.1 1 2392.071 33.489 8.65E-05 4.747225

Within Groups 857.14 12 71.42857

Total 3249.2 13

We can also enter a larger N 
with the same mean and std 
dev for the Future State to 
see the effect on the 
confidence interval.

720Exercise 35.4

Open Student Files → Case Studies → MBDP → MBDP current & future pilot. 

Go back to your results from Exercise 35.2 for the Future State pilot data and use 

the appropriate MOE calculator to determine the following information:

a) 95% Confidence Interval on the average PO−PD:

b) Upper bound on the % PO−PD > 30, with a 95% Confidence level:

c) Upper bound on the % MFG not happy:
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721Exercise 35.5

Open Student Files → Case Studies → quotation process → quotation process current 

& future pilot.

Go back to your results from Exercise 35.3 for the Future State pilot data and use 

the appropriate MOE calculator to determine the following information:

a) 95% Confidence Interval on the average TAT: 

b) Upper bound on the % TAT > 3, with a 95% Confidence level:

c) Upper bound on the PO “No” rate:

722Notes
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36  Control Plan

724What is a control plan?

• A summary of the plan to sustain the gains from a LSS project

• The project team helps the in−scope process owner and 

participants develop the plan

• Project team advises the in−scope process owner and participants 

on statistical monitoring issues

• Most common control methods:  training, auditing, control chart

• Most common control chart quantities:  individual measurements, 

averages, and percentages
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725

Process name:

Process owner:

Revision date:

Lower Upper

Process step
Response plan 

location

Control 

method

Meas. 

system
Frequency

Metric to 

monitor

Control limits 
Response plan 

owner

Data 

variable

Student Files → blank control plan

726Student Files \ Case Studies \ tool development \ tool development control plan

Process name:

Process owner:

Revision date:

Lower Upper

Determine run 

conditions

Audit compliance with new 

procedure requiring special 

approval to change weight or 

line speed

Monthly, then 

Quarterly

Run 

conditions

Determine run 

conditions

Disable weight and line speed 

controls on test line 
 

Release to 

manufacturing
Control chart Weekly

Number of 

days in 

testing

Database Average TBD

Testing 

area 

manager

TBD

Release to 

manufacturing
Control chart Weekly

Number of 

rework 

cycles

Database Average TBD

Testing 

area 

manager

TBD

Dimensional inspection
Install DVT gage and trainer 

testers to use it

Dimensional inspection Periodic gage R&R TBD
Spec 

dimensions
DVT % of Tolerance TBD

Testing 

Engineer
TBD

Tool Testing Process

Testing Area Manager

Process step

Response 

plan 

location

Control method
Meas. 

system
Frequency Metric to monitor

Control limits Response 

plan 

owner

Data variable
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37  Statistical Monitoring

728Statistical monitoring*

• Two kinds of variation

• Quantifying common cause variation

• Establishing control limits 

• Commonly used control charts

• Interpreting control charts

• Response plans

• Relationship to Process Capability

*The more commonly used term is Statistical Process Control (SPC), even though it has 
nothing to do with “control” in the usual sense. 
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729

a) Sign your name five times in the space provided below.

b) Put your pencil or pen into the other hand. Sign your name once in the space 

provided below. 

Exercise 37.1

730Two kinds of variation

Variation due to common causes

Variation due to assignable causes

729
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731Two kinds of variation (cont’d)

Common causes                  Assignable causes

Systematic variation

External factors, mistakes, 

malfunctions, miscommunications, etc.

Relatively few large fluctuations, 

causes can be assigned and removed

Outcomes are not predictable at all

Random variation 

Inherent in the process as 

currently defined 

Myriad small fluctuations, 

causes cannot be assigned

Outcomes are predictable 

within statistical limits

732Quantifying common cause variation

• Common cause variation is usually represented by 

upper and lower control limits

• Upper control limit (UCL)  =  + 

• Lower control limit (LCL)  =  − 

• These are also called three-sigma limits

• Center Line (CL) = 
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733

LCL

( − )

UCL

( + )

CL



Common 
 causes

Baseline distribution of variable to be monitored

 = average 

 =  standard deviation

Assignable

causes

Assignable

causes

Common cause variation (cont’d)

Control limits provide an operational definition

of common cause variation

734

If the quantity to be monitored follows a Normal distribution,

 the chance of a false alarm is 0.27% 

Common cause variation (cont’d)

CL


 99.73% 

Baseline distribution of variable to be monitored

False
alarms

 

False
alarms

 

LCL

( − )

UCL

( + )
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735

0 2 4 6 8 10 12 14

gamma 5

Distributions

0 2 4 6 8 10 12 14 16 18 20 22 24

gamma 10

Distributions

0 1 2 3 4 5 6 7

gamma 1

Distributions

Common cause variation (cont’d)

99.4%99.0%

• 3 limits are shown for three 

non−Normal distributions

• Data doesn’t need to be Normally 

distributed for most charts

• The Central Limit Theorem also 

greatly reduces the effect of non-

Normality when samples are used

• 3 limits are an economic 

compromise between false alarms 

and missed signals

98.1%

736Behavior of Averages: the “Central Limit” effect

Individual data values sampled from a population

 with  =  and  = 
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737Behavior of Averages: the “Central Limit” effect (cont’d)

Averages of 4 data values sampled from the same population 

with  =  and  = 

30
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65

70
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UCL

CL

LCL

• Why would the limits shown above be ineffective for statistical monitoring of the 
averages? 

• Control limits for a distribution of averages must be calculated a different way. 

738Behavior of Averages: the “Central Limit” effect (cont’d)

Averages of 4 data values sampled from the same population 

with  =  and  = 

30
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65

70
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• These are the true control limits for the averages. 

• In addition to the obvious narrowing of the distribution, the Central Limit 
Theorem (stated simply), concludes that subgroup averages converge to a Normal 
distribution, even if the underlying distribution is non-Normal.

737

738



Copyright © 2025  ETI Group

739The Standard Deviation of Averages

If we repeatedly sample sets of N individual data

values from a population with mean  and 

standard deviation , and calculate

the average in each case, the 

standard deviation of

the averages is:

N



740Control Limits for Averages

If we repeatedly sample sets of N individual data

values from a population with mean  and 

standard deviation , and calculate

the average in each case, the 

three-sigma limits for

the averages are:


−=


+=







3    LCL

3    UCL
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741Establishing Control Limits

• Control Limits are calculated using data representative of day-to-day process 

operation

• The exact calculation for three sigma limits depends on the type of control 

chart being used

• The type of control chart used depends on the type of data and the sampling 

method

• At least 20 – 25 sample subgroups should be used to set control limits

• Data from a pilot run can be used to set control limits for the “future state” 

process, if the pilot is representative of the process that will be implemented.

➢ If not, run the “future state” process long enough to gather a sufficient 

sample.

Control limits are not the same as specification limits! 

742Sampling for control charts

To detect process shifts, we need to take a reasonable sample of the process.

• Samples should estimate, or try to represent, the population. 

• Samples need to be taken in the order of production and as soon as possible 

in an operation to get an early warning of defects.

• The chance of variation from assignable causes should be minimized within 

an individual sample set (pull parts for a sample close together in time).

• The chance of variation from assignable causes should be maximized 

between samples (time separation between samples).

• Pulling subgroups of parts at a predetermined interval works best.

➢ Do not pre-identify which parts will form the SPC sample before they 

are manufactured (avoid bias).

➢ Do not adjust the process during sampling.
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743Common Shewhart control charts

Quantitative measurement:

• ഥX & s (sample average and standard deviation)

• ഥX & R (sample average and range)

• IX and MR (individual values and moving range 

Categorical classification:

• p (fraction defective)

744Quantitative control charts

With quantitative control charts, we pull samples from the process and use 

them to estimate how the process as a whole is performing. 

We can then answer two important questions using two graphs:

1. Is the process staying centered?

2. Is the process staying consistent?

SCENARIO A 

 

 

 

 

 

The centering is  ________________  

 ______________________________  

 

The consistency is  ______________  

 ______________________________  

 

SCENARIO B 

 

 

 

 

The centering is  ________________  

 ______________________________  

 

The consistency is  ______________  

 ______________________________ . 

 

SCENARIO A 

 

 

 

 

 

The centering is  ________________  

 ______________________________  

 

The consistency is  ______________  

 ______________________________  

 

SCENARIO B 

 

 

 

 

The centering is  ________________  

 ______________________________  

 

The consistency is  ______________  

 _______________________________  
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745Quantitative control charts (cont’d)

Control  
Chart 

Statistics  
Plotted 

Sample 
Size 

Description 

X-bar & R Average & 

Range 

2–5 The X-bar and R chart was the first and most common quantitative control chart 

used in SPC, only because in the days before calculators and statistical software, 

Range was easier to calculate than Standard Deviation. 

The X-bar and R chart can be useful for monitoring product, process or 

environmental characteristics when the sample size is fairly small (say 5 or less). 

But given the prevalence of software tools available, it should really be replaced by 

the X-bar and s chart unless there is a particular need for spotting “outlier” range 

values.  

X-bar & s Average & 

Standard 

Deviation 

5–15 The X-bar and s chart is useful for monitoring product, process or environmental 

characteristics, especially when the sample size is larger (say, more than 5). 

Again, the standard deviation chart will be more robust than range because all data 

are used, not just the highest and lowest numbers. 

IX & MR Individual & 

Moving 

Range 

1 The IX and MR chart is used when the sample size is one. A single sample may 

need to be taken because: 

• It is expensive to take samples. 

• The measurement method is destructive. 

• It is the only sample size that makes sense for that process. 

Because an average cannot be calculated for a sample size of one, the individual 

data points are used.  

When there is only one number, standard deviation and range cannot be calculated. 

Instead, we use what is called the Moving Range. 

 

746Example: ഥX and s chart

For each sample, the average is plotted on the ഥX chart (centering) and 

the standard deviation (consistency) is plotted below on the s chart.

JMP Output of ഥXs Chart of control chart diameter
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747Control limit calculations for X–bar and s charts

Monitoring 

frequency

Metric to

monitor

Statistic(s)

Needed Control limits

Hourly 

Daily

Weekly

Monthly

Quarterly

etc.

ത𝑋 chart:

Average

Average

()

Standard

deviation

()

s chart:

Standard 

Deviation

Standard

deviation

()

N
3    LCL

    CL   

N
3    UCL


−=

=


+=

UCL = σ + 3
σ

2 N−1

 CL = σ

LCL = σ − 3
σ

2 N−1

748Control limit calculations for X–bar and s charts (cont’d)

Notes for the ഥX and s chart formulas:

is the overall standard deviation, calculated from all the individual 

data points (the X’s from all the samples)

is the standard deviation of all the sample averages 

(aka standard error of the mean)

is the average of all the sample standard deviations

is the standard deviation of the sample standard deviations


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749Exercise 37.2

We want to use ഥX and s control charts to monitor a critical dimension, diameter, of the 

parts we are producing. Open Data Sets → control chart diameter. Does the baseline 

data appear to be adequate to represent process variation? 

Use Excel formulas for the following:

a) Calculate the average (തx) and standard deviation (s) for each subgroup of five parts. 

b) Calculate the overall average, which will be the center line (CL) of the ഥX chart. 

There are two ways to do so: take the average of all the data points or take the 

average of the subgroup averages. The name given to the statistic from the second 

method is നX  (X-double bar) aka the Grand Average. 

c) Calculate the average of the subgroup standard deviations, (𝜎 ), which will be the 

Center Line (CL) for the standard deviation chart. 

750Exercise 37.2 (cont’d)

d) Calculate the various components needed for the control limit calculations, as laid 

out in the file Data Sets → control chart diameter: 

𝜎 =  N =  
𝜎

N
 = 2 N − 1  =

𝜎

2 N−1  
=    

e) Use the numbers found above to calculate the upper and lower control limits for 

each chart.

UCL ҧx
  = 

CL ҧx
  = 

LCL ҧx
  = 

UCLs  = 

CLs  =

LCLs  = 
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751Control limits for X–bar and R charts

Constants for sample size n

From Introduction to Statistical Quality Control by Douglas C. Montgomery

n A2  D3 D4 d2

2 1.880 0.000 3.267 1.128

3 1.023 0.000 2.574 1.693

4 0.729 0.000 2.282 2.059

5 0.577 0.000 2.114 2.326

6 0.483 0.000 2.004 2.534

7 0.419 0.076 1.924 2.704

8 0.373 0.136 1.864 2.847

9 0.377 0.184 1.816 2.97

10 0.308 0.223 1.777 3.078

752Example: Individual and Moving Range chart

For each unit, the measurement is plotted on the Individual 

chart and the Moving Range is plotted below.

Why is the first point missing on the MR chart?
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753Estimating standard deviation using the moving range method

0

5

10

15

20

25

30

35

40

Each moving range is the absolute value of the difference between 

consecutive data points.

Time

Y

754Control limit calculations for Individual and Moving Range chart

Individual Chart Control Limits:

UCL =  തx + 3
MR

d2

 CL =  തx   MR = xi − xi−1

LCL =  തx − 3
MR

d2

The value of d2 is 1.128 since the range is between two consecutive points.

Moving Range Chart Control Limits:

UCL =  D4MR = 3.267MR      

   CL = MR

 LCL =  D3MR = 0
The same constants shown 
previously are also used here.
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755Individual and Moving Range chart calculator

To make it easier to calculate the moving range, open 

Student Files → calculator – individual moving range chart

• Paste your data into cell A3

• Copy cell B4 down to the end of your data

756Example: Individual and Moving Range chart calculator

Excerpted data from Data Sets→ solution properties 

• If data (Y variable)  0 and LCL  0, 
ignore LCL

• With MR calculations, the number of 
decimal places shown may need to be 
increased
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757Exercise 37.3

We want to use ഥIX and MR control charts to monitor radial deviation. This 

measurement requires special equipment and is very time-consuming, hence the 

sample size of one.

Open Data Sets → control chart aligner 

Open Student Files → calculator - individual moving range chart

a) Copy the R dev data into the calculator (Paste Values).

b) Copy the calculation in cell B4 down Column B, in order to calculate the moving 

range for R dev. What is the average moving range?

 MR =

758Exercise 37.3 (cont’d)

c) What are the control limits for the Individual Chart?

 UCL =

      CL = 

  LCL = 

d) What are the control limits for the Moving Range Chart?

 UCL =

      CL = 

  LCL = 
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759Individual & Moving Range chart plotted

JMP Output of Individuals & MR Chart of Aligner 2 R dev

Data Sets → control chart aligner

760p Chart

The p Chart is used when: 

• Samples are periodically taken and it’s determined whether each unit in 

the sample is good or bad

• The data plotted is fraction or percent defective

p Chart control limits are based on the Binomial distribution, since pass/fail 

data is binomial.

• The standard deviation of the Binomial distribution is:  
p(1−p)

n
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761p Chart (cont’d)

Example of a p Chart (created in JMP)

In this case, there were 50 units in each sample. Overall percent 

defective was about 5% for this timeframe.

762p Chart (cont’d)

Control Limits for the p Chart

UCL =  തp + 3
തp(1 − തp)

n

CL =  തp

LCL =  തp −  3
തp(1 − തp)

n

തp =
Total number of defective units in the samples

Total number of units in the samples

n = number of items in each sample

These control limits are the mean +/- 3 sigma for this distribution.
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763Exercise 37.4

We want to use a percent defective (p) control chart to monitor the weekly defects per 

unit occurring during an in-process assembly inspection.

Open Data Sets → control chart parts inspected & defective

Use Excel formulas for the following and during calculations, keep the numbers in 

“fraction defective” form vs percentage:

a) The sample size varies each week, so we’ll use an average sample size for 

calculating control limits. Calculate the average weekly sample size. What 

concerns might there be about using this number?

b) Calculate the overall fraction defective, തp. Hint: we determined this number in 

Exercise 23.2 a). 

This number will be the center line (CL) for the p chart.

764Exercise 37.4 (cont’d)

c) Use the average sample size and തp found above to calculate the upper and lower 

control limits for the p chart.

 UCL =

      CL = 

  LCL = 

d) Optional: Copy the formulas for the control limits down the column for all of the 

data and use line charts to plot the fraction defective with control chart limits.
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765Other Shewhart control charts

Categorical classification:

• np chart: number (count) of defective items per sample with a fixed quantity

• u chart: count of defects per unit

• c chart: count of defects) per sample with a fixed quantity

For np, c and u charts, the control limit calculations  and chart appearance are 

similar to the p chart.

Details of these and other specialized control charts are beyond the scope of 

this course. More information can be found in any basic statistical process 

control textbook or reference.

766Interpreting control charts

Once the control chart is created, the most valuable work can begin — discerning 

what the chart is telling us about process variation.

• Is the process “in control” or “out?”

• Are there warning signs that the process may go out of control soon?

• What actions should be take in response to the control chart signals?

The rules we’ll discuss for deciding whether a process is in or out of control work 

only for control limits — not for specification limits.

• Our concern with specification limits is whether an item conforms or not. 

• Inspection and testing must be used to screen out bad parts, not control limits.
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767A hypothetical KPI scenario

New manager has
“special meeting” 

with CEO!

Manager gets bonus!
Manager is reassigned! 

New manager makes big improvement!

Customer

Complaints/Wk

5

10

15

20

25

30

35

40

2 4 6 8 10 12 14 16 18 20 22 24 26 28 30

Month

768Using control limits

UCL

LCL

( + )

( − )



Evidence of assignable causes

Evidence of assignable causes

Plot and react to future data
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769Back to our hypothetical scenario

Control Limits show there are no assignable causes!

Run charts can cause us to overreact.
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µ0=20.40

LCL=9.00

UCL=31.80

Individual Measurement of in-process inventory

Control Chart

Customer

Complaints/Wk

Manager gets bonus!

Manager is reassigned! 

New manager makes big improvement!

New manager has
“special meeting” 

with CEO!

770Using control limits (cont’d)

• Control limits provide an operational definition of assignable 

cause variation

• Simplest rule:  points inside the limits are common cause 

variation, points outside the limits have assignable causes

• 27 in 10,000 common cause data points are expected to fall 

outside the control limits* ― this is the nominal false alarm rate

• Assignable causes may occur without producing points outside 

the limits ― these are missed signals

• To reduce missed signals, additional rules are sometimes applied

*Assuming a Normal distribution
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771Using control limits (cont’d)

When monitoring a straightforward KPI, such as number of customer 

complaints/week or monthly on-time delivery, Management may only 

want to see a chart of the KPI metric itself.

• In this case, it may be sufficient to use an X-bar or IX chart without 

the associated standard deviation or range chart.

• Adding control limits to the resulting X-bar or IX chart will provide 

a statistical basis for action. 

• It may also be helpful to add a target or goal line to the chart (aligned 

with the KPI calculation method). 

• An associated variation chart could be created for deeper root cause 

analysis if necessary. For example:

➢ Are late deliveries “normal” for the organization?

➢ Are there inconsistencies between divisions for global KPI charts?

772Notes
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 Normal(173.333,1.1547)

weight

Distributions

month=1

Using control limits (cont’d)
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Assignable cause

1. This event has probability 0.00135 ( 0.0027  2 ) 

2. Investigate to determine the cause

3. Take corrective action to eliminate the cause
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Using control limits (cont’d)

Post implementation data

C
om
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1. This event has probability 0.00195 [ (0.5)9 ]

2. Investigate to determine the cause

3. Take corrective action to eliminate the cause
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775

C

B

A

C

B

A

Avg

LCL

UCL

Control chart zones:  A, B, and C

Additional tests for assignable causes

776Additional tests for assignable causes (cont’d)

The zone system is based on 3 limits

• C is the region within 1 standard deviation of the mean

• B is the region more than 1 but less than 2 standard 
deviations from the mean

• A is the region more than 2 but less than 3 standard 
deviations from the mean

• These tests for “statistical significance” are also referred 
to as the Western Electric Rules.
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777Additional tests for assignable causes (cont’d)

Test 1 One point beyond A (This is the basic test & always used.)

Test 2 9 points in a row on the same side of the average.

Test 3 6 points in a row steadily increasing or decreasing. 

Test 4 14 points in a row alternating up and down. 

Test 5 Any 2 out of 3 points in a row in A or beyond. 

Test 6 Any 4 out of 5 points in B or beyond. 

Test 7 15 points in a row in C, above and below the center line. 

Test 8 8 points in a row on each side of the average with none in C. 

778Tests most commonly used (and most useful)

One or more points outside the control 
limits.

Nine or more points in a row on one side of 
the average.

Test  #1

Test  #2
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779

C

B

A

C

B

A

Avg

LCL

UCL

Circle occurrences of Tests 1 and 2 on the control chart shown below. Indicate 

which is which.

Exercise 37.5

780Exercise 37.6

The data sets needed are in the Student Files \ Case Studies \ quotation process.

a) Open quotation process current & future pilot and 

Student Files  → calculator – individual moving range chart. 

b) Use the future pilot data to calculate control limits for an Individual and Moving 

Range (IX & MR) chart of TAT.

c) Open quotation process post implementation. Create an IX chart by plotting the 

TAT data, then add lines for the CL and UCL as calculated in (b) for the IX chart.

d) Identify the quote number and account manager for any TATs above the UCL.
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781Response plans

UCL

LCL

CL

So far, so good . . .

782Out-of-control event (OOC)

UCL

LCL

CL

1. Investigate to 

determine the 

cause

2. Take corrective 

action to eliminate 

the cause

Step 1 requires a response plan
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783Response plan “skeleton”

OOC?

Verify the data point

Document problem

and corrective

action

Take corrective

action to prevent

re-occurrence

Continue

Verify the measurement system

Most recent

data point

Is the cause

known?
Investigate

N

Y

N

Y

784Response plan (cont’d)

• OOC stands for out of control

• This means the control chart indicates an assignable cause 

according to one or more selected tests

• The success of statistical monitoring depends on having a 

documented plan for responding to OOCs

• The most effective form of documentation is a process map like 

the one shown above

• It should posted in a place clearly visible to process participants
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785Response plan example

OOC?

Take another sample OOC?

Do operator checklist

Enter into

process log

Call Process Tech.

Upstream? Provide feedback to upstream process

Do technician

checklist
Problem solved?

Start new lot

Call Engineer

N

Y

N

Y

Y

Y

N

N

Take sample from

current lot

Problem solved? YN

Disposition

of affected

material

786Response plan (cont’d)

• Example from a high-volume automated assembly process (“sanitized”)

• Development team:  operators, technicians, engineers, area manager

• Based on experience, they wanted to verify an OOC with a second sample 

from the same lot 

• Note the escalation from Operator to Technician to Engineer.

• When an OOC was confirmed, production was halted

• Within a few months:

• Chronic equipment and process problems were solved

• Unplanned downtime and need for Engineering support plummeted 

• Engineers able to focus more on process improvement

• Productivity increased dramatically
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787What about performance requirements?

Acceptable

 outcomes

Upper Specification Limit

(USL)

Unacceptable 

outcomes

0 60Minutes

788Out-of-specification event (OOS)

60

0

What do we do now?
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789Scenario 1:  process capability is good

• If the process has good capability, it will virtually never 

produce a defective outcome, unless there is an assignable 

cause

• Any OOS point is also OOC

• Any OOS point should trigger the response plan

USL

0 60

..

790Scenario 2:  process capability is poor

• If the process has poor capability, there will be OOS 

outcomes that are not OOC

• These outcomes do not indicate assignable causes

• They should not trigger the OOC response plan

USL

0 60

..
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791Exercise 37.7 

USL

Check the 

appropriate actions

for outcomes in 

each of the 4 zones 

shown above. 

1

Zone

Initiate OOC 

response plan

Scrap, 

rework, do 

over, etc. Do nothing

1

2

3

4

USLUCL UCL

2 3 1 4 3

792Summary

Thank you for participating

 in ETI Group’s

 Lean Six Sigma Green Belt Workshop!

Your Instructor will give all necessary instructions for the final 

LSS GB Exam. 

The exam is intended to be both an assessment of comprehension 

and a reinforcement of the DMAIC roadmap.

You will also receive a link to a Course Evaluation. 

We appreciate you taking a few minutes of your time to provide us

with constructive feedback.
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